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In This Guide 
This guide covers the following module: NovoExpress Software 

1 Prologue 

This chapter provides basic information for NovoExpress and the software guide, 
including overview of NovoExpress, scope of this guide, keyboard shortcuts and 
glossary. 

2 Installation 

This chapter describes the installation requirements, procedures to install, start 
and uninstall the NovoExpress software, NovoExpress license registration and 
dissociation, and user management feature. 

3 Use NovoExpress Software 

This chapter provides information needed to use NovoExpress software, including 
overview of NovoExpress software interface, Title Block, Menu, Workspace 
Toolbar, Cytometer Setting panel, Cytometer Control panel, Plate Manager panel, 
Experiment Manager panel, Cytometer Status panel , Gate Manager panel, Status 
Bar, Instrument Configuration window and Manage Plate Types window. 

4  Sample Acquisition 

This chapter provides the information for sample acquisition function, including 
Cytometer Setting panel, Work List, and Cytometer Control panel. 

5 Data Analysis 

This chapter provides information for data analysis tools, including Plots, Gates, 
Statistics, Fluorescence Compensation, Cell Cycle Analysis, Cell Proliferation 
Analysis, Statistical Tables, Heat Maps and Post Gain. 

6 Plate Manager 

This chapter provides the information for the Plate Manager panel, including 
overview of Plate Manager panel and context menu. 

7 Experiment Manager 
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This chapter provides the information for the Experiment Manager function, 
including Experiment Manager Toolbar, Hierarchy, Templates, Import and Export 
Data. 

8 Reports 

This chapter provides information for the Report function, including Report 
Interface, Automatically Generate Reports, Report Options, Report Editor, Report 
Output and Batch Print Reports. 

9 QC Test 

This chapter describes the procedures to run QC test and view the report for 
Agilent flow cytometers. 

10 Troubleshoot 

This chapter provides the information for troubleshooting Agilent flow cytometer 
instrument and associated accessories, including prompted message ID, software 
messages, possible causes, recommended solutions, and procedures to create 
technical support files. 

11 Version History 

 

 
  



Contents 

 Software Guide 5 

Contents 
In This Guide 3 

Contents 5 

1 Prologue 13 

About NovoExpress 13 

Using this Guide 13 

Keyboard Shortcuts 13 

Glossary 15 

2 Installation 21 

Installation Requirements 21 

Install NovoExpress Software 21 

Start NovoExpress Software 24 

Uninstall NovoExpress Software 25 

NovoExpress License 26 

Free Trial 26 

NovoExpress Registration 26 

NovoExpress Dissociation 28 

User Management 29 

User Groups 30 

Users 34 

3 Use NovoExpress Software 39 

NovoExpress Software Interface 39 

Title Block 41 

Menu 42 



Contents 

6   Software Guide 

File 42 

Home 45 

Instrument 49 

Sample 55 

Plot 57 

Gate 59 

View 60 

Setting 60 

Workspace Toolbar 74 

Cytometer Setting Panel 77 

Cytometer Control Panel 77 

Plate Manager 78 

Experiment Manager 80 

Cytometer Status Panel 81 

Gate Manager Panel 85 

Status Bar 85 

Green Indicator 85 

Flashing Red Indicator 86 

Flashing Yellow Indicator 86 

Black Indicator 87 

Instrument Configuration 87 

Instrument Configuration with Instrument Connected 88 

Instrument Configuration with Instrument Disconnected 91 

Manage Plate Types 92 

4  Sample Acquisition 99 

Cytometer Setting 99 



Contents 

 Software Guide 7 

Parameters Settings 100 

Stop Condition Settings 101 

Flow Rate Settings 103 

Threshold Settings 103 

Work List 104 

Open the Work List 107 

Work List Management 107 

Edit a Work List Cell 109 

Cytometer Control 112 

Active Sample Information 113 

Experiment Control 113 

5 Data Analysis 119 

Plots 119 

Create a Plot 121 

Open and Close a Plot Window 124 

Edit Plots 124 

Set the Coordinates of the Axis 128 

Adjust the Size of Plots 135 

Copy or Save Plots 136 

Overlays 136 

Plot Formatting 139 

Bi-Variate Plots 145 

Gates 149 

Create Gates 149 

Edit Gates 151 

Gate Display Format 152 

Apply a Gate to a Plot 155 



Contents 

8   Software Guide 

Copy and Paste Gates 156 

Export Gate Events 156 

Gate Manager 157 

Statistics 160 

Display Statistical Information 160 

Calculation of Statistics 165 

Fluorescence Compensation 168 

Automatic Compensation 168 

Active Compensation 177 

Quick Compensation Adjustment 179 

Cell Cycle Analysis 181 

Automated Cell Cycle Analysis 181 

Manual Cell Cycle Analysis 183 

Cell Proliferation Analysis 186 

Automated Cell Proliferation Analysis 186 

Cell Proliferation Setting 189 

Statistical Tables 191 

Create Different Types of Statistical Tables 192 

Statistical Table Columns 194 

Statistical Table Rows 198 

Statistical Tables Export or Copy Text 200 

Statistical Table Options 200 

Statistical Table Management 201 

Heat Maps 202 

Create a New Heat Map 202 

Heat Map Window 202 

Edit Heat Map Statistics Window 205 



Contents 

 Software Guide 9 

Update Heat Map 207 

Save Heat Map 207 

Copy Heat Map 209 

Heat Maps Management 209 

Post Gain 210 

Adjust Post Gain 210 

Clear Post Gain 212 

Apply Post Gain 213 

Export Post Gained Data 213 

6 Plate Manager 215 

Overview of Plate Manager Panel 215 

Context Menu 222 

Context menu when a single well is selected 222 

Context menu when multiple wells are selected 225 

7 Experiment Manager 229 

Experiment Manager Toolbar 229 

Hierarchy 229 

Description 229 

Right-Click Menu 233 

Move Items 239 

Merge Samples 240 

Templates 243 

Copy and Paste the Template 243 

Drag and Drop the Templates 245 

Use the Toolbar 247 

Import and Export Templates 247 



Contents 

10   Software Guide 

Import and Export Data 250 

Import Data 250 

Export Data 250 

Copy and Paste Events 253 

8 Reports 255 

Report Interface 256 

Automatically Generate Reports 259 

Report Options 260 

Report Editor 263 

Add Report Objects 263 

Select Report Objects 264 

Edit Report Objects 265 

Align Report Project Items 269 

Resize Objects 269 

Order Object Levels 269 

Cut, Copy, Paste, and Delete 269 

Insert or Delete Pages 270 

Header and Footers 270 

Report Output 272 

Batch Print Reports 272 

9 QC Test 275 

Prepare QC Particle Sample 276 

Run QC Test 276 

View QC Test Report 281 

10 Troubleshoot 285 



Contents 

 Software Guide 11 

Troubleshoot Instrument 285 

Technical Support Request 294 

11 Version History 297 

 



Contents 

12   Software Guide 

 

This page is intentionally left blank. 



Prologue 

 Software Guide 13 

1 Prologue 

This chapter provides basic information for NovoExpress and the software guide, 
including overview of NovoExpress, scope of this guide, keyboard shortcuts and 
glossary. 

About NovoExpress 

NovoExpress Software provides users with the ability to control data collection 
and analysis on Agilent flow cytometer and associated accessories. The software 
contains features to control Quality Control (QC) test, sample acquisition, data 
analysis, and report generation.  

Using this Guide 

This guide contains an overview and information on using NovoExpress software. 
For information on the operation and maintenance of Agilent flow cytometer and 
associated accessories, please refer to associated operator's guide. 

Keyboard Shortcuts 

 

Shortcuts Command 

Overall Situation 

Ctrl + [ Switch the active sample to the previous sample  

Ctrl + ] Switch the active sample to the next sample  

Ctrl + 1 Create a dot plot  

Ctrl + 2 Create a density plot  
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Ctrl + 3 Create a histogram  

Ctrl + 4 Create a contour plot  

Ctrl + 5 Create a cell cycle diagram  

Ctrl + 6 Create a cell proliferation diagram 

Ctrl + N New file  

Ctrl + O Open the file  

Ctrl + S Save the file  

Ctrl + W Close the file  

F3 Next sample without template  

F4 Next sample  

F5 Run / Stop / Run single well / Stop Single Well 

F6 Run Plate / Stop 

F7 Pause / Continue 

F8 Restart 

Plot 

Alt + 1 Change to dot plot 

Alt + 2 Change the density plot  

Alt + 3 Change to histogram  

Alt + 4 Change to contour plot  

Alt + 5 Change to cell cycle diagram  

Alt + 6 Change to cell proliferation diagram 

Alt + Q Quick compensation  

Ctrl + + Zoom In 

Ctrl + - (Minus Key) Zoom Out 

Ctrl + A Auto Range  

Ctrl + B Bi-Range gates  

Ctrl + C Copy the plot or gate  

Ctrl + D Duplicate a plot or gate  

Ctrl + E Elliptical gate  

Ctrl + F Full Range  

Ctrl + H Range gates  
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Ctrl + J Freehand gate 

Ctrl + L Logic gates 

Ctrl + M Move 

Ctrl + P Polygonal gate  

Ctrl + Q Quadrant gate  

Ctrl + R Rectangular gate  

Ctrl + T Adjust threshold 

Ctrl + V Paste gate  

Ctrl +Y or Ctrl + Shift + Z Redo  

Ctrl + Z Undo  

Experiment Manager 

Ctrl + C Copy 

Ctrl + D Duplicate 

Ctrl + V Paste 

F2 Rename 

Glossary 

Term Definition 

Absolute count Number of cells or particles per unit volume. Agilent flow cytometer is a 
volumetric instrument, thus, exact volumes of acquired sample can be 
determined without the need for counting beads. After the dilution 
factor and unit of measure (default is # of events per µL) are defined by 
user, NovoExpress can display number of events within specified gate 
per unit volume in the statistical information chart. 

Active sample The sample currently displayed and being analyzed. The Cytometer 
Control and Cytometer Setting panels display basic information 
regarding the active sample. In the Experiment Manager panel, the 
active sample is indicated by a red arrow. To switch the active sample, 
double-click on a new sample in the Experiment Manager panel, use 
the Switch Active Sample buttons from the Sample tab of the Menu 
Bar, or use the combination of Ctrl + [ or Ctrl + ] on the keyboard to go 
backward or forward. 

Adjust on Plot A function to adjust threshold value on plot. 
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Alias Alternative and customizable name for fluorescence parameter.  

Analysis The process of plotting, gating, and comparing statistical information 
on collected parameters of samples. 

Auto compensation Use a specimen containing an unstained sample and single stained 
samples to automatically calculate a compensation matrix. 

Auto Range A function which allows user to display the range for the X-axis and Y-
axis to fit the experimental data. 

Backflush Clear blockages in the sample pipeline. 

Batch Print Reports A function to print or create PDF of multiple specimen and sample 
reports. 

Bi-Range Gate Draws a gate with two ranges 

Bi-Variate Plot A matrix of plots with selected parameters plotted against each other. 

Blank samples Samples without collected event data. A blank sample must first be 
created before sample collection begins. Created blank samples 
contain the default settings from the previously created sample. See 
the icon for a blank sample in Hierarchy. 

Cell cycle plot Uses a histogram of DNA content to derive cell cycle phase populations 
based on curve fitting to the histogram. 

Cell proliferation plot Generates c modeling results to analyze different cell generations 
during the cell proliferation procedure. 

Cleaning Clear biological hazards that may exist in the pipeline. 

Compensation Matrix A matrix which contains each photo detector's value that is subtracted 
in order to determine the final calculated true fluorescence. 

Contour plot Two-parameter plot. Each axis can plot a parameter. The plot uses 
contour lines to indicate the density of populations on the plot. 

Core Diameter The diameter of hydrodynamic focusing which corresponds to the flow 
rate. 

Debubble Clear bubbles present in the sample line. 

Decontamination Decontaminate the instrument when it is known to have contamination 
or to prevent the occurrence of contamination 

Density plot Two-parameter plot. Each axis can plot a parameter. The color of a 
point on the plot will be an indicator of the number of events at that 
point. 

Dot plot Two-parameter plot. Each axis can plot a parameter. Multiple 
overlapping points will be displayed the same as a single point in a dot 
plot. 

Elliptical Gate Draws an elliptical gate  



Prologue 

 Software Guide 17 

Event Refers to a particle that passes the acquisition threshold and has a set 
of data on intensity collected. Events are due to particles including 
microspheres and cells. 

Experiment File The NovoExpress Software saved experimental data files. A file can 
store experimental data from multiple samples. 

Experiment Manager The NovoExpress Software uses samples, specimens, and groups in a 
hierarchy structure to organize the experimental data, instrument 
settings, analysis and other information. The organization is displayed 
in the Experiment Manager panel. 

Export to LIS A function allows a user to export data analysis results in the 
designated format to CSV file and such CSV file can be parsed by a 
Laboratory Information System (LIS) or read by other programs. 

Extensive Rinse Extensively rinse tubing 

FCS Data file standard for flow cytometry. NovoExpress is compatible with 
FCS 3.0 and 3.1. 

Fluidics maintenance 
sequences 

A function to program and run multiple fluidics maintenance 
sequences in pre-defined order 

Fluorescence compensation Different fluorescent dyes emit different emission spectrums. When 
emission spectrums overlap, this is known as spectrum overlap. When 
the overlap occurs within a detection channel, fluorescence 
compensation can be used to mathematically compensate by 
removing the signal that does not belong in the channel. 

Freehand Gate Draws a freehand gate. 

Free Unused File Space When events of a sample or all samples are deleted, the file space is 
not automatically released. Click on this icon to free the file space. The 
file space can also be released by saving the file to the hard drive. Large 
files may take longer to release. 

Full Range Sets the full range of the X and Y-Axes.  

Gain A parameter corresponds to the output current of a photodetector for 
fluorescent signal detection. 

Gate Used to select a specific population of events. Gate types include 
rectangular, elliptical, polygonal, freehand, range, and bi-range gates. 
Gates can also be combined to create logic gates. Gates are used to 
further analyze specific populations. 

Group A part of the NovoExpress Software’s hierarchy structure. The group 
can contain multiple specimens. 

Heat Map Heat map can be used to visualize the data in a well plate format. It 
uses different color to display the result of a specified statistical 
parameter. 

Histogram Plot Single-parameter plot. The X-axis will plot a parameter, and the Y-axis 
will plot the number of events. 
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HT Abbreviation for High Throughput. 

Instrument settings The settings include the sample, the stop condition, the sample flow 
rate, and the threshold settings. 

Layer The option to superimpose multiple plots to make a comparison. This 
tool is available with histograms and dot plots. The overlay plots then 
contain these superimposed layers. 

LIS (Laboratory Information 
System) 

Result of a statistical table and plots can be exported and parsed by LIS 

Logic gate The combination of individual gates using the logic operators AND, OR, 
or NOT to create logic gates. 

Merge Samples Merge two or more samples when they were collected from same 
instrument (i.e. same instrument serial number, and same optical 
configuration), with same data acquisition parameters selected in the 
Cytometer Setting panel, with same data acquisition mode (i.e. 
Absolute Count mode applied or not), and the total events from 
merged samples are less than 10 million.  

Overlay Display the data from multiple samples and gates in one plot with 
different colors. 

Parameters Refers to fluorescent or scattering intensity measurements. 
Parameters can be differentiated by the specific light channel or 
measurement type (height or area). 

Plot Tool for displaying sample information, including fluorescence or 
scattered light intensity. In the NovoExpress Software, plots include dot 
plots, density plots, histograms, contour plots and cell cycle diagrams. 

Polygon Gate Draws a polygon gate. 

Post Gain In certain situation, user may want to align a particular peak on 
different samples in the same plot. Post Gain function allows such 
adjustment performed after data acquisition. 

Priming Use after the instrument has been inactive for a long period of time to 
fill the tubing with fresh sheath fluid and clear any bubbles 

Purge If Agilent flow cytometer needs to be shipped, click this button and 
follow the procedure shown on the popup window to purge the fluidic 
system before packaging and shipment. 

QC test In QC test, Agilent Flow Cytometer QC Particles are used to check the 
instrument performance. Measured data are used to determine if the 
instrument parameters fall within a standard range to ensure stable 
and reliable operation of the instrument. 

QC test reports QC test reports contain parameters for individual QC test results, and it 
can also plot results over a period of time in the Levey-Jennings 
reports. 
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Quick compensation Use scrollbars in two-parameter plots to quickly adjust the 
fluorescence compensation of a sample. 

Quadrant Gate Draws an quadrant gate. 

Range Gate Draws a gate with single range. 

Reagent Lots Sets the type of the reagent in prompted window. 

Rectangular Gate Draws a rectangular gate 

Report Reports can be either a specimen report or a sample report. A sample 
report can contain plots, statistical information, compensation 
matrices, and collection information for the sample. A specimen report 
will contain information for all the samples included in the specimen. 

Reset Layout Resets the layout of the panels to the default layout. 

Rinse A function to rinse fluidic system. 

Sample The basic unit of experimental data organization. Samples contain the 
information from sample data collection, instrument settings, 
fluorescence compensation, reporting, analysis and data. 

Sample currently in 
acquisition 

Usually, sample currently in acquisition is same as active sample; 
however, they do not have to be same sample. After sample acquisition 
is started, user can switch active sample to other sample for analysis 
purpose. In Experiment Manager panel, sample currently in acquisition 
has a flash arrow (alternating green and dark green). If sample 
currently in acquisition is same as active sample, the arrow alternating 
red and green. 

Sample flow rate The flow rate of the sample can be used to control the number of 
events collected per second. 

Specimen A part of the NovoExpress Software’s hierarchy structure. Specimen 
can be composed of many samples; multiple samples of the same test 
items can be placed in a specimen; a clinical specimen can correspond 
to a patient. 

Spillover Matrix A matrix contains value of spillover of each fluorochrome into each of 
the others. It is inversely related to the compensation matrix. 

Statistical table A customizable table of statistical information for batch data analysis. 
It can contain multiple samples, multiple gates, and statistical 
information for multiple parameters. 

Stop condition A defined number of events, length of time, or volume of collection, 
where sample collection is stopped immediately after reaching the 
condition. 

Storage Gate Filter out events outside the selected gate. 

System Log A window records information including user login and log out, and 
instrument operating activities including data acquisition, fluidics 
maintenance, etc. 
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Technical Support Request A function which automatically collects instrument configurations, 
NovoExpress system logs, current screenshot, current experiment file 
and other information that helps diagnosis and troubleshooting of 
instrument. 

Templates Set contains the group, instrument settings, specimens and samples, 
fluorescence compensation, reporting, analysis, etc., can be saved as 
*.nct file format. 

Threshold The minimum value of defined parameters where if the signal is lower 
than the defined value, the data will be discarded. By setting an 
appropriate threshold value, the target events can be effectively 
captured. A threshold value too high will discard target events, while a 
threshold too low will include a large noise from small events being 
collected. 

Transaction Log A window which displays recorded information related to changes to 
the experiment file, such as Time, Computer, Software Version, User, 
and Action. 

Unclog Clear blockages in the flow cell. 

Work List Displays the samples as rows in a table. Sample settings are also listed 
and can be set in the table, including specimen name, sample name, 
parameters, stop condition, sample flow rate, threshold, compensation, 
and analysis is reporting information. Allows the user to quickly create 
and manage multiple samples. 

Workspace In the main interface of the NovoExpress Software, the middle area 
where plots are displayed. 
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2 Installation 

This chapter describes the installation requirements, procedures to install, start 
and uninstall the NovoExpress software, NovoExpress license registration and 
dissociation, and user management feature.  

Installation Requirements 

Before installing the NovoExpress Software, ensure that your computer meets the 
following minimum requirements: 

Hardware: 
• Processor: 1 GHz 
• Computer Memory: 2 GB 
• Hard Drive: 10 GB free space 
• Screen Resolution: 1024 X 768 pixels or higher 

Software: 
• Operating System: Windows 7 SP1/Windows 10 
• PDF Reader Software 

 
 

NOTE To analyze high event-count samples (event count greater than 1 million), 8 GB 
memory and quad-core 2.5 GHz CPU are required. 

 
 

Install NovoExpress Software 

Install NovoExpress Software using the following instructions: 
 

1 Download the NovoExpress Software installation package from website 
https://www.agilent.com/chem/novoexpress and unzip it. Double-click the 

https://www.agilent.com/chem/novoexpress
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Setup.exe file in the NovoExpress installation directory to start the installation 
process. 

2 The NovoExpress Software installation wizard will display. Click Next to 
continue. 

 

3 Please read the license agreement and accept by selecting the check box and 
clicking Next. 

 

4 Choose the installation location. By default, the NovoExpress Software will be 
installed in C:\Program Files (x86)\NovoExpress. To install the software to 
another location, enter the target location or click Browse to select a 
destination folder. If the selected path does not exist, the installation wizard 
will automatically create the directory. After selecting the destination folder, 
click Install to continue. 
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5 After the installation is complete, click Finish to finish the installation and start 
the software. If you would not like to immediately start the software, uncheck 
the Run NovoExpress box, and click Finish. 
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Start NovoExpress Software 

After the successful installation of the NovoExpress Software, the program can be 
started by the following methods: 
• Desktop Shortcut 

 

• Start Menu 
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Uninstall NovoExpress Software 

The NovoExpress Software can be uninstalled by the following methods: 
• Control Panel 

Start > Windows System > Control Panel > Programs and Features 

In the new window, select NovoExpress and select Uninstall/Change. 

 

 

• Start Menu 
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NovoExpress License 

Free Trial 

NovoExpress is available for a 30-day free trial. The Register NovoExpress window 
will automatically pop up every time starting the NovoExpress software during the 
trial expiration. Click the Evaluate button to start the free trial of NovoExpress. 

 

Registration will be needed to use the software after the trial expires. User can 
enter the NovoExpress Software License Key which comes with instrument. User 
can also purchase it separately from Agilent. 

NovoExpress Registration 

The Register NovoExpress window will automatically pop up when starting the 
NovoExpress software if the software is not registered yet. You can also click File 
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> About > Register NovoExpress to open the Register NovoExpress window. 
There are two ways to register NovoExpress. 
• If the computer is connected to the internet, enter a valid Agilent issued license 

key and a valid email address and click the Register button to register 
NovoExpress. 

 

• If the computer is not connected to the internet, click the Offline Registration 
button to switch to offline registration mode. Write down the Machine Code 
displayed in the window and go to another computer that is connected to the 
internet and open the Get Registration Code web page 
(https://www.agilent.com/chem/novoexpress). On the web page, enter the 
Machine Code into the specified textbox, type a valid Agilent issued license 
key, and then click Get Registration Code. Write down the Registration Code, 
enter it to the Register NovoExpress window, and click Register button to 
register NovoExpress. 

https://www.agilent.com/chem/novoexpress
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NOTE A license key is required for NovoExpress software registration or license transfer. 
Software will automatically record the license key. However, it is still recommended 
to keep a safe record of license key assigned to each computer or user. 

 
 

NovoExpress Dissociation 

NovoExpress supports license transfer to another computer. Each license may be 
transferred up to 5 times. If you want to transfer the NovoExpress license to 
another computer, log in the software with Administrator account, click File > 
About > Dissociate NovoExpress to open the Dissociate NovoExpress window. 
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The license key recorded during software registration will automatically filled in the 
text box. User can click the Dissociate button to dissociate or decouple 
NovoExpress from this computer. After dissociation, the license key can be used 
to register NovoExpress on another computer. 

 

NOTE Please connect NovoCyte workstation to the internet when dissociating the license. 
Contact Agilent technical support for how to dissociate the license if no connection 
to the internet is available. 

 
 

NOTE Only the users with the Administrator privilege can conduct this license 
dissociation process. 

 

User Management 

A user management feature is included with the NovoExpress Software allowing 
for separate user settings to be saved in different accounts. 

When starting the NovoExpress Software, a login window will appear. By checking 
the Auto Login box, the software will automatically login with the associated user 
account and the login window will not appear in the future.  

The NovoExpress Software initially includes a system administrator account with 
username as “administrator”. The default password for this account is 
“administrator”. This system administrator account has the highest privilege and 
the username “administrator” cannot be changed. This system administrator and 
users with the Administrator privilege can add, delete, and modify information for 
all the other users and user groups. There is no limit to the number of user groups 
or user accounts. Each user belongs to a specific user group. The methods for 
adding, modifying and deleting a user group are described in User Groups. The 
methods for adding, modifying, and deleting a user account are described in  
Users. A user can directly enter the username and password to log in the software, 
or select the specific user group first, select the username, and enter the correct 
password to log in the software.  
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User Groups 

NovoExpress contains a user group management feature to allow groups of 
multiple users. Only users with Administrator privilege can add, modify, and delete 
user groups. The root parent group “Organization” is included by default. Users 
can only add group under this root group. 

Add a User Group 

New user groups can only be added through an account with Administrator 
privilege. To add a new user group: 
1 Log into the software using an account with Administrator privilege. 
2 Select the Setting tab. 
3 Click User > Management. The User Management window will appear.  



Installation 

 Software Guide 31 

 

4 Click Add Group. The Add User Group window will appear. 

 

5 Enter the group name and select the desired parent group for the created user 
group in the prompted window.  

6 Click Add and the new user group is created. 
 
 

Modify a User Group 

User groups can only be modified through an account with Administrator privilege. 
To modify a user group: 
1 Log into the software using an account with Administrator privilege. 
2 Select the Setting tab. 
3 Click User > Management. The User Management window will appear.  
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4 Select the group to be modified. Click Modify. The Modify Group window will 
appear. 

 

5 Modify the group name and select the desired parent group for the modified 
user group in the prompted window. 

6 Click Modify and the user group is modified. 
 
 

Delete a User Group 

User groups can only be deleted through an account with Administrator privilege. 
To delete a user group: 
1 Log into the software using an account with Administrator privilege. 
2 Select the Setting tab. 
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3 Click User > Management. The User Management window will appear. Select 
the group to be deleted. Click Delete. 

 

4 Click Yes in the prompted window and the selected user group is deleted. 

 
 
 

NOTE When the selected user group is deleted, the user accounts in the group will 
automatically be moved to the deleted group’s parent group. 

 
 

NOTE The root parent group Organization cannot be deleted. 
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Display the Users in a User Group 

The right half of the User Management window displays the users contained in the 
user groups with check box checked in the left half of the window. All displayed 
usernames are automatically listed in alphabetical order. 

   

Users 

NovoExpress contains a user management feature to allow different settings and 
privileges for each user account. Only users with the Administrator privilege can 
add, modify, and delete user accounts.  

Add a New User 

New users can only be added through an account with Administrator privilege. To 
add a new user: 
1 Log into the software using an account with Administrator privilege. 
2 Select the Setting tab. 
3 Click User > Management. The User Management window will appear.  
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4 Select a user group. Click Add User. The Add User window will appear. 

 

5 Enter username and password and assign user privilege (User or 
Administrator) for the created account in the prompted window.  

6 Click Add and the new user account is created. 
 
 

Modify User Information 

Accounts with Administrator privilege can modify username, user privilege, access 
privilege, and password for each user, while other accounts can only modify its 
own username, user group name, and password. 
• From the administrator account or an account with Administrator privilege: 

a After logging in, select the Setting tab. 
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b Click User > Management. The User Management window will appear. 
Select the user group, and then the user account you would like to modify. 

 

c Click Modify. The Modify window will appear allowing the user to make 
changes to the account. 

 

• From individual user accounts: 
a After logging in, select the Setting tab. 
b Click User > Modify. The Modify window will appear allowing the user to 

make changes to the logged in account. Please note User Privilege and 
Access Privilege can only be modified by accounts with Administrator 
privilege. 
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Access Privilege 

Several functions in NovoExpress are only accessible to accounts with specified 
Access Privileges, including: 
• Photodetector Gain Adjustment 
• View Transaction Log 
• View System Log 
• Decontaminate Instrument 
• Delete Sample Events 
• Merge Samples 
• Calibrate Fluidics Station/Cart 
• Purge Instrument 
• Power Down/Up NovoSampler 
• Post Gain Adjustment 
• Customize Optical Configuration 

To modify the Access Privilege for users, click the  button in the Modify 
window and then select or unselect checkboxes in the popup Access Privilege 
window. Click OK to confirm changes. 
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Delete a User 

User accounts can only be deleted through an account with Administrator 
privilege. To delete a user account: 
1 Login to the software as the administrator or an account with Administrator 

privilege. 
2 Select the Setting tab. 
3 Click User > Management. The User Management window will appear. 

 

4 Select the user account that you would like to delete. 
5 Click Delete. 
6 In the confirmation window, click Yes. 
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3 Use NovoExpress Software 

This chapter provides information needed to use NovoExpress software, including 
overview of NovoExpress software interface, Title Block, Menu, Workspace 
Toolbar, Cytometer Setting panel, Cytometer Control panel, Plate Manager panel, 
Experiment Manager panel, Cytometer Status panel , Gate Manager panel, Status 
Bar, Instrument Configuration window and Manage Plate Types window. 

NovoExpress Software Interface 

After starting the NovoExpress Software, the initial interface (i.e. main window) 
may look different depending on whether NovoSampler (or NovoSampler Pro or 
NovoSampler Q) is connected. 
• If NovoSampler (or NovoSampler Pro or NovoSampler Q) is not connected, 

user will see following interface which includes a Title Block, Menu, Cytometer 
Setting Panel, Toolbar, Experiment Manager Panel, Cytometer Control Panel, 
Workspace, and Status Bar. 
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• If NovoSampler (or NovoSampler Pro or NovoSampler Q) is connected, user 
will see following interface. Compared to the software interface with 
instrument alone, differences are observed in the Menu Bar, Cytometer 
Control panel, Experiment Manager panel, and Work List. The Plate Manager 
panel is only visible when NovoSampler (or NovoSampler Pro or NovoSampler 
Q) is installed. 
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Title Block 

The Title Block displays the data file name in the center. It also provides options 
for opening, saving, and closing an experiment file. 

 
 

Icon Description 

 

Clicking this button displays a drop-down menu with options to resize the 
display window and close the software. 

 

Saves the experiment file. 

 

Creates a new experiment file. 

 
Opens an experiment file. 

 
Undo drawing gates, deleting gates, zooming in or zooming out on a plot, 
etc. This operation is only effective for plot related functions.  
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Redo drawing gates, delete gates, zooming in or zooming out on a plot, 
etc. This operation is only effective for plot related functions. 

 
Displays the data file name (*.ncf). 

 
Minimizes window. 

 
Maximizes window. 

 
Restores window. 

 
Closes window. 

Menu 

The Menu contains functions for instrument control and data analysis. 

File 

 
 

Icon Description 

 

New experiment file 
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• New Experiment: Creates a new experiment file. 
• New from Template: Imports a template (*.nct) for the new experiment. 
• New from Experiment File: Creates a new experiment file with the experiment 

setting and data analysis method inherited from an existing experiment file. 
• New from JSON File: Creates a new experiment file with the experiment setting 

and data analysis method inherited from an existing JSON file. This option is only 
available when NovoCyte Quanteon, NovoCyte Advanteon or NovoCyte Penteon 
is connected. 

 
Open experiment (*.ncf) file 

 
• Open Experiment File: Opens an experiment file. 
• Import FCS files: Imports selected file to the current specimen. 
• Import FCS Files from Folder: Imports all FCS files in a selected folder to the 

current FCS specimen. 

 
Closes the current experiment file and creates a new experiment file. 
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Saves the experiment data, experiment setup, and data analysis of the current 
experiment file. 

 

Saves the current experiment file to a specified location. 

 

Prints sample report/batch print reports 

 
• Print Report for Active Sample: Prints the report for the current sample. 
• Batch Print Reports: Opens the Batch Print Reports window. 

 

About: Contains the software version, copyright information, help files, and 
registration information. 

 
• About NovoExpress: Displays the software version and copyright information.  
• Register NovoExpress: Registers the NovoExpress software.  
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• Help Document: Opens the help file (i.e. NovoExpress Software Guide). 

 

Options: Opens the Options window. See Setting for details. 

 
Recent Documents: Shows recently opened data files. Up to 10 files can be 
displayed. Click the file name to directly open the corresponding file. 

 
Logout: Exits and logs out of the current account. The login window will appear. 

 
Exit: Exits the software. 

Home 

 
 

Icon Description 

Clipboard 

 

Copy: Copies the selected gate or selected data. 

 

Paste: Pastes the copied gate to other plots or pastes the copied item in the 
Experiment Manager. 

 

Duplicate: Creates a duplicate of the plot (the gates will not be included.) or creates a 
duplicate sample or specimen. 

Editing 

 

Undo drawing gates, deleting gates, zooming in or zooming out on a plot, etc. This 
operation is only effective for plot-related functions.  
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Redo drawing gates, delete gates, zooming in or zooming out on a plot, etc. This 
operation is only effective for plot-related functions. 

 

Select All: Selects all the gates in the current plot. 

 

Delete: Deletes the selected gate. 

Compensation 

 

Auto Compensation: Opens the Automatic Compensation Settings window.  

 

Compensation Matrix: Displays the current compensation matrix for the selected 
sample. 

 

Quick Compensation: Displays the Compensation scrollbars on the active plot for quick 
compensation. 

Experiment 

 

Work List: Users may view and edit the Work List. 

 

Plate View: This function is only available when NovoSampler (or NovoSampler Pro or 
NovoSampler Q) is used. User can view the sample information for each well in the 
prompted window. 

 

Statistical Table: Creates a statistical analysis table. 

 

Heat Map: Creates a heat map for the defined parameter in a plate layout format. 

Tools 

 

Batch Print Reports: Prints or creates PDF of multiple test reports. 

 

Free Unused File Space: When events of a sample or all samples are deleted, the file 
space is not automatically released. Click on this icon to free the file space. The file 
space can also be released by saving the file to the hard drive. Large files may take 
longer to release. 

 

Export to LIS: 
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This function allows a user to export data analysis results in the designated format to 
CSV file and such CSV file can be parsed by a Laboratory Information System (LIS) or 
read by other programs.  
• Statistical table template: Sets the proper statistical table template to export the 

data. To add a statistical table template, export the statistical table as a template to 
the default folder “User data root folder\Statistical Table Templates”. Refer to 
Statistical Table Management for details. 

• Export plots in Specimen/Sample report as image: Once selected, plots in the 
specimen report or sample report will be exported as images in the selected image 
file format to the designated folder. 

• Image file format: Sets the image file format of the export plots, including PNG, 
JPEG, Bitmap, GIF and TIFF format. 

• Export: Exports the data and the plots into designated folders. The data will be 
exported into *.csv file in UTF-8 code. * is the same as the experiment name. The 
created csv file will be automatically saved in “User data root folder\LIS Results” 
folder, and plots will be saved in “User data root folder\LIS Plots” folder. The default 
user data root folder is “D:\NovoExpress Data\administrator” and can be changed. 
Refer to Setting for details of changing the default user data root folder. 

 

Transaction Log: Displays the Transaction Log window. Records can be filtered by 
Time, Computer, User, and Action. Only accounts with the View Transaction Log 
privilege can access the Transaction Log.  
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System Log: Displays the System Log window. Only accounts which have the View 
System Log privilege can access the System Log. The System Log window records 
information including user login and log out, and instrument operating activities 
including data acquisition, fluidics maintenance, etc. 

 

 

Technical Support Request: Technical Support Request Creation Wizard automatically 
collects instrument configurations, NovoExpress system logs, current screenshot, 
current experiment file and other information that helps diagnosis and troubleshooting 
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of instrument. You can also attach any other files using this function. Refer to  
Troubleshoot in this guide for details.  

Instrument 

This panel allows user to view the instrument configuration, conduct instrument 
operation and maintenance. The availability of these functions depends on the 
model of instrument connected to the workstation. When NovoSampler (or 
NovoSampler Pro or NovoSampler Q) is connected, additional functions are 
available.  

 

When NovoCyte flow cytometer is connected 

 

When NovoCyte flow cytometer and NovoSampler (or NovoSampler Pro) are connected 

 

When NovoCyte Quanteon (or Advanteon or Penteon) flow cytometer is connected  

 

When NovoCyte Quanteon (or Advanteon or Penteon) flow cytometer and NovoSampler Q are 
connected  

 

Icon Description 

Instrument 

 

Information: Click to display the instrument information.  
• When NovoCyte flow cytometer is connected, following window is prompted. User 

can view the hardware information (e.g. Product Model) for the instrument and 
fluidics station (or cart).   
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• When NovoCyte Quanteon and Advanteon flow cytometer is connected, following 

window is prompted. User can view the hardware information (e.g. Product Model) 
for the instrument, AD boards, COM board and fluidics station (or cart).   
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• When NovoCyte Penteon flow cytometer is connected, following window is 
prompted. User can view the hardware information (e.g. Product Model) for the 
instrument, AD boards, COM board, Laser board and fluidics station (or cart).   

 

 

Configuration: Displays and modifies the excitation laser and detection channel and 
options for the NovoSampler, NovoSampler Pro or NovoSampler Q. See Instrument 
Configuration for details. 

 

QC Test Report: Displays results from QC tests. The results can be viewed individually 
or plotted over a time interval in a Levey-Jennings chart.  

Operation 

 

Shut Down: Starts the shutdown process. After completion, the instrument will 
automatically turn off. To clean sample injection probe while shutting down instrument, 
see associated instrument operator's guide for more information. 

 
QC Test: Runs the instrument QC test. 

 

Calibrate Fluidics Station (or Fluidics Cart): Long distance transportation, movement 
and other reasons may cause the fluidics station (or Fluidics Cart) system malfunction. 
Use this function to re-calibrate the fluidics station (or Fluidics Cart). After clicking the 
button, it will ask to remove the instrument reagent containers from the fluidics station 
(or Fluidics Cart) before calibration. Only accounts with the Calibrate Fluidics Station 
(or Fluidics Cart) privilege can calibrate the fluidics station (or Fluidics Cart). 

 

Replace Fluidic System Consumables: Click the button to open the Replace Fluidic 
System Consumables window and follow the instructions to replace fluidic system 
consumables. See associated instrument operator's guide for more information. 
 

NOTE Agilent flow cytometer monitors the accumulated running time of the 
fluidic system consumables to ensure the consumables are changed in  
timely manner for optimal flow cytometry results. When the accumulate  
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running time is reached, NovoExpress software will prompt a message to 
remind the users to replace the consumables. 

 

  

Schedule Power On & Off: Click this button to open the Schedule Power On & Off 
window. User can schedule the instrument to be powered on or off at user defined time 
with user defined frequency. This function is available only when NovoCyte Quanteon, 
Advanteon or Penteon flow cytometer is connected. 

 
• Start Date: Select the start date of the instrument power on and off. The start date 

cannot be set to 7 days or more over the current date. 
• End Date: Select the end date of the instrument power on and off. 
• Start Time: Select the start time of instrument power on or off. 
• Recur On: Select the recurring frequency of instrument power on or off. 
• Add: Click to add the selected start time and recurring frequency to the schedule 

table. 
• Remove: Click to remove the selected schedule from the schedule table. 
• Set: Click to confirm and make the schedule effective.  
• Clear: Click to clear the schedule. 
After the scheduled power on and off was executed, and the software is launched with 
the instrument properly connected, following Power On & Off Timing Log window will 
pop up. User can view the date, status and remark of the executed power on and off 
function in this window. 
• Start Date: Select the start date of the instrument power on and off. The start date 

cannot be set to 7 days or more over the current date. 
• End Date: Select the end date of the instrument power on and off. 
• Start Time: Select the start time of instrument power on or off. 
• Recur On: Select the recurring frequency of instrument power on or off. 
• Add: Click to add the selected start time and recurring frequency to the schedule 

table. 
• Remove: Click to remove the selected schedule from the schedule table. 
• Set: Click to confirm and make the schedule effective.  
• Clear: Click to clear the schedule. 
After the scheduled power on and off was executed, and the software is launched with 
the instrument properly connected, following Power On & Off Timing Log window will 
pop up. User can view the date, status and remark of the executed power on and off 
function in this window. 
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Fluidics Maintenance 

 

Debubble: Removes the air bubbles from the fluidic system.  

 

Cleaning: Uses a cleaning solution to decontaminate the biohazards that may exist in 
the fluidic system.  

 

Rinse: Rinses the fluidic system using a rinsing solution.  

 

Extensive Rinse: Performs an extensive rinse of the fluidic system. This function is 
available only when NovoCyte flow cytometer is connected. 

 

Priming: After the instrument has not been in use for a period of time, this function 
clears the air bubbles and primes the fluidic system with fresh sheath fluid.  

 

Unclog: Clears blockage from the flow cell.  

 

Backflush: Clears blockage from the sample injection probe. This function is available 
only when NovoCyte flow cytometer is connected. 

 

Fluidics Maintenance Sequences: program and run multiple fluidics maintenance 
sequences in pre-defined order. 
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• Fluidics Maintenance Type: Select fluidics maintenance type (e.g. Cleaning, Rinse, 
Extensive Rinse, Priming, Unclog, Backflush for NovoCyte, and Cleaning, Rinse,  
Priming, Unclog for NovoCyte Quanteon, Advanteon and Penteon) 

• Iterations: Set the number of iterations for the selected fluidics maintenance 
sequence. 

• Add: Click to add the selected fluidics maintenance sequence to the table. 
• Remove: Click to remove the selected fluidics maintenance sequence from the 

table. 
• Total Iterations: The total number of iterations. 
• Finished Iterations: The number of completed iterations. 
• Shut down instrument after finishing the selected fluidics maintenance 

sequences: Check to shut down the instrument after finishing the selected fluidics 
maintenance sequences. 

• Start: Click to start the fluidics maintenance sequences in the pre-defined order (top 
to bottom). 

• Stop: Click to stop the fluidics maintenance sequences. The fluidics maintenance 
sequence currently running will continue until completed, but the remaining 
scheduled fluidics maintenance sequences will be aborted. 

• Continue: Click to continue the remaining fluidics maintenance sequences which 
was not completed. 

 

Purge: If Agilent flow cytometer needs to be shipped, click this button and follow the 
procedure shown on the popup window to purge the fluidic system before packaging 
and shipment. Only accounts with the Purge Instrument privilege enabled can perform 
the purge operation. Refer to Purge Fluidic System before Shipment in the associated 
instrument operator's guide for detailed procedure. 

 

Decontamination: If Agilent flow cytometer is known to have contamination or to 
prevent the occurrence of contamination, click this button and follow the instruction 
shown in the popup window to decontaminate the instrument. Only accounts with the 
Decontaminate Instrument privilege can perform this decontamination operation. 
Refer to Decontamination in the associated instrument operator's guide for detailed 
procedure. 

NovoSampler (or NovoSampler Pro or NovoSampler Q) 

 

Mix: Click to mix the sample. The Mix button from the Cytometer Control panel has the 
same function. 

 

Reset: Click to move the sample tray to the home position. This will allow a reset of the 
NovoSampler (or NovoSampler Pro or NovoSampler Q) in case of misalignment or 
error 

 

Calibrate: Click to calibrate the NovoSampler (or NovoSampler Pro or NovoSampler Q) 
with the instrument. 

 

Power Down/Up: When clicked, NovoSampler (or NovoSampler Pro or NovoSampler Q) 
will be powered on (if currently powered off) and allow the operation of the 
NovoSampler (or NovoSampler Pro or NovoSampler Q). After execution, the status 
indication LED on NovoSampler (or NovoSampler Pro or NovoSampler Q) will light up in 
green color. The NovoExpress will prompt a message to restart the software. After the 
software restart, a dialog box requesting to calibrate the NovoSampler (or 
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NovoSampler Pro or NovoSampler Q) will be shown. Click Calibrate to start the 
automatic calibration procedure. The software features for control and use of the 
NovoSampler (or NovoSampler Pro or NovoSampler Q) will be available after restart of 
the NovoExpress Software. If the NovoSampler (or NovoSampler Pro or NovoSampler 
Q) is already powered on, clicking this button will power off the NovoSampler (or 
NovoSampler Pro or NovoSampler Q), the status indication LED on NovoSampler (or 
NovoSampler Pro or NovoSampler Q) will be off. The NovoExpress will prompt a 
message to restart the software. After the software restart, only the instrument stand-
alone features will be available. This feature is only visible when logged into 
NovoExpress Software with the account with Power Down/Up NovoSampler privilege. 

 

Manage Plate Types: Click to add, remove, and modify plate settings in prompted 
window. Refer to Manage Plate Types in this guide for more details. 

Sample 

 
 

Icon Description 

Import and Export 

 

Import FCS File: Users may select FCS format files to import. 

 

Export FCS File: Exports the current data into a FCS file. 

 

Export CSV File: Exports the current data into a CSV file. 

 

Export Plots: Exports the plots of the active sample into files in PNG, JPEG, 

Switch Active Sample 

 

Previous: Switches the Active Sample to the previous sample. 

 

Next: Switches the Active Sample to the next sample. 

 

Select: Switches to an Active Sample from the prompted drop-down menu. 

Others 
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Delete Events: Deletes events from a sample. Users may select events inside a gate, 
outside a gate, or all events to delete. If the threshold or the photodetector gain has 
been adjusted during data acquisition, the Prior to last threshold or photodetector gain 
change radio button will be available to allow event deletion before the last adjustment. 
Only accounts with the Delete Sample Events privilege can perform this operation. 

 
 

NOTE  After deleting the events from a sample, the file size does not 
automatically decrease. When saving the file, the software will prompt 
a window, asking if the unused file space is to be released or not. To 
manually release the unused space, refer to Home in this guide for 
details. 

 

 

Absolute Count Setting: Sets up absolute counting conditions for active sample. 

 
• Dilution Factor:  

The Dilution Factor is conversion coefficient used to calculate the absolute 
counting results for the original sample. For instance, if the original sample is 
diluted 10 times and is run on the instrument, enter 1:10 in the Dilution Factor. 
NovoExpress software will show the absolute counting results for the original 
sample by multiplying the concentration of the sample run on instrument by 10.  

• Absolute Count Unit:  
The Absolute Count Unit is parameter to set the unit for the absolute counting. 
User can select one of the units (i.e. No./µL, No./mL, or No./L) to present 
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absolute count result for number of interested particles per microliter, per 
milliliter, or per liter.  

• Set as Default:  
Set the Absolute Count setting (i.e. Dilution Factor and Absolute Count Unit) as 
default for new samples. 

 

NOTE  Changing the settings in File > Options >Absolute Count tab also sets 
the settings as default. 

 

• Show Absolute Count in Statistics:  
Show Absolute Count column in the statistical table of the plots in the 
workspace. 

 

NOTE  There are three states of the checkbox: 
•  : Show Absolute Count column for all plots of the sample. 
•  : No change. 
•  : Hide Absolute Count column for all plots of the sample. 

 

• Apply to All Samples in the Experiment File:  
Set Absolute Count Setting for all samples in the experiment file. 

• Apply to All Samples in the Same Specimen:  
Set Absolute Count Setting for all samples belonging to the same specimen as 
the active sample. 

 

Further information on absolute count calculations are described in Calculation of 
Statistics. 

 

Remove Post Gain: Click this button to remove Post Gain of all parameters of the Active 
Sample. Only accounts with the Post Gain Adjustment privilege can perform this 
operation. To adjust Post Gain, refer to Post Gain. 

Plot 

 
 

Icon Description 

Properties 

 

Plot Type: Changes the plot type for the selected plot. 

 

Overlays: Opens the Edit Overlays window. Overlay is 
only available for dot plots and histograms. 

 

Gating: The gate and its events are selected as the 
current data source for plotting. 

 
Apply to All Plots: Apply the selected gate to all plots. 
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Show Title on Plot: Toggle on and off the display of a 
title on plots. This is set for all data analysis plots in the 
Workspace. 

 
Plot Name: Sets the name of a plot. 

X -Axis, Y –Axis 

 

 

• Sets plot properties for the X and Y-axes including 
the plotted parameter, scale (linear, logarithmic, or 
biexponential), and the display range. 

• Custom Range: Uses the input boxes to set the 
minimum and maximum displayed values for the 
selected parameter. 

• Automatic Range  : Automatically sets the range 
of the X and Y-Axes according to the range of the 
dataset. 

• Full Range  : Sets the full range of the X and Y-
Axes. The default range is 224=16,777,216. 

Format 

 

 

Format: Controls format settings for the plots. Available 
settings depend on the type of the selected plots. 
• Smooth: Smooths the data in histogram and density 

plots. 
• Pseudocolor: Density plots are displayed in pseudo-

color to visualize event density. 
• Events Displayed: Opens a window to set the 

number of events to be displayed in the plot. 
• Show Fitting Result: Displays the results for the cell 

cycle analysis. 
• Filling: Sets the histogram fill mode: None, Filled, or 

Tinted. 
• Contour Level: Sets the contour levels in contour 

plots. The three levels are: 10%, 5%, and 2%. 
• Show Outlier: Show outlier events as dots on 

contour plot. 

Output 

 

Save As Image: The plot can be exported in JPEG, BMP, 
PNG, GIF, TIFF, and EMF formats. EMF format is a 
vector format which, when exporting, uses 600dpi 
resolution TIFF format. 

 

Copy: Selects from the drop-down menu to copy to the 
clipboard. The plots can then be pasted into Microsoft 
Word, PowerPoint, Excel, and other documents.  
Pull-down options include:  
• Copy Plot (Bitmap): Copies the selected plot as a 

Bitmap. 
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• Copy Plot with Statistics (Bitmap): Copies the 
selected plot and associated statistical information 
as a Bitmap.  

• Copy Vector Graphics (EMF): Copies the selected 
plot as an EMF. 

• Copy Statistics (Text): Copies the statistics for the 
selected plot in text format. 

Gate 

 
 

Icon Description 

Current Selection 

 

Provides a drop-down menu of all available gates. A gate can be 
selected from this list. The Edit button is available only when a 
logic gate is selected. Click the Edit button to open the Edit 
Logic Gate window for modifying the setting of a logic gate. 

Format 

 

Formats the selected gate.  
Gate Name: Sets the name for the selected gate. 
Color: Sets the color for the selected gate. 
Show Percentile: Shows the percentage of the gated events 
relative to the total number of events on the plot. 
If the Show population percentile in gate label in Setting > 
Analysis is not checked, the Show Percentile option here will be 
disabled. 
Show Name: Shows the gate name in gate label on plot. 
If the Show gate name in gate label option in Setting > Analysis 
is not checked, the Show Name option here will be disabled. 

Apply Gate 

 
Gating: Applies the current gate to the selected plot. 

 
Create Plot: Creates a new plot and applies the current gate to 
the new plot.  

 

Export Events: Exports data for the events inside the current 
gate in either FCS or CVS format. 
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View 

 

 

Icon Description 

Show 

  

Shows or hides the corresponding panel. Plate 
Manager is available only when NovoSampler, 
NovoSampler Pro or NovoSampler Q is connected. 

 

Reset Layout: Resets the layout of the panels to the 
default layout. 

Zoom 

 

Zoom to: Selects the scaling of the size of the plots 
inside the workspace in the drop-down menu (50%-
150%). 
This function is equivalent to adjusting the sliding bar 
at the bottom-right corner of the software. 

 

100%: Restores the size of the plots inside the 
workspace to the default setting. 
This function is equivalent to adjusting the sliding bar 
at the bottom-right corner of the software to 100% 
value. 

 
Zoom out: Decreases the size of the plots inside the 
workspace. 
This function is equivalent to adjusting the sliding bar 
at the bottom-right corner of the software. One click 
corresponds to 1% increment. 

 
Zoom in: Increases the size of the plots inside the 
workspace. One click corresponds to 1% increment. 

Setting 
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Icon Description 

User 

 

Management: Use this function to manage all user groups and user accounts. It allows 
for adding, deleting, and modifying user groups and user accounts. This function is only 
available on the accounts with the Administrator privilege. 

 

Modify: Use this function to change the username and password of the currently logged 
in account. 

Options 

 

General: Allows user to define general settings. 

 
• Automatically login with User:  

If this box is checked, the current user will automatically be logged in when the 
software starts and the login window will not appear. 

• Display Language:  
Sets the display language.  

• Shut down NovoCyte every day at: 
If this box is checked, the instrument will automatically shut down at the selected 
time. For example, if the time is set to 22:00, the software will prompt a message 
window as shown below at 22:00 o’clock every day. The system will automatically 
shut down in 1 min if there is no operation from the user. 
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Only user with Administrator privilege can enable this function. If the instrument is 
not in the “Ready” status at the set time (i.e. the instrument is performing fluidic 
maintenance or data acquisition etc.), the software will wait until the instrument 
enters the “Ready” status before shutting down the instrument. If the instrument 
cannot enter the “Ready” status 30 mins after the set time, automatic shutdown 
function will be cancelled automatically.  

 
 

NOTE  The NovoExpress software should be opened at the selected time to 
perform this function. 

 
 

NOTE  User can also double click the icon  in the status bar to access this 
function. User can view the current status of this function (i.e. 
“Instrument will be shut down at the set time” or “Automatically 
shutting down instrument is disabled”) by placing the mouse on the 
icon . 

 

User can also enable or disable this function by left clicking the  icon in the 
status bar. 

 

NOTE  This function is available when NovoCyte instrument is connected. 
When NovoCyte Quanteon, NovoCyte Advanteon or NovoCyte Penteon 
flow cytometer is connected, user can schedule the instrument to be 
automatically powered on and/or off by clicking the Schedule Power 
On and Off function from the Operation panel. Refer to Instrument in 
this guide for details. 

 

• Maximum number of events for display during acquisition:  
Sets a limit to the number of events displayed on plots during sample acquisition. 
For example, if this is set to 20,000 events, only the last 20,000 events collected 
will be displayed. The maximum setting is 50,000 events. 

• Ctrl + C to copy selected table content with header, Shift + C without header:  
When selected, statistical data copied from either the Statistical Table or the table 
below the plots will include a header when copied using Ctrl + C and will not 
include a header when selected using Shift + C. 

• Copy plot with border:  
When selected, plots copied will include a dotted line border. 

• Only one NovoExpress software application is allowed to run at one time: 
When selected, only one instance of NovoExpress is allowed to run at a time. An 
error message will be displayed when user tries to run a second instance of 
NovoExpress. 

• Synchronize plot scale between plots of same sample: 
When selected, the axis range and scale of same parameter on different plots of 
same sample will be automatically synchronized when user change axis range or 
scale.  
Click Synchronize Plot Scale button  on workspace toolbar to quick switch this 
setting. Refer to Workspace Toolbar for more information. 

 

Experiment: Allows user to define experiment related settings. This window displays 
additional settings when NovoSampler (or NovoSampler Pro or NovoSampler Q) is 
connected.    
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When NovoSampler (or NovoSampler Pro or NovoSampler Q) is not connected 

 

When NovoSampler or NovoSampler Pro is connected 
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When NovoSampler Q is connected 

• User data root folder:  
Sets the default folder directive for saving the experiment file.  

• Default prefix of sample name:  
Sets the prefix for the name of the sample.  

• Default prefix of specimen name:  
Sets the prefix for the name of the specimen. 

• Automatically save experiment file in default experiment file folder with default 
name for new experiment: 
This setting determines how to save a current experiment file when a new 
experiment is started.  
If selected, the current file is automatically saved when a new experiment is 
started. The file is saved at the default experiment file folder with the name based 
on the current time in the format of YYMMDD_hhmm.ncf. 
If not selected, a Save As window appears when a new experiment is started. The 
user then has the option to set a name and location to save the current 
experiment file.  

• Automatically export samples to FCS/CSV files after data acquisition is completed: 
If selected, the software will automatically generate and export a FCS or CSV file 
after data acquisition is completed. Click Export Settings to open the Export 
Events window. Export Settings, including file format (i.e. FCS 3.0, FCS 3.1, or 
CSV), can be defined in this window. Please refer to Export Data in this guide for 
more details. 
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• Always remind to check plate type for first run when using NovoSampler: This 

option is available only when NovoSampler, NovoSampler Pro or NovoSampler Q is 
connected. With this setting checked, a window will be prompted to remind user to 
check if the correct plate type is selected before starting the experiment. It is highly 
recommended to enable this setting to remind user to check and make sure the 
correct plate type is selected for the experiment to avoid collision of the sample 
injection probe 

 
• Read plate barcode when running experiment: This option is available only when 

NovoSampler Q is connected. If this option is selected, the software will automatically 
read the barcode attached to the plate. Please refer to Read Plate Barcode in 
NovoSampler Q Operator's Guide for more details 

• Keep time gap fixed when appending sample events for Calcium Flux Assay: 
If this option is selected, the software will keep the time gap fixed when appending 
sample events for some specific assay (e.g. calcium flux assay). 

 

Analysis: Allows user to define analysis related settings. 
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Set the default plot properties when creating a new plot: 
• Histogram plot filling type:  

Sets the filling type for the histogram plots. Options include None, Filled, and 
Tinted.  

• Smooth histogram plot:  
If selected, this option smooths data on histogram plots. 

• Levels of contour plot:  
Sets the contour plot level (2%, 5%, and 10%). 

• Normalize histogram overlays:  
If selected, the histogram overlays are normalized to a 100% scale.  

• Use pseudocolor for density plot:  
If selected, density plots are displayed in pseudocolor. 

• Smooth density plot: 
If selected, density plots are smoothed. 

• Show legend for overlay plots:  
If selected, plots with overlays include a legend. 

• Showing fitting results for cell cycle analysis:  
If selected, the fitting results for the cell cycle analysis are displayed on the plot. 

• Use height or area parameter: 
Sets the default parameter for plots to either Height or Area. 

• Show outlier for contour plot: 
If selected, outlier events are shown as dots on contour plots. 

• Format: 
Click Format… button to open the Plot Format window to define plot default 
format. Click the Restore Defaults button in the window to restore factory default 
plot format. Refer to Plot Format for more details about plot format. 
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• Plot provides warning if XXX events are off-scale or saturated:  

If selected, the number or percentage of off-scale events will be displayed in created 
dot, density, histogram and contour plot after the data acquisition. By default, this 
function is enabled. User can click XXX area to open Events off-scale setting window 
to define the off-scale event settings. By default, 5% off-scale events are selected in 
this window. User can check the radio button in front of events or %events and enter 
the proper number to define the off-scale settings. Once defined, after the data 
collection, when there is any off-scale events in either X or Y axis, the upper right 
corner of the associated plot will display “!”, user can hover the mouse onto it, and 
view the details of the off-scale event information. 

 
 

• Default X and Y axis scale for fluorescent parameters: 
Allows user to select Biexponential, Log or Linear to be the default scale from the 
associated drop down menu. By default, software will select Biexponential here. 
When a new Dot Plot, Density Plot, Histogram Plot or Contour Plot is created, the 
selected scale will be automatically applied. This setting will not apply to any 
previously created plots. 

 

Set plot Display Options: 
• Show color for new gates:  

If selected, new gates are displayed with default color. If not selected, new gates 
are in black. 

• Show gate name in gate label: 
If selected, gate name is displayed in gate label on the plot. 

• Decimal places of mean and median values:  
Sets the number of digits displayed after the decimal point when computing mean 
and median values. 

• Show population percentile in gate label: 
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If selected, gate label is displayed with the percentage of the population within the 
gate. 

• Plot Title Options:  
If clicked, a drop-down menu will show as below: 

 
 Show Plot Title:  

If selected, plot titles are displayed on workspace plots. 
 Sample Name: 

If selected, the sample name is displayed in the workspace plot title. 
 Specimen Name: 

If selected, the specimen name is displayed in the workspace plot title. 
 Gating Name: 

If selected, the gating name is displayed in the workspace plot title. 
 Gating Hierarchy: 

If selected, the gating hierarchy is displayed in the workspace plot title. 

 

Absolute Count: Allows user to define absolute count related settings. 

 
Set default Absolute Count setting for new samples. 
• Dilution Factor: 

Sets the default dilution factor for new samples. The Dilution Factor is a 
conversion coefficient used to calculate the absolute counting results for the 
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original sample. For instance, if the original sample is diluted 10 times and is run 
on instrument, enter 1:10 in the Dilution Factor. NovoExpress software will show 
the absolute counting results for the original sample by multiplying the 
concentration of the sample run on instrument by 10.  

• Absolute Count Unit:  
Sets the default absolute count unit for new samples. The Absolute Count Unit 
parameter is used to set the unit for the absolute counting. User can select one of 
the units (i.e. No./µL, No./mL, or No./L) to present absolute count result for 
number of interested particles per microliter, per milliliter, or per liter.  

 

Further information on absolute count calculations is described in Calculation of 
Statistics. 

 

Statistical Table: Allows user to define statistical table related settings. This window 
displays additional settings (e.g. Plate ID, Well ID) when NovoSampler (or NovoSampler 
Pro or NovoSampler Q) is connected. 

  

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is not connected 
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When NovoSampler or NovoSampler Pro is connected 

 

 

When NovoSampler Q is connected 



Use NovoExpress Software 

 Software Guide 71 

• Group 
Customize Name allows the user to re-name the Group column header in the 
statistical table. If Default Visibility is selected, the Group column will appear in 
the statistical table by default. 

• Specimen: 
Customize Name allows the user to re-name the Specimen column header in the 
statistical table. If Default Visibility is selected, the Specimen column will appear 
in the statistical table by default. 

• Specimen ID: 
Customize Name allows the user to re-name the Specimen ID column header in 
the statistical table. If Default Visibility is selected, the Specimen ID column will 
appear in the statistical table by default. 

• Plate ID:  
Customize Name allows the user to re-name the Plate ID column header in the 
statistical table. If Default Visibility is selected, the Plate ID column will appear in the 
statistical table by default. This option is available only when NovoSampler, 
NovoSampler Pro or NovoSampler Q is connected. 

• Plate Barcode: 
Customize Name allows the user to re-name the Plate Barcode column header in the 
statistical table. If Default Visibility is selected, the Plate Barcode column will appear 
in the statistical table by default. This option is available only when NovoSampler Q is 
connected. 

• Plate Description: 
Customize Name allows the user to re-name the Plate Description column header in 
the statistical table. If Default Visibility is selected, the Plate Description column will 
appear in the statistical table by default. This option is available only when 
NovoSampler, NovoSampler Pro or NovoSampler Q is connected. 

• Well ID: 
Customize Name allows the user to re-name the Well ID column header in the 
statistical table. If Default Visibility is selected, the Well ID column will appear in the 
statistical table by default. This option is available only when NovoSampler, 
NovoSampler Pro or NovoSampler Q is connected. 

• Sample: 
Customize Name allows the user to re-name the Sample column header in the 
statistical table. If Default Visibility is selected, the Sample column will appear in 
the statistical table by default. 

• Sample ID: 
Customize Name allows the user to re-name the Sample ID column header in the 
statistical table. If Default Visibility is selected, the Sample ID column will appear 
in the statistical table by default. 

• Operator: 
Customize Name allows the user to re-name the Operator column header in the 
statistical table. If Default Visibility is selected, the Operator column will appear in 
the statistical table by default. 

• Run Time: 
Customize Name allows the user to re-name the Run Time column header in the 
statistical table. If Default Visibility is selected, the Run Time column will appear 
in the statistical table by default. 

• Gate: 
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Customize Name allows the user to re-name the Gate column header in the 
statistical table. If Default Visibility is selected, the Gate column will appear in the 
statistical table by default. 

 
Report Options: Allows user to define report related settings. This window displays 
additional setting (i.e. Plate Information) when NovoSampler (or NovoSampler Pro or 
NovoSampler Q) is connected. 

 

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is not connected 
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When NovoSampler (or NovoSampler Pro or NovoSampler Q) is connected 

Set Default Report Options for New Report. 
The settings in Plot Options panel are used for customizing plots inside report. They are 
effective for both auto and manual report mode. 
• Show Gate Name in Gate Label: If selected, gate name is displayed in gate label on 

the plot. 
• Show Population Percentile in Gate Label: If selected, gate label is displayed with the 

percentage of the population within the gate. 
• Plot Title Options: If clicked, a drop down menu will show as below: 

 
 Show Plot Title:  

If selected, plot titles are displayed on report plots. 
 Sample Name: 

If selected, the sample name is displayed in the report plot title. 
 Specimen Name: 

If selected, the specimen name is displayed in the report plot title. 
 Gating Name: 

If selected, the gating name is displayed in the report plot title. 
 Gating Hierarchy: 

If selected, the gating hierarchy is displayed in the report plot title. 
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The settings in Auto Report Mode Options panel are used for customizing auto report. 
They are only effective for auto report mode. 
• Number of Plots per Row: Sets how many plots are shown in one row. 
• Plot Statistics: If selected, shows gate statistics of plot. 
• Sample Statistics: If selected, shows gate statistics of sample. 
• Compensation: If selected, shows compensation matrix. 
• Photodetector Gain: If selected, shows photodetector gain of parameters.  
• Plate Information: If selected, shows plate information. This option is available only 

when NovoSampler, NovoSampler Pro or NovoSampler Q is connected. 
• Insert Page Break Before Each Sample: Only available for specimen report. If 

selected, a page break will be inserted before each sample. 
• Show Statistics Columns: Selects statistical items to display. 

 

Reagent Lots: 

 
• Reagent Type: Sets the type of the reagent. 
• Lot ID: Sets the ID of the active lot.  
• Import: Import the lot file download from https://www.agilent.com/chem/novocyte-

qc-lot-files.The lot ID will be listed after importing the lot file. 
• Expiration Date: Sets the expired date of the active lot.  
• Lot File: Display the lot file associated to the selected Lot ID. 

Workspace Toolbar 

 
 

Icon Description 

 

Dot Plot: Creates a dot plot. 

http://www.agilent.com/chem/novocyte-qc-lot-files
http://www.agilent.com/chem/novocyte-qc-lot-files
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Density Plot: Creates a density plot. 

 
Histogram: Creates a histogram. 

 
Contour Plot: Creates a contour plot. 

 
Gate Pointer: Use to select charts, gates, and statistical data. 

 
Rectangular Gate: Draws a rectangular gate. To use, select the tool, click and drag 
inside a plot to draw a rectangle gate. 

 
Elliptical Gate: Draws an elliptical gate. To use, select the tool, click and drag inside a 
plot to draw an elliptical gate. 

 
Polygon Gate: Draws a polygon gate. To use, select the tool, click inside a plot to begin 
creating the polygon. Click at additional locations inside the plot to add vertices to the 
polygon. To close the gate, either click on the first point of the polygon or double click 
on the last point. 

 
Freehand Gate: Draws a freehand gate. To use, select the tool, click inside start point in 
a plot to begin creating the freehand gate. Move mouse cursor inside the plot to draw 
the gate. Double click the end point to close the gate. 

 
Quadrant Gate: Draws a quadrant gate. To use, select the tool, and click inside the plot 
to divide it into quadrants. 

 
Logic Gate: Creates logical gates. Click the icon to open the Create Logic Gate window. 
In the window, select two current gates and define the logic gate with AND or OR. Select 
one gate if you wish to define logic gate with NOT. The logic gate name and color can 
also be defined in this window. 

 

 
Range Gate: Draws a range gate.  

 
Bi-Range Gate: Draws a bi-range gate.  
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Zoom In: Zooms in on a specified area of a plot. To use, select the tool, click and drag 
inside a plot to create a rectangle. The plot will be zoomed in on the area inside the 
rectangle. To zoom in only along one axis, click and drag along either the X-axis or the 
Y-axis on the plot.  

 
Zoom Out: Zooms out on a specified area of a plot. To use, select the tool, and click on 
a plot to zoom out. Continue to click to zoom out further. To zoom out only along one 
axis, click on either the X-axis or Y-axis on the plot.  

 
Auto Range: The display range for the X-axis and Y-axis are automatically adjusted to fit 
the experimental data. 

 
Full Range: The display range for a plot is set to the maximum. 

 
Move: Use to adjust the display parameters of a plot by dragging the plot area. To use, 
select the tool, click and drag inside the plot to achieve the desired display range. To 
only adjust along one axis, click and drag along either the X-axis label or Y-axis label. 
The display range will only be adjusted along the selected axis. 

 
Synchronize Plot Scale: When selected, the axis range and scale of same parameter on 
different plots of same sample will be automatically synchronized when user change 
axis range or scale. 

 
Adjust Threshold: Use this tool to adjust threshold value on plot. Refer to Threshold 
Settings for detailed procedures. 

 

Adjust Post Gain: Use this tool to adjust Post Gain. Only accounts with the Post Gain 
Adjustment privilege can perform this operation. Refer to Post Gain for detailed 
procedures. 

 
Quick Compensation: Allows for quick fluorescence compensation through scrollbars. 
To use, select the tool. Scrollbars appear on plots to allow for adjustment of 
fluorescence compensation. 

 
Show Statistics: Shows or hides the statistical tables below plots. 

 
Cell Cycle Plot: Creates a cell cycle analysis plot. 

 
Cell Proliferation Plot: Creates a cell proliferation plot. 

 
Bi-Variate Plots: Opens Bi-Variate Plots window. 

 
Previous Plot: Switches the active plot to the previous plot. Use this tool when the plot 
window is maximized. 

 
Next Plot: Switches the active plot to the next plot. Use this tool when the plot window 
is maximized. 
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Cytometer Setting Panel 

The Cytometer Setting panel sets the data collection parameters, stop conditions, 
flow rate, and threshold. Please refer to Cytometer Setting for cytometer settings. 

 

Cytometer Control Panel 

The Cytometer Control panel contains the Active Sample Information and the 
Experiment Control panel. The Experiment Control panel displays additional 
buttons when NovoSampler (or NovoSampler Pro or NovoSampler Q) is 
connected. Please refer to Cytometer Control for cytometer controls. 
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Plate Manager 

The Plate Manager allows user to set up the working mode, plate type, mixing and 
rinsing conditions when NovoSampler or NovoSampler Pro or NovoSampler Q is 
used. Please refer to Plate Manager for more details. 

 

When NovoSampler is connected 
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When NovoSampler Pro is connected 

 

When NovoSampler Q is connected 
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Experiment Manager 

The Experiment Manager contains the sample hierarchy structure and functions 
for copying, pasting templates, and importing and exporting sample data. Please 
refer to Experiment Manager for experiment management. 

 

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is not connected 

 

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is connected 
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Cytometer Status Panel 

The Cytometer Status panel displays the fluidic component status, photodetector 
gains, and laser powers. This panel is hidden by default. To show this panel, click 
on the Cytometer Status box in the Show group of the View tab. 
• Cytometer Status Panel for NovoCyte Instrument (e.g. 3000 System) 
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• Cytometer Status Panel for NovoCyte Quanteon Instrument (e.g. 4025 
System) 
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• Cytometer Status Panel for NovoCyte Advanteon Instrument (e.g. V8B7R4 
system) 
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• Cytometer Status Panel for NovoCyte Penteon Instrument (e.g. U7V7B6Y6R4 
system) 
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Gate Manager Panel 

The Gate Manager displays all gates of the active sample in list mode or tree 
mode. It provides user interface to modify gate name, color and color precedence 
and also shows gate hierarchy and gate statistics. 

 

Status Bar 

The status bar located at the bottom of the monitor displays the instrument’s 
status through color indicators. If the instrument is connected, the indicator can be 
green, red, or yellow, indicating a normal condition, an error, or a warning, 
respectively. If the instrument is not connected to the computer, the indicator is 
black. 

Green Indicator 

The indicator light is green if the instrument is connected and without warnings or 
errors.  

The status bar will display Ready if the instrument has completed the initializing 
sequence and is ready for additional commands. 

 

The status bar displays Instrument initializing after powering on the instrument. 
The initializing sequence flushes the fluidic lines in the instrument to prepare for 
sample acquisition. 
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The status bar displays Instrument shutting down after shutting down the 
instrument. The shutting down sequence flushes the fluidic lines and 
automatically powers off the instrument when complete. 

 

The status bar displays Sample acquiring during sample acquisition. 

 

Flashing Red Indicator 

If an error occurs, the indicator flashes red. An error message is displayed with the 
cause and possible solutions. Please see Troubleshoot for details. 

 

Clicking on the indicator displays the message box. 

 

Flashing Yellow Indicator 

If a warning occurs, the indicator flashes yellow. A warning message displays the 
cause of the problem and possible solutions. Please see Troubleshoot for details. 

 

Clicking on the indicator displays the message box. 
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Black Indicator 

If the instrument is not connected to the computer, the indicator is black. This may 
be due to the instrument being off or a problem with the USB connection between 
the computer and instrument. Also, if multiple instances of the NovoExpress 
Software are running, only the first instance of the software will connect to the 
instrument. The remaining instances will not connect to the instrument and the 
indicator light will be black.  

 

Instrument Configuration 

To open the Instrument Configuration window, click the Configuration icon from 
the Instrument tab of the Menu Bar. User can view or modify the instrument 
configuration from this window.  

 

NOTE Please refer to associated instrument operator's guide for procedures to modify the 
instrument configuration. 

NovoExpress Software automatically detects the fluorescence parameters, 
excitation lasers, and detection channels of a connected Agilent flow cytometer. 
The software also detects if the NovoSampler or NovoSampler Pro is connected 
while connecting NovoCyte instrument and detects if the NovoSampler Q is 
connected while connecting NovoCyte Quanteon, NovoCyte Advanteon or 
NovoCyte Penteon instrument.  
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If using the software while the instrument is powered off or not connected to the 
workstation, use the Instrument Configuration window to select the correct 
instrument and configuration to display the correct fluorescence parameters. 

Instrument Configuration with Instrument Connected  

The Instrument Configuration window displays the instrument type, the name and 
schematic of the current optical configuration, parameter window, and status of 
NovoSampler, NovoSampler Pro or NovoSampler Q. When the instrument is 
connected to the workstation and powered on, the software will detect the 
excitation laser and photodetectors connected to the system and display the 
schematics of the compatible optical configurations. The schematic of each 
configuration shows the position and type of each bandpass filter, dichroic mirror, 
photodetector, and the excitation laser. The parameter window shows the 
Parameter, Excitation Laser, Detection Channel and the Default Alias for each 
fluorescence channel. The Default Alias can be modified by double-clicking.  

The status of the NovoSampler, NovoSampler Pro or NovoSampler Q  is displayed 
in the lower left corner of this window. When the workstation is connected to the 
instrument and the instrument is powered on, it can automatically detect the 
installed NovoSampler, NovoSampler Pro or NovoSampler Q and this box will be 
automatically checked. 
• Instrument Configuration with NovoCyte Connected (e.g. 3000 System) 
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• Instrument Configuration with NovoCyte Quanteon Connected (e.g. 4025 
System) 

 
 

• Instrument Configuration with NovoCyte Advanteon Connected (e.g. V8B7R4 
System) 
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• Instrument Configuration with NovoCyte Penteon Connected (e.g. 
U7V7B6Y6R4 System) 
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Instrument Configuration with Instrument Disconnected  

When there is no instrument connected to the workstation or the instrument is 
powered off, user can select NovoCyte, NovoCyte Quanteon, NovoCyte 
Advanteon or NovoCyte Penteon instrument, and all the available optical 
configurations of the selected instrument will be displayed in the Optical 
Configuration field. User can select any one of the configurations and view the 
associated optical schematic. After selecting the optical configuration, click OK, 
and the software will restart. After restarting, the Cytometer Setting panel, the 
Cytometer Control panel, the Experiment Manager panel, and the Work List are all 
updated according to the new configuration settings. When the instrument is 
connected to the workstation and powered on, the software will automatically 
detect the current hardware setting, and restore the correct optical configuration 

User can also view the NovoSampler, NovoSampler Pro or NovoSampler Q related 
software interface and functions. 
• If NovoCyte is selected from the drop down menu of Instrument, check the 

NovoSampler installed checkbox located at the lower left corner of 
Instrument Configuration window, choose NovoSampler Pro or NovoSampler 
in the prompted dialog box, and click OK. The software will prompt a dialog 
box, asking to restart software. After restarting, the Cytometer Control panel, 
the Experiment Manager panel and the Work List are all updated, and the 
Plate Manager panel will be visible 

 

If NovoCyte Quanteon, Advanteon or Penteon is selected from the drop down 
menu of Instrument, check the NovoSampler Q installed checkbox located at the 
lower left corner of Instrument Configuration window, and click OK. The software 
will prompt a dialog box, asking to restart software. After restarting, the Cytometer 
Control panel, the Experiment Manager panel and the Work List are all updated, 
and the Plate Manager panel will be visible. 
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Manage Plate Types 

If NovoSampler, or NovoSampler Pro, or NovoSampler Q is used, user can add, 
remove, and modify plate settings in the Manage Plate Types window. To open 
this window, click the Manage Plate Types button from Instrument > 
NovoSampler or NovoSampler Pro or NovoSampler Q. 

 

 

Manage Plate Types Window When NovoSampler is Connected 
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Manage Plate Types Window When NovoSampler Pro is Connected 

 

 

Manage Plate Types Window When NovoSampler Q is Connected 
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NOTE When NovoSampler Pro or NovoSampler Q is used, a new plate type must be 
calibrated before it could be used. Once calibrated, the same type of plate can be 
used for an experiment without any calibration needed. 

 
 

NOTE Plate Type is defined by the format of the and the geometry of the well. For 
example, two U-bottom 96-well plates are considered as different types if they have 
different height of the well. 

 
 

NOTE Specify the plate name in detail to help easy recognition of different plate type, such 
as Nunc 96-Well Polypropylene Plates, Corning Carbo-BIND 96-well plates, etc. 

 
 

All the available plate types are listed in the left box in the Manage Plate Types 
window. Please refer to associated operator's guide for more details. 
• Name: The name of the selected plate type. Edit it to rename the customer 

plate other than the built-in plate types. The name of the built-in plate type 
cannot be changed. 

• Plate Format: The plate format of the selected plate type. This property cannot 
be changed. 

• Max Volume: Set the limit for the maximum sampling volume user can input in 
the Stop Condition of Cytometer Setting panel for an experiment. Max 
Volume can be set in a range between 10 µL to 5000 µL. 

 

NOTE Input an appropriate Max Volume to avoid running out of sample for a well during 
an experiment. 

 
 

• SIP Movement Offset (+ Down, - Up): The sample injection probe height offset 
relative to the default height when aspirating the sample from each well or 
tube. Positive value means the height is decreased. Negative value means the 
height is increased. The SIP Movement Offset can be set in a range between -
10 mm to 5 mm with a zero default value. 

 

NOTE Set SIP Movement Offset to be Positive can help to reduce the dead volume from 
each well. 

 
 

NOTE Be cautious to set the SIP Movement Offset. Incorrect setting would result in 
collision of SIP to the bottom of the well. When NovoSampler Pro or NovoSampler 
Q is used, the SIP height is automatically calibrated during plate type calibration. 
Normally, there is no need to adjust the SIP Movement Offset. 
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• Mix Speed: The mix speed of the orbital shaker. Refer to table below for the 
range of mix speed and default mix speed for each compatible plate. This 
function is available only when NovoSampler Pro or NovoSampler Q is 
connected. 
 

Auto-Sampler Plate Type Range of Mixing 
Speed (rpm) 

Default Mixing 
Speed (rpm) 

NovoSampler Pro 96 well plate (U, V and Flat bottom) 60 -  3000 1500 

24 well plate 60 -  3000 2500 

24 tube rack 60 - 1800 1500 

48 well plate 60 -  3000 1500 

NovoSampler Q 96 well plate (U, V and Flat bottom) 200 -  3000 1500 

24 well plate 200 -  3000 2500 

48 well plate 200 -  3000 1500 

40 tube rack 200 -  1200 1000 

384 well plate 200 -  3000 2500 

24 tube cooling rack 200 -  1200 1000 

96 well plate (U, V and Flat bottom) 
with cooling box 

200 -  2000 1500 

 

NOTE Determine the proper mixing speed and volume before running the experiment can 
help to avoid any potential spills during the experiment running. 

 

 

NOTE When NovoSampler Pro or NovoSampler Q is selected to work in Standard and 
High-Throughput mode, the software will automatically apply the default settings 
for mixing cycle, rinse cycle, mixing speed, acceleration, mixing duration, sampling 
volume and flow rate. 

 

• Mix Acceleration: The acceleration time for the orbital shaker to reach the 
specified Mix Speed. Mix Acceleration can be set from 0  second (default) to 
10 seconds for NovoSampler Pro, or 1 second (default) to 10 seconds for 
NovoSampler Q. This function is available only when NovoSampler Pro or 
NovoSampler Q is connected. 

• Mix Duration: The mixing time for the orbital shaker to mix the sample when 
NovoSampler Pro or NovoSampler Q works in custom mode. Mix Duration 
can be set from 1 second to 120 seconds. However, the default mix duration 
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may vary when NovoSampler Pro or NovoSampler Q works in other mode (i.e. 
Standard and High Throughput mode). Please refer to Plate Manager in this 
guide for more details. This function is available only when NovoSampler Pro 
or NovoSampler Q is connected. 

• Built-in: Checked if the selected plate is the built-in plate type. Built-in plate 
types cannot be renamed or deleted. The built-in information is read only.  
 

NOTE The built-in plate type has been tested with biological samples, including human 
peripheral blood sample and cultured cell lines, to determine the default mixing 
settings. At the default mixing settings, the biological samples can be effectively 
mixed and uniformly suspended inside each well. 

 

• Calibrated: Indicate if the selected plate type is calibrated. Only calibrated 
plate type can be used in experiments. This function is available only when 
NovoSampler Pro or NovoSampler Q is connected. 

• Reset to Default: Click this button to reset the Max Volume and SIP 
Movement Offset of the selected plate type to default for NovoSampler, and 
reset the Max Volume, SIP Movement Offset, Mix Speed, Mix Acceleration, 
and Mix Duration of the selected plate type to default for NovoSampler Pro 
and NovoSampler Q. Only built-in plate types can be reset to default. 

• Remove: Click this button to delete the selected plate type. Only non-built-in 
plate types can be removed. 

• Add: Click this button to add a customer plate type. Input plate type name for 
new plate type in the prompted window. The Copy from function helps to 
quickly set up a customer plate type based on the format of an existing plate 
type. Choose a proper existing plate type from the Copy from drop-down list. 
The Plate Format, Max Volume and SIP Movement Offset settings are copied 
from the Copy From plate type. 

 

• Calibrate: This function is available only when NovoSampler Pro or 
NovoSampler Q is connected. Click this button to calibrate the selected plate 
type. Only calibrated plate type can be used in experiments. The Calibrated 
checkbox indicates if the selected plate type is already calibrated. Figure 
below shows the dialog box prompted when the Calibrate button is clicked. 
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Click OK after properly placing a plate of the selected plate type on the orbital 
shaker. It will take several minutes to complete the plate type calibration process. 
If the plate is not placed properly, the calibration could fail and a dialog box shown 
below will be prompted. Reposition the plate properly and conduct the calibration 
again. 

 

 

NOTE Before loading multi-well plates or tube racks, identify the correct orientation to 
position the plate or the tube rack onto the orbital shaker. Make sure the sample 
plate is positioned properly on the orbital shaker and completely contact the 
surface of the orbital shaker without any tilting. Incorrect placement may cause 
misalignment between the sample wells and sample injection probe, resulting in 
damage to the sample injection probe or the orbital shaker. 

 
 

NOTE Before calibrating the 24 tube rack, 40 tube rack or 24 tube cooling rack, ensure a 
12 X 75 mm tube is fully inserted in each position of the tube rack. 

 
 

NOTE Once plate type calibration is initiated, the Calibrate button in the Manage Plate 
Types window will automatically become Stop Calibration button. Click Stop 
Calibration will stop the plate type calibration. 
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4  Sample Acquisition 

This chapter provides the information for sample acquisition function, including 
Cytometer Setting panel, Work List, and Cytometer Control panel. 

Cytometer Setting 

The Cytometer Setting panel contains the Parameters, Stop Condition, Flow Rate, 
and Threshold controls. The panel displays the settings of the sample being 
acquired. 
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Parameters Settings 

The parameters settings specify which parameters are collected during sample 
acquisition. 

 

The list includes all of the parameters that the instrument is capable of collecting. 
Area and height measurements can be collected for each parameter. To enable 
data collection for specific parameters, check the corresponding check boxes 
under the A (area) and H (height) columns. The selection of parameters can no 
longer be modified once sample acquisition has started. The FSC height and SSC 
height parameters are required for data collection and cannot be unselected. 
Fluorescent parameters can be renamed by double clicking the name under the 
alias column. 

To adjust photodetector gain of one parameter, double click the cell on the 
specified parameter row and Gain column, the photodetector gain adjustment tool 
will show as below: 

 

Drag the slider bar or directly enter the target value to change the photodetector 
gain. Click the Reset link button to set as default value. If currently logged in user 
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does not have Photodetector Gain Adjustment privilege, only Reset button will be 
available. To grant Photodetector Gain Adjustment privilege, refer to Access 
Privilege. 

Every channel has its default photodetector gain setting. An underlined 
photodetector gain value as shown above for the B586 channel means the 
photodetector gain has been modified and is not the default value. A non-
underlined photodetector gain indicates that it is the default setting.  

 

NOTE Click the Gain column header and select the Reset All context menu item to reset 
the photodetector gains of all parameters to default value. When NovoExpress is 
restarted or new blank experiment file is created, the photodetector gains will be 
reset to default value too. 
Click the A or H column header to check or uncheck area or height check boxes for 
all parameters. 

 
 

NOTE For NovoCyte instrument, different parameters may share the same photodetector, 
for example B675 and R675. If the photodetector gain of one parameter is changed, 
the other one will be changed too. 
For NovoCyte Quanteon, NovoCyte Advanteon and NovoCyte Penteon instrument, 
the photodetector gain for each parameter can be changed independently. 

 
 

NOTE The photodetector gain can be changed during sample acquisition. When changing 
photodetector gain during acquisition, the plot will only display events after the gain 
adjustment. Please note the events are not deleted, and will be shown on the plots 
when the acquisition is completed. If previous events before photodetector gain 
adjustment are not wanted, click the Restart button to restart the acquisition. Refer 
to Experiment Control for the Restart function. You can also delete the previous 
events after the acquisition is completed by using the Delete Events function (refer 
to Sample). 

 
 

NOTE For NovoCyte instrument, the photodetector gain of FSC and SSC cannot be 
changed. 
For NovoCyte Quanteon, NovoCyte Advanteon and NovoCyte Penteon instrument, 
the photodetector gain of FSC and SSC can be changed. 

 
 

Stop Condition Settings 

The Stop Condition Settings are used to stop sample acquisition after a specific 
set of conditions has been met. The conditions may include number of events 
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collected, collection time, and / or collection volume. To enable a condition, check 
the box next to the condition. 

 

Stop Conditions 
• Events: Used to specify the number of events to acquire. Acquisition stops 

when the set number of events has been collected. When the drop-down menu 
is set to Ungated, the acquisition stops after the total number of events 
reaches the set value. If the drop-down menu is set to a gate, the acquisition 
stops after the number of events in the gate reaches the set value. The 
number of events collected can range between 1~10,000,000.  

• Time: Used to stop sample acquisition after a set sample collection time. The 
collection time can be set between 0 and 60 minutes and 0 to 59 seconds. 

• Volume: Used to stop sample acquisition after a set sample volume has been 
analyzed. The sample volume can be set between 10 and 5000 µL for 
NovoCyte instrument, and between 5 and 5000 µL for NovoCyte Quanteon, 
NovoCyte Advanteon and NovoCyte Penteon instrument. 

Multiple stop conditions can be concurrently set. When multiple stop conditions 
are set, the sample acquisition stops after the first stop condition is met. If no stop 
conditions are set, the sample acquisition stops after one of the system’s 
maximum limits for events, time, and volume as described is reached.  

 
 

NOTE After sample acquisition has started, stop conditions based on number of events 
can be modified but stop conditions based on time and volume cannot be changed. 

 
 

NOTE The number of events displayed in a plot during sample acquisition can be set in 
Settings. See Setting. The maximum number of events displayed is 50,000 events. 

 
 

NOTE File size can be excessively large if you acquire a large number of events, i.e., 
1,000,000 events. Therefore, it is always important to consider disabling 
unnecessary parameters (Parameters Settings) before acquisition in order to 
reduce the file size. If events have already been acquired or collected, you can 
delete events (See Sample) to discard parts of unnecessary events in the sample. 
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Flow Rate Settings 

The three standard settings for flow rate include Slow (14 µL/min), Medium (35 
µL/min), and Fast (66 µL/min). In addition, custom flow rates can be set using the 
slider bar. Sample flow rates can range between 5~120µL/min. The bottom of the 
panel includes information on the current sample’s flow rate and the 
corresponding core diameter. 

 

Threshold Settings 

The threshold settings determine which events are recorded during sample 
acquisition. Only events that exceed the set threshold values are recorded. 

 

To set the threshold: 

For sample acquisition, the primary threshold can be set on either FSC or SSC 
height, or a fluorescence signal height if firmware supports. If desired, a secondary 
threshold can also be set on the height of a second parameter. The Storage Gate 
is used to filter out events outside the gate. All events exceeding the primary and 
secondary threshold will be recorded when Storage Gate is set to Ungated. 
Threshold values can range from 10 to 500,000,000. 

To adjust threshold value on plot, first click the Adjust on Plot link button in the 
Threshold window or the Adjust Threshold tool  in the workspace toolbar. Then 
move the cursor to the target position on a plot with either primary, secondary or 
both thresholds set as displayed axis parameter. As shown below, the right edge 
of the dark gray area is the current threshold value and the right edge of the light 
gray area is the target threshold value to be set. Left-clicking the cursor sets the 
threshold value to the new value which is shown on the lower left corner.  
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NOTE Threshold channels cannot be changed after data acquisition begins. Threshold 
values and Storage Gate can be changed during acquisition, but the events already 
acquired will not be processed. When changing threshold values during acquisition, 
the plot will only show events after threshold adjustment. Please note the events 
are not deleted, and will be shown when the acquisition is completed. If previous 
events are not wanted, click the Restart button to restart the acquisition. Refer to 
Experiment Control for Restart function. You can also delete the previous events 
after the acquisition is completed by using the Delete Events function (refer to 
Sample). 

 

Work List 

Before starting the experiment, the Work List can be used to set up the sample list. 
The Work List allows users to create new specimens and samples, import 
specimens or samples from a template, duplicate specimens or samples,  and 
copy and paste sample information. Please see Experiment Manager for additional 
details. 

The Work List displays all created specimens and associated samples. User can 
view the specimen name, specimen ID, template, sample type, plate number, well 
ID, sample name, acquisition parameters, stop conditions, threshold settings, 
compensation settings, and analysis and report information, etc. 
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When NovoSampler (or NovoSampler Pro or NovoSampler Q) is not connected 

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is connected, there 
are three additional icons  shown on the menu bar. The created Work List 
will also include the Plate ID and Well ID columns. The other functions remain the 
same.  

 

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is connected 

 

Icon  Description  

 
Apply Modification: Click this button to save the changes made to the Work List. After 
applying the modification, the Experiment Manager panel updates to reflect the changes. 

 
Import Sample from Template: Click this button to import a new sample to the work list 
with selected template.  User needs to select the template file to open. The template of the 
first sample in the file gets imported to the Work List. 

 
Import Specimen from Template: Click this button to import a new specimen to the work 
list with selected template. User needs to select the template file to open. The template of 
the first specimen in the file gets imported to the Work List. 
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Duplicate as Sample: Click this button to duplicate selected sample as new sample and 
add to the Work List. Refer to Create a Duplicate Specimen or Sample in this guide for more 
details. 

 
Duplicate as Specimen: Click this button to duplicate selected specimen as new specimen 
and add to the Work List. Refer to Create a Duplicate Specimen or Sample in this guide for 
more details. 

 

Well ID Setting Direction: This function is only available when NovoSampler (or 
NovoSampler Pro or NovoSampler Q) is used. When new samples are created in the Work 
List, the Well ID will be assigned sequentially. Use the Well ID Setting Direction button  
in the Work List window to set whether new samples are created in a row-by-row sequence 
or a column-by-column sequence for a plate. 

 

Automatic Setting Well ID: This function is only available when NovoSampler (or 
NovoSampler Pro or NovoSampler Q) is used. When selected, a blue outline will show on 
the icon. When Well ID of a sample is modified manually, the NovoExpress Software will 
automatically assign new Well ID for blank samples below that sample in an order set in the 
Well ID Setting Direction based on the plate type information. 

 

Plate View: This function is only available when NovoSampler (or NovoSampler Pro or 
NovoSampler Q) is used. Click this icon opens the Plate View window. Plate View window 
is read only and is used to view the sample information for each well on a plate view.  
The Plate drop-down menu lists the Plate ID for all the created plates. Select a Plate ID from 
the drop-down menu and view the sample information for this plate. Check the Show 
Specimen Name checkbox to enable the specimen name associated with each well to be 
shown. Check the Display sample has data checkbox to also show samples which have 
collected data. 

 

 
Hide Disabled Parameters: Click to hide the acquisition parameters that are currently 
disabled. 

 
Hide Samples Containing Events: Click to hide the samples that contain events. 
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Hide Photodetector Gain: Click to hide the photodetector gain value in parameters 
columns. 

 
 

NOTE The Plate ID and Well ID in the Work List can be modified to assign Plate ID and 
Well ID for the samples. 

 

NOTE When collecting repeats from a sample well is desired, multiple samples can be 
assigned to the same Well ID. 

 

Open the Work List 

The Work List can be opened using two methods: 
• From the Experiment Manager or Plate Manager panel, click the Work List 

icon at the top of the window. 

 

• From the Home tab in the Menu Bar, click on the Work List icon in the 
Experiment group. 

 

Work List Management 

Insert a New Specimen or Sample 

To create a new specimen or sample, right click on the first column of a sample 
row or an empty row. Click Insert Specimen to create a new specimen, or click 
Insert Sample to create a new sample. The new sample will be placed in the 
selected row and under the corresponding specimen for that row. 
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Copy and Insert the Copied Specimen or Sample 

Pertaining to copying and inserting of specimens or samples: 
1 To select the specimens or samples for copying, click and drag in the first 

column of the Work List. The selected rows become highlighted.  
2 To copy the selected specimens or samples, right click and select Copy or use 

the keyboard shortcut Ctrl C. A dash line borders the copied rows. 
3 To insert the copied samples, right click and select Insert Copied Samples. 

The samples are inserted at the selected location. Select Insert Copied 
Specimens or use the keyboard shortcut Ctrl V to insert the specimens at the 
selected location. 

 

Delete Specimen or Sample 

Pertaining to deleting of specimens or samples: 
1 To select the specimens or samples for deleting, click and drag in the first 

column of the Work List. The selected rows become highlighted. 
2 To delete the selected specimens or samples, right click and select Delete or 

press the Delete key on the keyboard. 
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Import a Specimen or Sample from a Template 
• To import a specimen from a template: 

In the Work List window, click on the Import Specimen from Template icon  
, from the toolbar at the top of the window and select the template file to open. 
The template of the first specimen in the file gets imported to the Work List.  

• To import a sample from a template: 

In the Work List window, click on the Import Sample from Template icon  , 
from the toolbar at the top of the window and select the template file to open. 
The template of the first sample in the file gets imported to the Work List.  

Create a Duplicate Specimen or Sample 

To duplicate a specimen or sample: 
1 To select the specimens or samples for duplicating, click and drag in the first 

column of the Work List. The selected rows become highlighted. 
2 After selecting the samples, click the Duplicate as Sample icon  , to duplicate 

the samples and add them under the last specimen of the Work List. 

Or, after selecting the specimens, click the Duplicate as Specimen icon  , to 
duplicate the specimens and create them as new specimens. 

Edit a Work List Cell 

Edit Specimen, Specimen ID and Sample Names 

To modify a specimen, specimen ID or sample cell, double-click on the cell in the 
Work List. Enter the new value and press Enter key. 

 

When a sample name is entered into an empty specimen, a new sample is created 
after Enter key is pressed. 

When a specimen, specimen ID, or template is entered into in an empty row, a new 
specimen is created after the edit is done. 
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Edit Template 

To modify a template, double-click on the Template cell in the Work List. After a 
new template is selected, the template is applied into the current specimen. See 
Templates for additional details. 

 

To edit template in an empty row, the template’s first specimen would be imported 
into Work List after the edit is done. 

Edit Acquisition Parameters 

To modify the acquisition parameters, double-click on the channel cell to enter edit 
mode. In this mode, the fluorescence parameter alias and photodetector gain can 
be modified, and the height and area measurements can be enabled or disabled. 

 

When in non-edit mode, the character * after photodetector gain text indicates the 
gain is not default value. For more information about photodetector gain, refer to 
Parameters Settings. 

 

Edit Stop Conditions, Sample Flow Rates, and Threshold Settings 

To set the sample stop conditions, double-click the stop condition cell to enter edit 
mode. 

 

To set the sample flow rate, double-click the flow rate cell to enter edit mode. 
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To set the sample threshold, double-click the threshold cell to enter edit mode. 

 
 
 

Copy and Paste Cells 

Pertaining to copying and pasting cells between samples: 
1 To select the cells for copying, click and drag in the Work List. The selected 

cells become highlighted. 
2 To copy the selected cells, right-click and select Copy or use the keyboard 

shortcut Ctrl C. A dashed line borders the copied cells. 
3 To paste the selected cells, select the target cells and right click and select 

Paste or use the keyboard shortcut Ctrl V. The target cells location must have 
matching columns. After pasting, a green background in the cells indicates 
that the pasting was successful. 

 
 

NOTE You can copy sample names in a column from a spreadsheet program like 
Microsoft Excel, then select sample cells of multiple rows in Work List and press 
Ctrl V to paste them into Work List. 
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Cytometer Control 

The Cytometer Control panel contains the Active Sample Information and the 
Experiment Control panel. The Experiment Control panel displays additional 
buttons when NovoSampler (or NovoSampler Pro or NovoSampler Q) is 
connected. 
• When NovoSampler (or NovoSampler Pro or NovoSampler Q) is not connected 

 

• When NovoSampler (or NovoSampler Pro or NovoSampler Q) is connected 

 
                                    



Sample Acquisition 

 Software Guide 113 

Active Sample Information 

In the Experiment Manager panel, the active sample is indicated by the red arrow. 
The active sample can be switched by double-clicking on a new sample or by 
using the keyboard shortcuts Ctrl + and Ctrl – to switch to the next and previous 
sample, respectively.  

In the Active Sample Information panel, the number of events collected, the 
average events collected per second, the collected volume, and the collection time 
are displayed. During sample acquisition, this information is updated in real-time. 

 

The current sample information box at the bottom of the panel displays the 
sample name of the current sample. When NovoSampler (or NovoSampler Pro or 
NovoSampler Q) is connected, the sample Well ID is also displayed. To rename the 
sample or change Well ID from this box, double-click the name to enter edit mode. 
The specimen name cannot be edited from this box. 

  

Experiment Control 

The Experiment Control panel displays different functions depending on whether 
the instrument is connected to NovoSampler (or NovoSampler Pro or 
NovoSampler Q) 

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is not connected 

The Experiment Control panel includes the Next Sample and the Run buttons. 
• Next Sample 

The Next Sample button can be used to switch the active sample to the next 
sample in the Experiment Manager panel. If the active sample is the last 
sample in the Experiment Manager, clicking the Next Sample button creates a 
new sample. The new sample has the same template as the previous sample 
with the same Cytometer Setting, Compensation, Report and Analysis. 

 

To create a new sample without the template settings, click on the arrow on 
the right side of the Next Sample button and select Without Template. The 
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new sample contains the same cytometer settings as the previous samples, 
but analysis, report and compensation settings are not transferred. 

 

• Run 

The Run button is used to begin sample acquisition. 

If the active sample does not contain event data, the Run button appears with 
a solid green triangle. Click the Run button to begin sample acquisition. 

 

If the active sample already contains event data, the Run button appears with 
a striped green triangle. 

 

Clicking the Run button causes a dialog window to appear. Click Append to 
add additional events to the existing events. Click Overwrite to delete the 
existing events and collect new events. If the “Keep fixed time gap when 
appending sample events for Calcium Flux Assay” function is enabled in the 
Experiment Setting window, the check box in front of the “Keep time gap fixed 
for Calcium Flux Assay” will be automatically selected. 
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• Restart 

The Restart button is used to restart sample acquisition while sample 
acquisition is in process and the previously acquired events are desired to be 
deleted. Restart button is particularly useful when user wants to adjust the 
photodetector gain or threshold first to a proper value and then collect the 
data. 

When Restart is clicked, the previously acquired events will be deleted and the 
acquisition status including sampling volume and sampling time will be reset 
to zero. Then the sample acquisition will restart until one of the defined stop 
conditions is met. The Restart button is only visible after acquisition has 
started. 

 
 

NOTE The Run button is only available when the instrument status is Ready. The Run 
button is not available when the instrument is not connected, when the instrument 
is powered off, when there is an instrument error, or during the initialization, 
shutting down, and reagent maintenance sequences. 

 

During sample acquisition, the Run button switches into a Stop button. Click 
the Stop button to manually stop the acquisition. 



Sample Acquisition 
 
 

116   Software Guide 

 

• Rinse after sampling: check to enable SIP rinse function after each sample 
acquisition. 

• Absolute Count: check to enable sample collection in Absolute Count mode. 
 

NOTE This function is available for NovoCyte Quanteon, NovoCyte Advanteon and 
NovoCyte Penteon instrument. 

• Recover Remaining Samples: check to enable recover remaining sample 
already aspirated into the sampling tubing but not used for acquisition back 
into the sample tube. The Sample Injection Probe (SIP) will move down after 
sample acquisition to return any remaining samples back to the sample tube 
(if tube holder is used) or plate well (if NovoSampler is used). 

 

NOTE Do not remove the sample tube, tube rack or microwell plate to prevent spill of the 
sample. Ensure the moving path of SIP is not blocked by any obstacles. 

 
 

NOTE This function is available for NovoCyte Quanteon, NovoCyte Advanteon and 
NovoCyte Penteon instrument. 

 

 

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is connected 

The Experiment Control panel includes the Next Sample, Run Single Well, Mix 
Sample and Run Plate buttons. 
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• Next Sample:  Click this button to switch the active sample to the next sample 
in the Experiment Manager panel. If the active sample is the last sample in the 
Experiment Manager, clicking the Next Sample button creates a new sample. 
The new sample has the same template as the previous sample with the same 
Cytometer Setting, Compensation, Report and Analysis. 

 

To create a new sample without the template settings, click on the arrow on 
the right side of the Next Sample button and select Without Template. The 
new sample contains the same cytometer settings as the previous samples, 
but analysis, report and compensation settings are not transferred. 

 

• Run Single Well:  Click this button to run a single well in the plate. 
 

NOTE When Run Single Well is selected, the sample will not be mixed before sample 
acquisition. To mix the sample, click the Mix Sample button in the Cytometer 
Control panel. 

 
 

NOTE When Run Single Well is selected, the sample injection probe will automatically be 
rinsed after sample acquisition. This SIP rinse function will minimize the carryover 
between samples. 

 

• Mix Sample:  Click this button to mix the sample in the plate. 
• Run Plate: Click this button to run multiple wells in the plate. 
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NOTE Before acquiring a sample, ensure the sample is the Active Sample and the Well ID 
is correct. In the Experiment Manager panel, double-click a sample node to set the 
sample to be the Active Sample. The active sample will be indicated by a red arrow 
on the left of the sample in the Experiment Manager panel. 

 

• Shutdown NovoCyte after plate run: When checked, NovoExpress can 
automatically shut down the instrument after plate run is completed. When the 
plate run is completed, NovoExpress will prompt a 60 seconds count down 
message box to confirm whether or not to shut down the instrument. The 
dialog box is shown below. If no action taken after 60 seconds, NovoExpress 
will shut down the instrument automatically. 

 
 

NOTE Automatic shutdown function is only effective for Run Plate. Run Single Well will 
not trigger the shut down process. 

 
 

NOTE User can also schedule automatic instrument power on or off at selected time and 
frequency by clicking Schedule Power On & Off from the Operation panel. This 
function is available only when NovoCyte Quanteon, Advanteon or Penteon flow 
cytometer is connected. Please refer to Instrument in this guide for more details 
about this function.   
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5 Data Analysis 

This chapter provides information for data analysis tools, including Plots, Gates, 
Statistics, Fluorescence Compensation, Cell Cycle Analysis, Cell Proliferation 
Analysis, Statistical Tables, Heat Maps and Post Gain. 

Plots 

The NovoExpress Software includes dot plots, density plots, contour plots, 
histograms, cell cycle plot, cell proliferation plot and bi-variate plot. 

 

Plot Type Icon Display 
Parameters 

Description Example 

Dot Plot  
 

Two-
parameter 

The intensities of two 
parameters are represented by 
the coordinates of the plot. Each 
point on the plot represents at 
least one event with the 
corresponding intensity values. 

 

Density 

 

Two-
parameter 

The intensities of two 
parameters are represented by 
the coordinates of the plot. The 
color of each point represents 
the density, or number of events, 
at the corresponding intensity 
values. 
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Contour 

 

Two-
parameter 

The intensities of two 
parameters are represented by 
the coordinates of the plot. 
Contour lines are drawn to 
represent the density distribution 
of the population. 

 

Histogram 

 

Single-
parameter 

The intensity of a parameter is 
represented along the horizontal 
axis, and the number of events at 
each intensity value is 
represented along the vertical 
axis. 

 

Cell Cycle 
Analysis  

Single-
parameter 

DNA content is represented 
along the horizontal axis, and the 
number of events at each value 
is represented along the vertical 
axis. The cell cycle fitting 
algorithm is used to separate the 
population into G1, S, and G2 
phases of the cell cycle. See Cell 
Cycle Analysis for more 
information.  

Cell 
Proliferation 
Analysis  

Single-
parameter 

Cell Proliferation Analysis can be 
used to analyze the samples 
containing cell proliferation 
information and show the fitting 
results. See Cell Proliferation 
Analysis for more information. 

 



Data Analysis 

 Software Guide 121 

Bi-variate 
Plot  

Two-
parameter 

Create a matrix of plots with 
selected parameters plotted 
against each other. See Bi-
Variate Plots for more 
information. 

 

Create a Plot 

In the NovoExpress Software, plots (except bi-variate plot) can be created through 
the toolbar, the Experiment Manager, and the Gate Manager. In addition, plots can 
be duplicated in the Workspace, copied in the Experiment Manager, and imported 
from templates. 

Create a Plot with the Toolbar 

Use the plot buttons in the Workspace toolbars to create new plots. The button will 
create a new plot for the active sample. 

 

Create a Plot with the Experiment Manager 

In the Experiment Manager panel, right-click on either the sample or the Analysis 
node under the sample. Select Create Plot and select the plot type.  
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Create a Plot from a Gate 

In the Workspace, new plots can be created using gates from previously created 
plots. New plots created through gates will only display events within the gate. 
There are multiple methods for creating a new plot through a gate: 
• Double-Clicking a Gate 

Double-clicking on a selected gate creates a new plot. The new plot has the 
same parameters and plot type as the plot containing the gate. The plot type 
and parameters can then be modified. 

• Selecting a Gate within the Workspace 

Click on a gate within a plot to select the gate. The gate label is italicized to 
indicate that it is selected. Right-click on the gate and select Create Plot and 
select the plot type. The new plot will have the same parameters as the plot 
containing the gate. The plot parameters can then be modified. 

 

• Selecting a Gate using the Menu Bar 

In the Gate tab of the Menu Bar, a gate can be selected from the drop-down 
menu in the Current Selection group. Click the Create Plot icon in the Apply 
Gate group to select a plot type. 

• Selecting a Gate using the Experiment Manager or Gate Manager 

In the Experiment Manager or Gate Manager panel, right click on a gate 
heading. Select Create Plot and select a plot type. 
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Create a Duplicate Plot 

Click a plot in the workspace to select it. To duplicate the selected plot, click the 
Duplicate icon in the Home tab of the Menu Bar or use the keyboard shortcut Ctrl 
D. The plot type and parameters of the new plot will match the previous plot, but 
the gates will not be replicated. 

Copy and Past a Plot with the Experiment Manager 

When using this method, the parameters of a plot from one sample can be applied 
to plot the data of a different sample. In the Experiment Manager panel, locate the 
initial plot by expanding the Analysis node under the corresponding sample. Right-
click the plot to be copied and click Copy. Select the Analysis node under the 
sample where the plot will be pasted. Right-click on this Analysis node and click 
Paste. The new plot uses parameters from the copied plot to plot data from the 
new sample. This can also be accomplished by doing a click and drag on the plot 
to be copied and dropping it into the desired sample. 

   
 
 

NOTE If the Analysis node is copied, all of the plots for the sample are included. Pasting 
this to the Analysis node of a new sample replicates all of the plots. Any plots 
currently in the sample are replaced. 

 
 

NOTE Pasting to a specimen node pastes to all of the samples under the specimen. 
 

Import from a Template 

In the Experiment Manager panel, select the Analysis node under the sample 
where the plots are to be imported. Right-click on the Analysis node and click 
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Import…. Select the template file to open. Upon selecting, the plots from the first 
sample in the template file are imported into the selected sample.  

Open and Close a Plot Window 

There are multiple methods for opening and closing a plot window. 

To open a plot window: 
• In the Experiment Manager panel, double-click on a plot node or right-click and 

select Open to open the plot. 
• In the Experiment Manager panel, double-click on a gate node or right-click 

and select Open to open the plot containing the gate. 
• In the Experiment Manager panel, right-click and select Open Plots on a 

sample to open all of the plots associated with the sample. 
• In the Experiment Manager panel, right-click and select Open Plots on a 

specimen to open all of the plots associated with the specimen. 
• In the Experiment Manager panel, right-click and select Open Plots on a group 

to open all of the plots associated with the group. 
 

To close a plot window: 
• Click the Minimize button in the top right corner of a plot window to close the 

plot. 
• In the Experiment Manager panel, right-click and select Close Plots on a plot 

to close the plot. 
• In the Experiment Manager panel, right-click and select Close Plots on a 

sample to close all of the plots associated with the sample. 
• In the Experiment Manager panel, right-click and select Close Plots on a 

specimen to close all of the plots associated with the specimen. 
• In the Experiment Manager panel, right-click and select Close Plots on a 

group to close all of the plots associated with the group. 
 
 

NOTE Click the Close button  in the top right corner of a plot window to delete the plot. 
 

Edit Plots 

Plot Gating 

To analyze subpopulations, plots can be set to only display events from within a 
specific gate. For this method, a gate from a previous plot will be applied to a 
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newer plot. The new plot can then be used to analyze the subpopulation or to 
further gate for more specific populations. 

If plots are gated, the gate will be displayed on the header of the plot as shown 
below. The header will display the sample name and the gate. In the example 
below, the sample name is Blood and the gate is LY. 

 

There are multiple methods for gating a plot. These methods include: 
• In the plot header, right-click to display a drop-down menu. In the drop-down 

menu, select the gate. If Ungated is selected, the plot is not gated and all 
events are displayed in the plot.  

 

• Right-click in the plot, select Gating and select the gate. If Ungated is selected, 
the plot is not gated and all events are displayed in the plot. 
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• Click on the plot to be gated to select the plot. In the Plot tab of the Menu Bar, 
select the gate in the drop-down menu from the properties group. If Ungated is 
selected, the plot is not gated and all events are displayed in the plot. 

• Select a gate in the Gate tab of the Menu Bar, and click Gating, select the plot 
to be gated. If All following plots is selected, all the plots listed will be gated. 

• Select a gate in the workspace, and drag it into the title of the plot to be gated. 

Parameter Plot Settings 

As shown in the figure below, the plot parameters are labeled next to the axes. 

 

To change the plot parameters: 

Right-click on the plot label and select the desired parameter. In the drop-down 
menu, the scatter and fluorescent parameters are separated in height and area 
measurements. Additional parameters include Width, the width of the individual 
event signal, Time, the time of the individual event signal, and Count, the number of 
events at a specific parameter. 
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Set Plot Types 

There are two methods for setting or changing the plot type of a plot. 
• Within a plot, right-click and select Plot Type and select the desired type of 

plot. 

 

• Click on the plot to be modified to select the plot. In the Plot tab of the Menu 
Bar, click on the Plot Type icon and select the desired type of plot from the 
drop-down menu. 
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NOTE When the plot is switched from a two-parameter type (dot, density, or contour plot) 
to a single-parameter plot (histogram), all two dimensional gates (rectangular, 
ellipse, polygon, and quadrant gates) are deleted. 

 

Rename Plots 

There are three methods for renaming a plot. 
• Click on the plot to be renamed to select the plot. In the Plot tab of the Menu 

Bar, edit the plot name in the Plot Name box. 
• In the Experiment Manager panel, right-click on the plot node and select 

Rename to enter a new name. 
• In the Experiment Manager panel, click the plot node, and type a new name 

directly. 

Delete Plots 

There are multiple methods for deleting a plot. 
• Click the Close button in the top right corner of the plot window to delete the 

plot. 
• In the Experiment Manager panel, right-click on the plot node and select 

Delete to delete the plot. 
• In the Experiment Manager panel, right-click on the sample node or Analysis 

node and select Delete Plots to delete all of the plots associated with the 
sample. 

Set the Coordinates of the Axis 

As shown in the figure below, the coordinates of an axis are labeled next to the 
axis. The axis multiplier is labeled within parentheses in the axis label. 
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Set the Coordinate Range 

By default, the coordinates for each parameter will be shown over a full range. 
During analysis, it may be necessary to reduce the display range to focus on a 
specific population. 

There are multiple methods for changing the coordinate range including zooming, 
the auto range tool, the move tool, and manually entering the coordinate range. 
Select these tools either from workspace toolbar  or plot right-click 
popup mini toolbar. 

 

• Pointer  : When the pointer is selected, maximum or minimum axis value can 
be directly adjusted on the plot. 

Move the cursor to the maximum or minimum position of the X or Y 
coordinate. The cursor will change to  for X coordinate or  for Y 
coordinate. Click and move the cursor to change the maximum or minimum 
value of the corresponding value. Double clicking the arrow will set the axis to 
Auto Range on the corresponding coordinate. 

• Zoom In  : This tool enlarges the display by narrowing the coordinate range.  

There are multiple methods to access this tool. This tool can be activated by 
clicking on the icon in the Workspace toolbar, using the keyboard shortcut Ctrl 
+, or right-clicking on a plot and selecting Zoom In. 

To use the tool, click and drag in a plot over the area to be enlarged. A 
rectangle is drawn, and the range of the rectangle becomes the range of the 
zoomed in plot. 
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NOTE To zoom in only along one parameter, click and drag along the parameter’s 
coordinate label. This method zooms in on the selected parameter, while the 
second parameter’s coordinate range remains unchanged. 

 

• Zoom Out  : This tool compresses the display by widening the coordinate 
range.  

There are multiple methods to access this tool. This tool can be activated by 
clicking on the icon in the Workspace toolbar, using the keyboard shortcut Ctrl 
-, or right-clicking on a plot and selecting Zoom Out. 

To use the tool, click within a plot. The range increases by 20% of the current 
range. Click repeatedly until the desired range is reached. 

 
 

NOTE To zoom out only along one parameter, click on the parameter’s coordinate label. 
This method zooms out on this parameter, while the second parameter’s 
coordinate range remains unchanged. 

 

• Auto Range/Full Range 

Auto Range  : This tool automatically sets the coordinate range based on 
the maximum and minimum values of the data set.  

Full Range  : This tool automatically sets the coordinate range to the 
maximum and minimum values possible for the parameter.  

There are multiple methods to access these tools. These tools can be 
activated by clicking on the icons in the Workspace toolbar, using the 
keyboard shortcuts Ctrl A for Auto Range and Ctrl F for Full Range, or right-
clicking on a plot and selecting Auto Range or Full Range. 

• Move  : This tool allows the user to pan the graph with the coordinate range 
automatically adjusting.  
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There are multiple methods to access this tool. This tool can be activated by 
clicking on the icon in the Workspace toolbar, using the keyboard shortcut Ctrl 
M, or right-clicking on a plot and selecting Move. 

To use this tool, click and drag in a plot to move the display region. The 
coordinate range then automatically adjusts. 

 
 

NOTE To pan the plot only along one parameter, click and drag along the parameter’s 
coordinate label. This method causes the plot to pan along the selected parameter, 
while the second parameter’s coordinate range will remain the same. 

 

• Manually Setting the Coordinate Range through the Axis Setting Window 

To access the Axis Setting window, right-click on the coordinate label of a plot 
and select Setting.  

 

The Axis Setting window includes boxes to set the maximum and minimum 
value for both parameters. 
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• Manually Setting the Coordinate Range in the Plot tab of Menu Bar. 

 

Set the Coordinate Scale 

The available coordinate scaling types available in the NovoExpress Software 
include linear, logarithmic, and biexponential. In general, linear scaling is used for 
scatter channels, logarithmic scaling is used for the fluorescent channels, and 
biexponential scaling is used for fluorescent channels where fluorescence 
compensation has resulted in negative values. 

To set the coordinate scaling, right-click on the coordinate label and select the axis 
scaling. 
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The axis scaling can also be set through the Plot tab of the Menu Bar using the 
Scale drop-down menu for each axis. 

Display a Biexponential Plot 

Biexponential display uses biexponential scale to transform data, especially for 
those where cells become piled up in the first decade at the axis. This is displayed 
as fluorescence values <0 even for uncompensated data. Biexponential 
transformation incorporates linear scaling for low values together with log scaling 
for high values. Biexponential scaling gets rid of cells being piled up at axes 
origins, allowing visualization of cells with negative or dim fluorescence. The plots 
below are the result of different scales, left side is with logarithmic scale and right 
is with biexponential scale.  

 

• Below Zero Value of biexponential scale 

Biexponential transformation can be seen as combination of near linear and 
near logarithmic scales. It goes smoothly from near linear within the reflection 
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point to the near logarithmic within range further away from the reflection 
point. The width of near linear transformation interval can be changed, which 
is calculated by the Below Zero Value of biexponential scale in NovoExpress 
software. 

Manually enter the Below Zero Value in Axis Setting dialog or click Reset 
button to let NovoExpress software calculate the value automatically. When 
resetting, software calculates the Below Zero Value according to the events 
data in current gating of plot. The minimum value of the axis will be 
automatically set by the linear minimum of biexponential scale, which is 
determined by the current Below Zero Value. 

 

Another way to reset the Below Zero Value is to right-click on the coordinate 
label and select the Reset Below Zero Value menu item. 
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To adjust the Below Zero Value directly on plot, move the cursor to a 
coordinate axis with biexponential scale, a triangular symbol will appear on the 
position of below zero value. Click and drag the triangular symbol to adjust the 
Below Zero Value, and the plot will reflect the change dynamically while 
dragging the triangular symbol. 

 

Adjust the Size of Plots 

• Maximizing and restoring a plot window 

Plot windows can be maximized by clicking on the maximize button  , in the 
top right corner of the window or by double-clicking in the plot. To restore the 
plot after maximizing it, either click on the restore button (as shown below) or 
double-click in the plot. 
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• Resizing all plot windows 

To resize all of the plot windows, use the zoom slider on the right side of the 
Status Bar (as shown below) or the Zoom tool in the View tab of the Menu 
Bar. 

 
 
 

NOTE Adjusting the size of the plot window does not affect the coordinate range of the 
plots. To adjust the coordinate ranges, see Set the Coordinate Range. 

 

Copy or Save Plots 

Plots from the NovoExpress Software can be copied and saved. 
• To copy a plot to the clipboard 

Right-click in a plot. Select Copy and select the format to copy the plot. Plots 
can also be copied using the Copy button in the Plot tab of the Menu Bar. 
Using the keyboard shortcut Ctrl C copies the selected plot in bitmap format. 

 

• To save a plot 

Select a plot by clicking on it, and click the Save as Image button  from the 
Plot tab of the Menu Bar. The image format can be selected in the Save 
Image window.  

Overlays 

Multiple overlays can be included in dot plots or histogram plots. When a plot is 
created, it only contains the data from one sample. Overlays can display the data 
from multiple samples and gates in one plot with different colors. Below show the 
example of the dot and histogram plots with overlays from different samples. 
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• Add overlays by using the drag and drop method:  

Hold down the Ctrl key on the keyboard, use the mouse to drag a sample or 
multiple samples to a plot from the Experiment Manager, and the new 
overlays are added to the plot. The gate of new overlay is from the sample of 
the overlay, it always takes the same name as the gate of plot. It will be the All 
gate, if no gate with the name is found in the sample of the overlay. 

• Edit overlays:  

Right-click a plot to access the shortcut menu, select Edit Overlays to 
generate the Edit Overlays dialog window as shown below. In the dialog, all 
overlays of the plot are listed. One can select an overlay, set the overlay’s 
sample, gate or color, and make a choice to show or hide the selected overlay 
on the plot. Adding new overlays or deleting overlays can also be done here. 
Click Add button to open the Add Overlay window, press Ctrl or Shift key while 
clicking the selected sample (s), click Add or Add & Close in this window to 
add selected sample (s) to the Edit Overlays window. Click Apply and OK to 
complete adding the new overlays to the current plot. 
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• Display legend:  

When the overlays are added, the legend will automatically appear on the 
overlay. User can move the legend to any location inside the plot by left-
clicking and dragging the legend. To remove the legend from the plot, right-
click the legend and uncheck the Show legend in the menu. 

 

Plot Formatting 

Each plot type has different formatting and settings options. This section 
describes the formatting options associated with each plot type. To format a plot, 
right click on a plot window and select corresponding format menu item. 

Dot Plot Formatting 

With dot plots, there is an option to only display the most recently collected events. 
This option allows the user to set a number or percentage of the most recently 
collected events to display. To open the Events Displayed window, right click on 
the dot plot and select Events Displayed…. 
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In the window, selecting Preview modifies the dot plot display as the user is 
changing the settings. Selecting Apply to all open plots applies the setting to all 
open dot plots. 

Density Plot Formatting 

With density plots, there is also an option to only display the most recently 
collected events. Please refer to Dot Plot Formatting for more details. Besides, 
following formatting options are available from the right click menu of density plot.   
• Smooth density plot: In this view, the density plot data are smoothed. To use 

this view, right-click on the density plot and select Smooth or select Smooth 
from the Plot tab of the Menu Bar. A comparison of a standard pseudocolor 
density plot (left) and a smooth pseudocolor density plot (right) is shown 
below.  

 

• Pseudocolor density plot: By default, density plots are displayed in 
pseudocolor. In this view, areas of the plot with a higher density of events are 
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shown in warmer colors (colors toward the right of the color bar below) and 
areas of the plot with a lower density of events are shown in cooler colors 
(colors toward the left of the color bar below). 

 

To switch from a pseudocolor to a gray-scale density plot, right-click on a 
density plot and unselect Pseudocolor or unselect Pseudocolor from the Plot 
tab of the Menu Bar. A comparison of a grayscale density plot (left) and a 
pseudocolor density plot (right) is shown below. 

 

Histogram Plot Formatting 
• Smooth histogram: To smooth the edges of a histogram, right-click on a 

histogram plot and select Smooth or select Smooth from the Plot tab of the 
Menu Bar. A comparison of a standard histogram plot (left) and a smooth 
histogram plot (right) is shown below. 

  

• Histogram fill type: Histogram plots can be viewed with different fill types. To 
select a fill type, right-click a histogram plot and select Filling and select the fill 



Data Analysis 
 
 

142   Software Guide 

type, or select the fill type from the Filling drop-down menu in the Plot tab of 
the Menu Bar. A comparison of the filling types is shown below. The options 
include None (left), Filled (middle), and Tinted (right). 

 

• Histogram layering: When overlaying histogram plots, different overlay styles 
can be selected. To select an overlay style, right-click in a histogram plot with 
layers and select Style to select the overlay style. The overlay style options, as 
shown below, include Overlaid (left), Offset (middle), and Half Offset (right). 

  

Contour Plot Formatting 

With contour plots, there is also an option to only display the most recently 
collected events. Please refer to Dot Plot Formatting for more details. Besides, 
following formatting options are available from the right click menu of contour 
plot. 
• Contour levels: Different contour levels are available for contour plots. Higher 

contour levels indicate a larger density interval in between contour lines on the 
plot. The available contour levels include 10%, 5%, and 2%. A contour plot is 
shown below with a 10% contour level (left) and a 5% contour level (right). 
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• Show Outlier: If selected, outlier events are shown as dots on contour plots. A 
contour plot is shown below with Show Outlier selected. 

 

Plot Format 

The Plot Format defines plot appearance. The font, size, style, color, line weight, 
and visibility can be customized. To open the Plot Format window, right click 
inside plot area and select the Format... menu item in the popup menu. 
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• Using Default Format: 

Check this box to set plot using system default format. 
• Objects: 

Select objects that the format is applied to. The objects are listed in tree mode. 
Select parent node will apply to all its child nodes. 

• Font: 

Set font name and font size for the selected objects. 
• Style: 

Set font style for the selected objects. Check button B for bold, button I for 
italic.  

• Default Color: 

Set color for the selected objects. Check Default Color box if the software 
default color is to be used. For gate label on plot or plot title, the default color 
is the color of the gate. For the other objects, the default color is black. 

• Visible: 

Check this box to set the object visible. 
• Line Weight: 

Select line weight of selected objects. 
• Set as Default: 
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Check this box to set the format settings as the default when Apply or OK 
button is clicked. 

• Apply to: 

Select which plot(s) to apply the format settings. 
• Apply: 

Click to apply changes and keep this window open. 
• OK: 

Click to apply changes and close this window. 
• Cancel: 

Click to close this window without applying any changes. 

Default Plot Settings 

To change the default settings for plots, go to File > Options and select the 
Analysis tab. See Setting for details. 

  

Bi-Variate Plots 

Bi-Variate Plots window can be used to create a matrix of plots with selected 
parameters plotted against each other. To create bi-variate plots, click  icon in 
the workspace toolbar to open Bi-Variate Plots window. 
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• Parameters: List all the parameters of the selected sample in the Sample 
drop-down box. Clicking the OK button after selecting the parameters in the 
drop-down list will create the N×N plots of the selected parameters. Check 
Select all parameters to check all the parameters. 

 

• Height: Select to set the parameter of the plots to Height. 
• Area: Select to set the parameter of the plots to Area. 
• Gate: List all the gates of the selected sample in the Sample drop-down box. 

The first item is Ungated. When select a gate, only the data in the gate will be 
displayed on the plots. 

• Plot Type: Select plot type for the created bi-variate plots, including Dot Plot, 
Density Plot, and Contour Plot. 
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• Sample: Select which sample in the experiment file to be plotted. Be default, 
the current active sample will be selected when the window is opened. Used 

 icon to switch samples forward and backward. 
• Compensation: Click to open Compensation window to change the 

compensation settings. The created plots will be refreshed according to the 
modified compensation settings. For details of the fluorescence 
compensation setting, refer to Active Compensation for detailed description. 

 

• Overlay Uncompensated: Select to overlay uncompensated data on the 
created bi-variate plots.  
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• Display Last XXX Events: Displays the most recently collected events in the 
plot. This option allows the user to set a number or percentage of the most 
recently collected events to display. When user clicks the XXX area, following 
window will pop up. User can select and edit either the number or percentage 
of events to be displayed for all Bi-variate plot. When Preview is checked, user 
can preview the resulted changes to all plots. 

          

• Plot Size: Move the slider can change the size of the plots. 
• Select: Click on the pop-up selection menu to select different section of the bi-

variate plots (Bottom Left Plots, Top Right Plots, and Histograms) or unselect 
all plots. The plot can also be selected by clicking individual plot. To select a 
group of plots, pressing the left mouse button and drag an area across all the 
plots to be selected. Once selected, a red border will show on the plot. Clicking 
on the selected plot one more time will cancel the selection. Selected plots can 
be added into the workspace by clicking “Create Selected” button.  

 

• Create Selected: Click to create the selected plots in the workspace. 
• Close: Click to close Bi-Variate Plots window. 

 

NOTE The settings user defined in Bi-variate Plots window, including Parameter, Height, 
Area, Gate, Plot Type, Sample, Compensation, Overlay, and Events to be displayed 
will be automatically recorded by the software. When user re-open this window or 
restart the software, these settings will be automatically applied. 
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Gates 

Gates allow for the analysis of subpopulations from the total population collected. 
As described in Plot Gating gates can be applied to subsequent plots to focus in 
on a specific population. These plots can then be further gated and new plot 
created to focus on a more specific population. 

The Workspace Toolbar includes icons for creating rectangular gates  , elliptical 
gates  , polygonal gates  , Freehand Gates  , quadrant gates  , logic 
gates  , range gates  , and bi-range gates  . 

 

The gating tools can be also selected from the right-click popup mini toolbar on 
plots. 

 

All gate types can be created on dot plots and density plots. Range gates and bi-
range gates can be created on histograms. Gates can also be combined to create 
a logic gate. 

Create Gates 

• To create a rectangular gate: Click the rectangular gate icon  , in the 
Workspace Toolbar. Click and drag in the plot to enclose the target population 
within the rectangle. Release the mouse button to create the gate. 

• To create an elliptical  , range  , or bi-range gate  : Follow similar 
procedures as for creating the rectangular gate. 

• To create a polygonal gate: Click the polygonal gate icon  , in the 
Workspace Toolbar. Left click in the plot to create the first vertex of the 
polygon. Click in a new location to create the second vertex of the polygon. 
Continue moving around the target population and creating vertices until the 
target population is enclosed. On the last vertex, double-click to complete the 
polygon and create the gate. 

• To create a Freehand Gate: Click the Freehand Gate icon  , in the Workspace 
Toolbar. Left click start point in the plot to begin creating the Freehand Gate. 
Move the mouse cursor inside the plot to draw curve. Double-click the end 
point to complete and create the gate. 
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The following figures include a rectangular gate GR, an elliptical gate MO, a 
polygonal gate LY, a range gate M1, and a bi-range gate separating CD3- and 
CD3+. 

 

• To create a quadrant gate: Click the quadrant gate icon  , in the Workspace 
Toolbar. Click in the plot to create the center of the quadrants and create the 
gate. As shown below, the center, endpoints, and lines of the quadrant gate 
can be moved to enclose the correct populations. 

 

• To create a logic gate: Click the logic gate icon  , in the Workspace Toolbar 
to open the Create Logic Gate window. In this window, the user can create a 
logic gate for the sample in the selected plot. 

There are three types of logic gates: AND gates, OR gates, and NOT gates. In 
the window, a drop-down menu includes the three logic gate types. 

When AND or is selected from the drop-down menu, there are two additional 
drop-down menus to select gates. With an AND gate, the new gate includes 
events that are included in both of the selected gates. With an OR gate, the 
new gate includes events that are included in either one of the selected gates. 

When NOT is selected from the drop-down menu, there is one additional drop-
down menu to select a gate. With a NOT gate, the new gate includes all of the 
events excluded from the selected gate. 
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In the Experiment Manager panel, logic gates can be found under the 
sample’s Analysis node. 

 

NOTE If you want to create multiple gates of the same type, double click the gate icon (a 
blue outer line will show on the gate icon). The gating tool will then remain active 
and you can create multiple gates of the selected type. Once completed, press the 
Esc key on the keyboard to exit. 

 

Edit Gates 

All gates can be moved and resized after being created. If a gate is edited, all gate 
statistics and subsequent plots dependent on the gates are updated to reflect the 
changes. 

There are multiple methods to select a gate for editing. Options include: 
• Click the pointer icon  , in the Workspace Toolbar to activate the cursor. 

Select the gate by clicking on a vertex or edge of the gate. 
• Click on the gate label. 
• From the Gate tab of the Menu Bar, select the gate from the drop-down menu 

in the Current Selection group. 
• Double-click on an area within the gate. This does not work for quadrant gates. 

After the gate is selected, the gate’s control points are displayed (as white boxes). 
To change the size of a gate, click and drag the control points to modify the gate. 

 

NOTE Extra grey control points are displayed when a polygon gate is selected, which can 
be used to scale the gate as a whole. 
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To move the gate, select the gate as described above and drag within the gate or 
press keyboard arrows. While moving, the cursor should change into the crossed 
arrow symbol. 

 

After editing is complete, click outside of the gate to unselect the gate. 

To delete a gate, select the gate as described above and press the Delete key on 
the keyboard. When a gate is deleted, the subsequent gates and plots that depend 
on it are reset. 

Gate Display Format 

The NovoExpress Software allows users to format the color and labels of gates. 
Gate color determines the color of events displayed on the dot plot, as well as the 
color of the histogram when the gate is applied to a histogram.  

Set the Color of the Gate 

The color of each gate can be set. In dot plots, the events included in the gates are 
displayed in the chosen color. If additional dot plots are created, these events are 
displayed in the same color for easy identification. 
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To remove the color from gates, select the gate and right-click on the gate and 
unselect Show Color or select the gate and unselect Color from the Gate tab of the 
Menu Bar. 

The plots shown below have a gate with the color unselected. 

 

The plots below have a gate with the color selected. 
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To change the color of a gate, select the gate, right-click and select Change Color… 
or select the gate and change the color from the drop-down menu next to Color in 
the Gate tab of the Menu Bar. Gate color can also be changed via color column of 
Gate Manager. 

When an event is inside more than one gate, its color on dot plot is determined by 
the color precedence of the gates. The plots below show that gate CD3+CD4+ has 
higher color precedence than does gate Lym. To view or modify color precedence 
of gate, refer to Gate Manager. 

 

Gate Labels 

Gate labels are displayed near the gates and include the gate name and the 
percentage of the events included in the gate relative to the total number of events 
displayed on the plot.  
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To change the name of a gate, select the gate and click on the gate name to edit or 
select the gate and edit it from the Gate Name box of the Gate tab in the Menu 
Bar. 

To hide the population percentage, unselect Show Value from the Gate tab of the 
Menu Bar, or unselect Show population percentile in the gate label in the Analysis 
Tab of Options. 

If the alias of a parameter is labeled in the Parameters panel as a CD (Cluster of 
Differentiation) marker, quadrant and bi-range gates can be used to easily label 
positive and negative populations. To use this setting, the parameter’s alias must 
be labeled as CD and a number. Right-click on the quadrant or bi-range gate and 
select Name with CD to rename the gates according to the CD markers.  

 

Apply a Gate to a Plot 

There are multiple methods for applying a gate to a plot. When gates are applied to 
plots, the plots only display events included within the specified gate. Gates can be 
applied to a plot if the creation of the gate is not dependent on the plot. 

To apply a gate to a plot: 
• Within the workspace, hold down the keyboard Ctrl key while dragging the gate 

to the plot. The dragged gate is applied to the plot where it was dropped. 
• Select a gate in the workspace, and drag it to the title of the plot to be gated. 
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• Select the gate and right-click on the gate. Select Gating and select the plots 
to have the gate applied. 

• Select the gate from the Gate tab of the Menu Bar, select the Gating button 
and select the plots to have the gate applied. 

Copy and Paste Gates 

There are multiple methods to copy and paste a gate: 
• Select the gate and use the keyboard shortcut Ctrl C to copy the gate. Select a 

plot and use the keyboard shortcut Ctrl V to paste the gate into the selected 
plot. 

• Select a gate. Drag and drop the gate into a different plot. The dragged gates 
are pasted into the plot where it was dropped. 

• To duplicate a gate within the same plot, select a gate and use the keyboard 
shortcut Ctrl D or select the gate and use the Duplicate button from the Home 
tab of the Menu Bar. The duplicate plot appears at the same location as the 
original gate. 

Export Gate Events 

The data from a gate can be exported in either CSV or FCS file format. To export: 
1 Select the gate. 
2 In the Gate tab of the Menu Bar, click the Export Events button to open the 

window shown below. 
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3 In the window, set the export path, file format, parameter range and post gain. 
Click OK to export the data. 

 

NOTE For more information regarding this window, see Export Data. 
 

Gate Manager 

The Gate Manager displays all gates of the active sample in list mode or tree 
mode. It provides user interface to modify gate name, color and color precedence 
and also shows gate hierarchy and gate statistics. 
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Toolbar of Gate Manager 

 
 

Icon Description 

 

Show Gate Hierarchy: When checked, the table displays output in tree mode. Child 
gates are indented. 

 

Show Columns: Choose which statistical columns to display in the table. Refer to 
Calculation of Statistics for further information on calculation of gate statistics. 

 

Modify Color Precedence: When checked, the table displays output as list mode. The 
table is sorted by color precedence – the gate with highest color precedence is 
displayed on the top. 

 

Reset to Default Color Precedence: Sets color precedence of all gates to default 
values. By default, newer gates have higher precedence than do older gates. Child gates 
have higher precedence than do parent gates. Logic gates have higher precedence than 
do gates which compose the logic gates. 

 

To Top: Sets color precedence of selected gate to the highest precedence. Only 
available when Modify Color Precedence is checked. 

 

Up: Sets color precedence of selected gate higher. Only available when Modify Color 
Precedence is checked. 

 

Down: Sets color precedence of selected gate lower. Only available when Modify Color 
Precedence is checked. 

 

To Bottom: Sets color precedence of selected gate to the lowest precedence. Only 
available when Modify Color Precedence is checked. 

 

Copy Text: Copies all gate name(s) and statistics as text to clipboard. 

Modify Gate Color and Color Precedence 

A gate can be set with a color, and the color will be used to draw the gate label. On 
dot plots, events inside a gate are shown as colored dots defined by the gate color. 
When an event is inside more than one gate, its color on a dot plot is determined 
by the color precedence of the gates. To understand more about gate color and 
color precedence, refer to Set the Color of the Gate. 

To modify gate color precedence, check the Modify Color Precedence tool in the 
toolbar. The color column in Gate Manager is shown below: 
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The number in the Color column is the gate color precedence. Number 1 indicates 
highest color precedence. The gate rows are sorted by color precedence. To 
change the color precedence of a gate, drag the gate row and drop it to desired 
position. Click the check box to set whether to show gate color (black color 
indicates no color is shown). Click the color square box to change gate color in a 
pop up tool window.  

Context menu 

The context menu is shown below for right clicking on only one gate. 

 

Create Plot: Creates a new plot including the events from the selected gate. 

Gating: Selects plots to apply the gate.  

Open: Opens the plot containing the gate. 

Copy: Copies the gate. 

Delete: Deletes the gate. 

Rename: Renames the gate. 
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Name with CD Marker: If a fluorescence parameter is labeled as a CD (Cluster of 
Differentiation) marker in the Parameter panel by setting the Alias as CD and a 
number, this labels the gate using the CD marker(s) specified. 

Change Color: Modifies the color of the gate. 

Show Color: Sets whether to display the gate in color. 

Color Precedence: Modifies color precedence of the gate. 

Show Name: Shows the gate name in gate label on plot. If the Show gate name in 
gate label option in Setting > Analysis is not checked, the Show Name menu item 
here will be disabled. 

Show Percentile: Shows the percentage of the gated events relative to the total 
number of events on the plot. If the Show population percentile in gate label 
option in Setting > Analysis is not checked, the Show Percentile menu item here 
will be disabled. 

Format: Opens Plot Format dialog to define gate format. 

Export Events: Exports data for the events inside the current gate in either FCS or 
CVS format. 

 
 

NOTE When multiple gates are selected in Gate Manager, only Delete, Show Color, Color 
Precedence, Show Name and Show Percentile are available. 

Statistics 

In the NovoExpress Software, a table of statistical information can be found under 
plots. 

Display Statistical Information 

In the following figure, the statistical information chart is displayed below the plot. 
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Open the Statistics Chart 

There are two methods to open the statistical information chart. 
• From the plot, click the button on the lower right corner to expand the plot and 

display the statistics chart. 

 

• From the Workspace Toolbar, click the Show Statistics button to show/hide 
the statistics chart of a plot. 

Statistics Layout 

In the statistics chart, the first column is the Gate column, and the remaining 
columns list the statistical parameters. As labeled by the Gate column, the first 
row of the chart contains statistical information for all events, and the remaining 
rows contain statistical information for individual gates. 
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To hide or show individual statistical parameters in the chart, right-click within the 
chart and select the parameters to hide or display. Check Set as Default to set the 
current setting as the default setting of new plot. And click Apply to All to hide or 
show individual statistical parameters to all plots of current sample. 

 

Copy Statistical Information to Clipboard 

Data from the statistics chart can be copied to the clipboard. The copied data can 
by pasted to a spreadsheet program, such as Microsoft Excel, for further analysis. 

There are two methods to copy statistical information to the clipboard: 
• Select the statistical information from the chart by clicking and dragging or by 

using the keyboard shortcut Ctrl A to select all. Use the keyboard shortcut Ctrl 
C or Shift C to copy the selected information. With Ctrl C and Shift C, one may 
copy the information with the column header and one may copy the 
information without the header. This can be set under File > Options > 
General. 
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• Right-click in the plot, select Copy, and select Copy Statistics (Text). 
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Statistics Layers 

For plots with multiple layers, the statistical table includes additional columns. The 
first column, #, indicates the layer on the plot. The second column, Sample, 
indicates the sample plotted in the layer. The third column, Gate, indicates the 
gate. The remaining columns describe the statistical parameters. 

If a gate belongs to a sample which is different from the first layer’s sample, an 
asterisk appears next to the gate name to indicate such situation. In the figure 
below, the statistics of the second row is for gate LYM which applies to the sample 
named Negative as indicated by the asterisk next to the gate name to distinguish it 
from the LYM gate which applies to the sample named Positive. 

 

For gates in a layered plot, the statistical information is displayed for all layers. In 
the figure below, statistical information for Gate M3 is displayed for both the layer 
corresponding to the Positive sample and the layer corresponding to the Negative 
sample. The statistics in the last row is for gate M3 which belongs to the sample 
named Positive; since this is the same as the first layer, no asterisk shows next to 
the gate name. 
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Calculation of Statistics 

In calculating the statistics, linear scale data are used regardless of the coordinate 
scale displayed by the plot. The calculation also takes into account any 
fluorescence compensation applied to the data.  

In addition, the calculations update automatically if the data set, gates, 
fluorescence compensation, or plot parameters are modified. 

The statistics include the total number of events, absolute count, percentage 
gated, mean, coefficient of variation, half-peak coefficient of variation, median, and 
geometric mean. 
• Count 

The number of events collected in the specified gate. 
• Abs. Count 

The abbreviation of Absolute Count. The concentration of events defined as: 

Absolute Count = Count / Ve / DF / Absolute Count Unit 

Where Count is the number of events in the gate, Ve is the sample acquisition 
volume, DF is the dilution factor, and Absolute Count Unit is the absolute 
number of units. To set the dilution factor and the absolute number of units, 
click on Absolute Count Setting from the Sample tab of the Menu Bar. 

 

• %Parent  
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Percentage of events included within the gate relative to the number of events 
within parent gate. 

• % Grandparent 

Percentage of events included within the gate relative to the number of events 
within grandparent gate. 

• % All 

Percentage of events included within the gate relative to the total number of 
events collected. 

• Mean 

The mean is defined as  

X� =
1
𝑛𝑛 

 �𝑋𝑋𝑖𝑖

𝑛𝑛

𝑖𝑖=1

 

Where n is the number of events and 𝑋𝑋𝑖𝑖 is the parameter value of the number i 
event. 

• SD 

The standard deviation indicates the variation in the data set and is defined as  

�
1

𝑛𝑛 − 1
�(𝑋𝑋𝑖𝑖 − 𝑋𝑋�)2
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Where n is the number of events, 𝑋𝑋𝑖𝑖 is the parameter value of the number i 
event, and 𝑋𝑋� is the mean of the set. 

• rSD (Robust SD) 

The robust SD is relatively insensitive to outliers comparing to the classical 
standard deviation. It is equal to 0.75 multiplied by the interquartile range 
(IQR). The interquartile range is the 75th percentile channel minus the 25th 
percentile channel.  

The RSD is defined as 

rSD = 0.75 × IQR = 0.75 × (Q3 − Q1) 

Where Q1 is the 25th percentile channel and Q3 is the 75th percentile channel. 
• CV 

The coefficient of variation indicates the variation of the data set expressed as 
a percentage and is defined as  
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CV = (SD / 𝑋𝑋�) × 100% 

Where SD is the standard deviation and X �  is the mean. 
• rCV (Robust CV) 

Robust CV is calculated by Robust SD divided by population median. 

rCV = rSD / Median 
• HPCV 

The half-peak coefficient of variation is expressed as a percentage and is 
defined as  

HPCV = FWHM / (2.36𝑋𝑋�) × 100% 

Where FWHM is the full width at half maximum of the peak and 𝑋𝑋� is the mean 
of the set. 

• Median 

The median value separates the data set so that number of events larger and 
the number of events smaller than the median are equal. 

• Geom. Mean 

The geometric mean is defined as 

𝑋𝑋�𝑔𝑔𝑔𝑔𝑔𝑔 = 10
1
𝑛𝑛∑ log𝑋𝑋𝑖𝑖

𝑛𝑛
𝑖𝑖=1  

Where, n is the number of events and Xi is the parameter value of the number i 
event. Note that the geometric mean cannot be calculated for events with 
negative values. If you include the geometric mean for populations with 
negative values, the resulting statistics will be invalid. 

• Stain Index 

The Stain Index is a normalized functional measure of the reagent brightness, 
defined as 

Stain_Index = (𝑀𝑀𝑀𝑀𝑀𝑀1 − 𝑀𝑀𝑀𝑀𝑀𝑀2)/(2 × 𝑆𝑆𝑆𝑆2) 

Where 𝑀𝑀𝑀𝑀𝑀𝑀1 is the Mean Fluorescence Intensity of the positive population, 
𝑀𝑀𝑀𝑀𝑀𝑀2 is the Mean Fluorescence Intensity of the negative population and 𝑆𝑆𝑆𝑆2 is 
the standard deviation for the negative population. The Stain Index function is 
only available in statistical table but not statistics chart below the plot. 
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Fluorescence Compensation 

In multicolor flow cytometry, where a sample is stained with a combination of 
different fluorophores, each of the different fluorophores has a unique emission 
spectrum, and in many cases, the different emission spectra overlap. If the overlap 
occurs within a specific fluorophore’s channel, fluorescence compensation can be 
used to correct for the overlap by removing the signal from the fluorophores that 
do not correspond to the channel.  

The NovoExpress Software provides three methods for the user to adjust 
fluorescence compensation. These methods include an automatic method, a 
compensation matrix adjustment method, and a quick compensation method. 

Automatic Compensation 

The automatic compensation method automatically calculates the compensation 
matrix and also allows for the compensation matrix to be applied to additional 
samples. Automatic Compensation matrix can be generated from samples 
acquired on instrument and from samples imported with FCS files. Conduct 
Automatic Compensation from Imported FCS Files describes the details on how to 
generate automatic compensation matrix using imported FCS files. 

Set Automatic Compensation 

In the Home tab of the Menu Bar, click the Auto Compensation button, or in the 
Experiment Manager panel, right click on the file name or a group and select New 
Auto Compensation…. The New Auto Compensation window appears. 

 

In the New Auto Compensation window, the user can select the channels for 
compensation, whether to compensate using area or height measurements, and 
whether to calculate compensation based on the measured mean or median.  

To set up the automatic compensation: 



Data Analysis 

 Software Guide 169 

1 Select the channels to compensate: Use the checkboxes to select the 
channels to compensate. If an unstained sample is to be used to assist in 
compensation, select the Unstained box. 

2 Choose to compensate either using the Area or Height measurements. 
3 Choose to compensate based on either mean or median values. 

 
New Auto Compensation window for NovoCyte instrument (e.g. 3000 System) 
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New Auto Compensation window for NovoCyte Quanteon instrument (e.g. 4025 System) 

                                     
                                     New Auto Compensation window for NovoCyte Advanteon instrument (e.g. V8Y6B7 System) 
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                                      New Auto Compensation window for NovoCyte Penteon instrument (e.g. U7V7B6Y6R4 System) 

4 Edit photodetector gain of each channel. Click Reset All photodetector Gain to 
reset photodetector gains of all channels to default values. Every instrument 
has the default photodetector gain setting. An underlined photodetector gain 
text as shown above for the B530 channel indicates it has been modified and 
is not the default value. A non-underlined photodetector gain indicates that it is 
the default setting. 

5 Click OK. In the Experiment Manager panel, a Compensation Specimen node 
gets created with blank control samples created for the compensation 
calculation. The samples include the channels selected in the New Auto 
Compensation window. 
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To modify the automatic compensation settings, right-click on the Compensation 
Specimen node in the Experiment Manager panel. Select Auto Compensation 
Setup…. The Auto Compensation Setup window appears. Modifications to the 
automatic compensation settings can be made in this window. Click OK to save 
the modifications. 

Prepare Samples for Automatic Compensation 

To calculate the compensation, experimental data will need to be collected for 
each of the control samples in the Compensation Specimen node. For the 
unstained sample, the sample should be prepared without any fluorophores 
added. For the other control samples in the Compensation Specimen node, the 
samples should be stained with only the corresponding stain. For example, a FITC 
control sample should be stained with only FITC. 

In addition, control samples can also be copied and pasted or imported from a 
FCS file into the sample, but for the compensation to be correct, the user must 
ensure that the samples meet the correct staining conditions and photodetector 
gain settings. 

Automatic Calculation of the Compensation Matrix 
• Automatic Gating 

After the acquisition of a compensation control sample, the sample data are 
automatically compensated. For each of the compensation specimens, the 
software automatically gates the main population in a density plot. In addition, 
the positive and negative groups are identified and gated on a histogram plot. 
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NOTE If an unstained sample is used, the Main gate in the unstained sample is used as 
the negative group for the control samples in calculating compensation. 

 

In most cases, the automatic gating finds the appropriate populations, but if 
necessary, the user can also adjust the gates using the following method: 
 Open the scatter plot for the sample and modify the position or size of the 

polygonal Main gate to enclose the correct main population. 
 Another option is to create a new gate in the scatter plot to enclose the 

correct main population, and then apply the new gate to the histogram 
containing the Positive and Negative gates. See Apply a Gate to a Plot for 
more information on applying a gate to a plot. 

 Adjust the Positive and Negative gates in the histogram to enclose the 
correct population. 

 
 

NOTE It is possible to remove the Main gate, but the Positive and Negative gates cannot 
be deleted. If the Main gate is removed, it has to be recreated manually on the 
unstained sample. 

 
 
 

NOTE After modifying the gates, if the user would like to restore the gate to the default 
position, in the Experiment Manager panel, select the sample, right-click, and select 
Reset Plots. 

 
 

• Automatic Calculation of the Spillover Values 

After the acquisition of the compensation specimen is completed, the 
fluorescence spillover of each dye is automatically calculated and displayed in 
the spillover matrix. In the matrix, the fluorophore is listed in the row and the 
spillover channel is listed in the column. 

In an example of calculating spillover, the spillover of FITC into the PE channel 
using median or mean height measurements is shown below. The values 
below are measured from the single stained FITC sample. 

Spillover of FITC into PE =
(𝑋𝑋𝑃𝑃𝑃𝑃,𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 − 𝑋𝑋𝑃𝑃𝑃𝑃 ,𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛)

(𝑋𝑋𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹,𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝 − 𝑋𝑋𝐹𝐹𝐹𝐹𝐹𝐹𝐹𝐹,𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛𝑛)
 

Where 𝑋𝑋𝑃𝑃𝑃𝑃,𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝𝑝  is the median or mean in the PE-H channel of the positive 
FITC population, and so on. 

If median is used for calculation, the above spillover value will be adjusted 
slightly so that after compensation, the median in PE-H channel of the 
negative FITC population and the median in the PE-H channel of the positive 
FITC population are closely aligned. 
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• Automatic Calculation of the Spillover Matrix 

In the following figure, the spillover of the single stained FITC sample is 
automatically calculated. In the matrix, the fluorophore is listed in the row and 
the spillover channel is listed in the column. In this figure, the FITC fluorophore 
spillover is 9.4007% into PE, 2.2213% into PerCP, 0.0067% into PE-Cy7 and 
0.0025% into APC. 

 

Following figure shows the entire spillover matrix automatically calculated. To 
open this, double click the Compensation node of Compensation Specimen in 
the Experiment Manager Panel. The spillover values of this matrix are from all 
single stained samples’ spillover matrices. 

 

Application of Automatic Compensation Results 

To apply the compensation matrix to experimental samples, in the Experiment 
Manager panel copy the compensation matrix under the Compensation Specimen 
and paste it to the Compensation node under the desired sample. 

WARNING 
 

The compensation matrix is calculated at specified photodetector gains. It 
should only be applied to samples that were acquired with the same 
photodetector gains. 
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Conduct Automatic Compensation from Imported FCS Files 

To perform auto-compensation directly from the imported FCS file:  
1 Click Home > Auto Compensation to open the New Auto Compensation 

window. Select the Import Samples from FCS files. 
 
 

NOTE This window can also be accessed by right clicking the experiment file and 
selecting New Auto Compensation in the Experiment Manager window. 

 

 

2 Select the single file or multiple files while pressing the Shift key in the 
keyboard. Click Open to import the selected file(s) to the software. 



Data Analysis 
 
 

176   Software Guide 

 

3 Ensure all the selected FCS files are successfully imported to the software. 
Click OK to continue.  

 

4 Set the compensation parameters in the New Auto Compensation window 
(i.e. Area or Height, Median or Mean). Ensure the selected channel parameter 
for each single stained sample is correct. To select different single stained 
sample file, click the file name, select the desired file from the pull-down menu. 
If a channel parameter does not need to be included for the compensation, 
click the blank area in the pull-down menu. The check box in front of the 
corresponding channel parameter will be automatically unselected. 

WARNING 
 

The software will automatically associate the imported FCS file with the 
selected channel parameter based on the keyword of the file name(e.g. 
B530). Users need to verify and select the correct FCS file for each 
fluorescence detection channel. 
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5 Click OK and NovoExpress will automatically calculate the compensation 
matrix based on the samples imported. Once generated, the compensation 
matrix can be applied to other experiment samples.  

Active Compensation 

The compensation matrix for each sample can be set to correct for fluorescence 
spillover in each channel. To open the compensation matrix for a specific sample, 
in the Experiment Manager panel, double-click on Compensation under the 
sample. 
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NOTE The text of the Compensation node in the Experiment Manager panel will be blue 
when the matrix is filled and black with the compensation matrix is empty. 

 
 

In the compensation and spillover matrix, the fluorescent probe is listed as rows 
and the spillover channel is listed as columns. 

 

Relationship between the Spillover and Compensation Matrix 

The spillover matrix and the compensation matrix are inversely related. When the 
spillover matrix is modified, the software automatically updates the compensation 
matrix. 

Edit the Spillover Matrix 

The NovoExpress Software has two methods for editing the spillover matrix. 
• The spillover matrix elements can be manually entered. To manually enter 

values, select the cell in the matrix to edit and directly enter the value. Values 
can range between 0 and 800 when entered manually. 

• The spillover matrix elements can be modified using the slider bar. To use the 
slider bar, select the cell in the matrix and user the slider bar to modify the 
value. Values can range between 0 and 800 when using the slider bar. 

 

Additional options in the Matrix Window: 
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• Preview:  

If the Preview box is checked, the plots will be continually updated in real time 
without exiting out of the matrix window as adjustments are made to the 
compensation and spillover matrices. 

• Clear:  

Click the Clear button to reset the compensation and spillover matrices. The 
matrix elements will be reset to zero. 

• Restore:  

Click the Restore button to restore the matrix to the last saved matrix. 

Quick Compensation Adjustment 

The NovoExpress Software’s quick compensation method gives users the option 
to use a slider bar for quick and intuitive adjustment of fluorescence 
compensation. 

Open the Quick Compensation Adjustment 

From the Home tab of the Menu Bar, click the Quick Compensation button  . 
Scrollbars appear on any two parameters plots with fluorescent parameters 
opened on the workspace. Quickly adjust compensation by adjusting the scrollbar. 

 

To hide the quick compensation scrollbars, click again on the Quick 
Compensation button. 

Use the Quick Compensation Adjustment 

To use the quick compensation: 
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1 For a single-stained sample, create a density plot. Set the X-axis parameter as 
the sample’s single-stained fluorophore channel. Set the Y-axis as the spillover 
channel to correct. For example, to correct for the spillover of FITC-H into PE-
H, analyze a sample stained only with FITC and use a plot with the X-axis set 
to FITC-H and the Y-axis set to PE-H. 

2 Create a quadrant gate to gate the positive and negative populations as shown 
below. 

 

3 Drag the vertical scrollbar to adjust compensation. When the Y-axis parameter 
mean or median in the positive and negative populations are approximately 
equal, the sample is properly compensated. 



Data Analysis 

 Software Guide 181 

 
 
 

NOTE Clicking on the blank area of the scrollbar adjusts the compensation by 0.1% 
increments, and clicking on the arrows of the scrollbar adjusts the compensation 
by 0.01% increments. 

 
 

NOTE When using quick compensation on bi-exponential plots, the display may be slow to 
update. 

 
 

Cell Cycle Analysis 

The NovoExpress Software includes a cell cycle analysis feature that allows for the 
quantification of cells in each phase of the cell cycle based on DNA content. 

Automated Cell Cycle Analysis 

• Gating Single Cell Population 
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After collecting the DNA stained cells, use a FSC-H /SSC-H density plot to get 
the target population and exclude cell debris. From the target population, 
create a Height versus Area density plot on the fluorescent channel 
corresponding to the DNA stain, and gate for the single cell population and 
exclude cell aggregates. This is shown in the figure below. 

 

• Cell Cycle Analysis 

Click on the Cell Cycle Plot button in the Workspace Toolbar to create a cell 
cycle plot. Set the X-axis of the plot to a channel for the DNA content stain, 
such as PI-A. Apply the previously created single cell gate to the plot and make 
sure all events inside the single cell gate is on plot scale. The software 
automatically attempts to fit the data and if successful, the results are 
calculated. To display the statistics, right click on the resulting cell cycle 
histogram and select Show Fitting Result. 

 

• Fitting results: 
 

Item Description 
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Watson The model used for cell cycle fitting 

RMS The root mean square error of the fit of the G1, S, and G2 phases. A smaller value 
indicates a better fit. 

Freq G1 Percentage in G1 phase 

Freq S Percentage in S phase 

Freq G2 Percentage in G2 phase 

Mean G1 The mean fluorescence intensity of the G1 phase 

Mean G2 The mean fluorescence intensity of the G2 phase 

G2/G1 The ratio comparing the mean fluorescence intensity of the G1 to G2 phase 

CV G1 The coefficient of variation of the G1 phase 

CV G2 The coefficient of variation of the G2 phase 

Freq Sub-
G1 

Percentage in Sub-G1 

Freq Super-
G2 

Percentage in Super-G2 

Manual Cell Cycle Analysis 

In some cases, the automatic fitting is not successful or additional constraints 
need to be applied to increase the accuracy of the fitting. 
• Constrain G1 and G2 peaks 

To modify the G1 or G2 peaks, click on the peak. Black boxes appear on the 
left, center, and right of the peak. Dragging the boxes adjusts the mean and CV 
used in the fitting. After the modification, the cell-cycle results update 
automatically. 
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• Cell Cycle Setting Window 

Right-click on the cell cycle plot and select Cell Cycle Setting to open the Cell 
Cycle Setting window. 

 

In the Cell Cycle Setting window, there are two mathematical models can be 
selected, the Watson model and the Dean-Jett-Fox model. For Dean-Jett-Fox 
model, the S Phase Shape can be fitted with three options: Rectangle, 
Trapezoid, and Polynomial. Normally, select Rectangle if the S phase looks 
relatively flat, select Trapezoid if the S phase is inclined, and select Polynomial 
if the S phase presents the middle low and the sides are high. When analyzing 
the experimental data for cell cycle S phase synchronization, Synchronous S 
Phase should be enabled. Constraints on the fitting can be applied including 
the mean of G1 and G2 peaks, the CV of G1 and G2 peaks, and the ratio 
between the mean of G1 and G2 peaks. In addition, the color of the fitting 
curves can be set for better visualization of the fitting results. 
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Cell Proliferation Analysis 

Automated Cell Proliferation Analysis 

• Gating Target Cell Population 

On the density plot of FSC-H/SSC-H, create a gate which includes the target 
cell population you are interested in, for example P1 as show below. 
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• Cell Proliferation Analysis 

Click on the Cell Proliferation Plot icon in the Workspace Toolbar to create a 
cell Proliferation plot. Set the X-axis of the plot to a detection channel that 
relates to the proliferation staining dye, such as CFSE-H. Apply the previously 
created cell gate to the plot and make sure all the events inside this gate is 
within the plot scale. The software automatically attempts to fit the data using 
the modeling algorithm and calculates the results. To display the statistics, 
right click the resulting cell proliferation histogram and select Show Fitting 
Result. 

 

Item Description 

 

Model The name of model used for analysis and generates results, including Standard and 
Floating models.  

RMS Root Mean Square error. It is an estimate of the “goodness of fit” of the model. 
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Peaks The count of Peaks. 

Peak Log CV Log CV of peak 

Peak Ratio The average ratio of all the peak positions. 

 
where 𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑖𝑖 is the mean of the peak of 𝑖𝑖𝑡𝑡ℎ generation, n is the count of peaks 
include the parent peak. 

Freq Divided The percentage of the original cells that are divided. 

 
where i=0 means the original generation. 

Prol. Index Proliferation Index. It is the sum of the number of divisions in each generation 
divided by the number of original cells that are divided. 

 

Exp. Index Expansion Index. It is the number of cells divided by the number of original cells. 

 

Div. Index Division Index. It is the sum of the number of divisions in each generation divided by 
the number of original cells. 

 

Rep. Index Replication Index. It is the number of non-original cells divided by the number of 
original cells that divided. 

 

Reduced Chi-
Square 

Reduced Chi-Square equals the Chi-Square value divided by the free degree. It is an 
estimate of the “goodness of fit” of the model. 

Freq Gi The percentage of the 𝑖𝑖𝑡𝑡ℎ generation. It equals the number of cells of 𝑖𝑖𝑡𝑡ℎ generation 
divided by the number of cells. 

Mean Gi The mean of the peak of the 𝑖𝑖𝑡𝑡ℎ generation. 
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Cell Proliferation Setting 

You can select model to fit the data, format to display the results, and set 
constraints for analyzing cell proliferation data. On a generated Cell Proliferation 
analysis plot, right click and select Cell Proliferation Setting to open the Cell 
Proliferation Setting window as shown below.  
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• Select Cell Proliferation Model 

The default cell proliferation model is Standard model, which is suitable for the 
case that there are overlaps between peaks of generations. The peak ratios 
between generations are the same. Floating model is only suitable for the case 
that peaks of generations are distinct, and almost no overlap between them. 
The peak ratios between generations are distinct. 

• Format the Modeling Display Results 

Select Draw Model Sum, Draw Components, and Fill Components to format 
the cell proliferation modeling results displayed on the plot. Select Show 
Fitting Results to enable the statistical results shown on the plot.  

• Set Cell Proliferation Constraints 

In the Cell Proliferation Setting window, Constraints on the fitting can be 
applied including Peak Count, Peak Ratio, Peak Log CV, and mean value of the 
parent peak. 
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Statistical Tables 

The statistical tables provide a summary from multiple samples, gates, and 
parameters enabling batch analysis and data comparison. For data generated 
using NovoSampler (or NovoSampler Pro), additional columns including Plate 
ID,Well ID and Plate Description are available. For data generated using 
NovoSampler Q, additional columns including Plate ID, Well ID, Plate Barcode and 
Plate Description are available. 

Many of the features of the statistical table can be accessed through the toolbar in 
the Statistical Table window. 

 
 

Icon Description 

 
Sets the type of statistical table 

 
Adds a column to the table  

 
Edits a column 

 
Duplicates columns  

 
Deletes columns 

 
Hides columns  

 
Selects columns to show 

 
Selects samples to show  

 
Deletes rows  

 
Exports table as a CSV file 

 
Opens the Options > Statistical Table window 
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Create Different Types of Statistical Tables 

Use the following method to create and format a new statistical table. 
• Creating a New Statistical Table 

In the Experiment Manager panel, under the experiment file name, right-click 
on the Tables node and select Create. A new table is created. 

  

Alternatively, click on the Statistical Table button  in the Home tab of the 
Menu Bar. This also creates a new statistical table. 

The new statistical table will contain Specimen ID, Specimen, Sample, and 
Run Time columns, and lists all of the samples in the experiment file. 

 

• Creating a New Statistical Table from Template 

In the Experiment Manager panel, under the experiment filename, right-click 
on the Tables node and select New from Template, a new table is created. 

• Selecting the Type of Statistical Table 

There are five types of statistical tables to choose from: Default Type, a table 
With Gate as Column, a table With Cell Cycle Analysis Results as Column, a 
table With Cell Proliferation Analysis Results as Column, and a table With 
Specimen as Column.  

New tables are created as The Default Type. To change the table type, click 
the Table Type button  from the toolbar and select the new table type from 
the drop-down menu. 



Data Analysis 

 Software Guide 193 

 

Shown below is an example for a table With Gate as Column. 

 

Shown below is an example for a table With Cell Cycle Analysis Results as 
Column. 

 

Shown below is an example for a table With Cell Proliferation Analysis 
Results as Column. 
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Shown below is an example for a table With Specimen as Column. Each 
specimen takes up one row in the table. 

 

• Add columns and rows to the table and close the window. 
• Rename the statistical table by selecting it from the Experiment Manager 

panel. Right-click and select Rename to rename the table. 
 
 

NOTE If columns or rows are not added to the table before closing the window, the table 
will not be saved. 

 

Statistical Table Columns 

Two types of columns can be added to the statistical table. These include 
statistical columns and formula columns. Formula columns are new parameters 
based on statistical parameters and user-defined formulas. 

After columns are created, they can be edited, deleted, duplicated, hidden, moved, 
and sorted. 

Add and Edit Columns 
• Drag and Drop to Add Columns 

For the Default statistical table type, dragging and dropping a gate into the 
statistical table creates a percent population column for the gate. For this 
method, select a gate from a plot in the Workspace and drag and drop it into 
the statistical table window. A percent population column is created. Gates 
can also be selected from the Experiment Manager panel and dragged and 
dropped into the statistical table window to create the percent population 
column.  

• Add Column Window 

Click on the Add Column button in the toolbar. The Add Column window will 
appear. Select the statistical value, the gate, and the parameter. Click the Add 
button to add the column to the table. 
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NOTE To add multiple items from each column, highlight the items to be added while 
holding the Ctrl or Shift key. Click Add to add the selected items to the table. 

 
 

NOTE For a table With Specimen as Column, the Sample Name should be specified when 
adding columns. If selecting “All” in the sample list box, the statistical results will be 
the average of all samples in each specimen. For Abs. Count calculation, if Abs. 
Count Unit defined for samples in the specimen is different, the Abs. Count result 
will be empty. 

 
 

NOTE To calculate the Stain Index, you need to select two gates. The gate with smaller 
MFI will be used as negative population gate while the gate with larger MFI is used 
as positive population gate. Refer to Calculation of Statistics for detailed 
description of Stain Index. 
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NOTE To add Percentile statistics, click on Percentile, enter the Percentile value in the 
Add Percentile window, such as 10 for calculating the 10th percentile. Then click 
OK and10th Percentile item will be added in the statistics column. 

 

 
 
 
 

• Edit a Column 

Select the column in the statistical table window and click the Edit Column 
button  , in the toolbar. The Edit Column window opens. Select the 
modifications and click OK to edit the column. 

By default, the column name is automatically generated. The name can be 
modified by the Column Name box at the top of the Edit Column window. 
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Formula Columns 

In the Add Column and the Edit Column windows, click the Formula tab to enter a 
user-defined formula. The formula can be defined using existing column values 
and basic arithmetic operations. Click Add or OK to define the formula and create 
a new column. User can select Number, Percentage or Text in the drop down 
menu of Format, select the Decimal Places and check Use Thousands Separator 
to add thousands separator to the formula.  When Percentage is selected, user 
cannot check Use Thousands Separator box (i.e. greyed out). When Text is 
selected, user cannot select the Decimal Places and check Use Thousands 
Separator box. 

 
 

NOTE If the formula is displayed in red, there is an error in the equation. 
 

 

Select Multiple Columns 

In the header row of the table, click and drag in the top half of the cell to select 
multiple columns. 

 
 

NOTE Click and drag in the lower half of the cell to move the column. 
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Duplicate Columns 

Select the column, and click the Duplicate Column button  , in the toolbar to 
duplicate the selected column. 

Delete Columns 

Select the column, and click the Delete Column button  , in the toolbar to delete 
the selected column. 

Show and hide Columns 

Select the column, and click the Hide Column button  , in the toolbar to hide the 
selected column. 

To show the column again, click the Show Columns button  , and select the 
column to show from the drop-down menu. 

Move Columns 

In the header row of the table, click and drag in the lower half of the cell to move 
columns. 

 
 

NOTE Click and drag in the upper half of the cell to select multiple columns. 
 

Sort by Columns 

In the header row of the table, double-click on a column header. The rows of the 
table are sorted in ascending order based on the selected column. Double-click on 
the header again to sort in descending order. 

Statistical Table Rows 

In the statistical table, the rows list separate populations for analysis. 

Add Rows 
• Filter Rows Window 

In the toolbar, click the Filter Rows button  . The Filter Rows window will 
appear. Check the boxes to be used as rows to the table. Unchecked boxes 
will be excluded from the table. Click OK to recreate or delete the rows in the 
table. 
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If Automatically check new samples is selected, the samples created later will 
be added into the statistical table automatically. For with Specimen as 
Column statistical table type, if Automatically check new specimens is 
selected, the specimens created later will be added into the statistical table 
automatically. 

• Drag and Drop to Add Rows 

Drag and drop a sample, a specimen, or a group from the Experiment 
Manager panel into the statistical table window can create new rows for each 
added sample.  

For the With Gate as Column statistical table type, drag and drop a gate from 
the Experiment Manager panel or plot in the workspace into the statistical 
table window to create rows for the selected gate. If multiple samples contain 
a gate with the same name as the dropped gate, a row is created in the table 
for each of those samples’ gates. 

For the With Cell Cycle Analysis Results as Columns statistical table type, 
drag and drop a cell cycle analysis plot from the Experiment Manager panel or 
workspace into the statistical table window to create a row for the sample. If 
multiple samples have a cell cycle analysis plot with the same name, a row is 
added to the table for each of those samples. 
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Select Multiple Rows 

Click and drag in the column to the left of the Sample row to select multiple rows. 
Alternatively, hold down Ctrl and click in the column to the left to the Sample row 
to select multiple noncontiguous rows. 

Delete Row 

Select the row, and click the Delete Rows button  , in the toolbar to delete the 
selected row. Alternatively, select the row and press the keyboard Delete key. 

Statistical Tables Export or Copy Text 

Statistical table results can be exported to CSV file or copied to clipboard as text. 

Export Statistical Tables as CSV File 

In the Sample tab toolbar, click the Export CSV File button . Enter the file path 
and click Save to export the file. 

Copy Statistical Table as Text to the Clipboard 

Select the cells to be copied by clicking and dragging with the mouse, or select all 
using the keyboard shortcut Ctrl A. Use the keyboard shortcut Ctrl C to copy the 
selected cells to the clipboard. The copied table can be pasted to a program, such 
as Microsoft Excel, for further analysis. 

Statistical Table Options 

In the toolbar, click the Statistical Table Options button  to open the Statistical 
Table tab of Options window, set Customize Name and Default Visibility of 
Specimen, Specimen ID, Case Number, Sample, Sample ID, Operator, Run Time 
and Gate columns. 
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Statistical Table Management 

Statistical tables can be managed in the Experiment Manager panel under the 
Tables node. 
• Copy and Paste Statistical Tables 

In the Experiment Manager panel, dragging a statistical table and dropping it 
into the Tables node will create a new table with identical information. 
Alternatively, a statistical table can be copied and then pasted into the Tables 
node to also create a new table with identical information.  

• Delete Statistical Tables 

In the Experiment Manager panel, select the table. Right-click and select 
Delete to delete the table. Alternatively, select the table and press the Delete 
key on the keyboard. 

• Rename Statistical Tables 

In the Experiment Manager panel, select the table. Right-click and select 
Rename. Enter the new name to rename the table. 
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• Export Statistical Table as Template 

In the Experiment Manager panel, select the table. Right-click and select 
Export Template... Enter the name for the template in the prompted window 
and click Save to create a template. The template will be saved as a *.nst file.  

Heat Maps 

The heat map can be used to visualize the data in a well plate format. It uses 
different color to display the result of a specified statistical parameter. The color is 
determined by the color scale set for the statistical parameter to be analyzed. 
Multiple heat maps can be opened at the same time, and one heat map supports 
up to four statistical items. 

Create a New Heat Map 

In the Experiment Manager panel, under the experiment file name, right-click on 
the Heat Maps node and select Create.  

 

Alternatively, click on the Heat Map icon  in the Home tab of the Menu Bar. The 
Heat Map window will show up.  

Heat Map Window 

The heat map window contains heat map and legends. The well plate ID, plate 
type, and whether to show the sample name and statistics can be changed, and 
the heat map statistics can be edited. In addition, the heat map and legend can be 
copied and saved as image (i.e. PNG, JPEG, BMP, GIF, TIFF, or EMF) or a CSV file. 
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NOTE If there are multiple samples in the same well, only the first sample will be used to 
generate the heat map. 

 
 

NOTE If there are samples outside the current plate type, “*” will be displayed in the upper 
left corner of the heat map. 

 
 

Heat Map Grid 

A heat map can be generated for up to four statistic parameters. Each parameter 
will be displayed in a heat map with a corresponding section as illustrated below, 
based on the number of parameters to be displayed together. 
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Heat Map for Multiple Statistics 

The following figure shows a heat map with two statistics. 

 
 
 

NOTE The gate, color scale, and color scale range of each statistic parameter can be set 
separately. 

 

Add Statistics 
• Drag and Drop to Add Statistic Parameter 

Directly dragging and dropping a gate into the heat map will add the Count 
parameter from the selected into the heat map. To do so, select a gate from a 
plot in the Workspace, drag and drop it into the created heat map. If there is no 
statistic parameter defined in the heat map, this action will add the Count 
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statistics of the selected into the heat map. Otherwise, the current statistic 
parameter will be replaced by the Count statistics of the selected gate. To add 
the Count of a gate as a new statistic parameter, press the Ctrl key while drag 
and drop a gate. You can also select the gate from the Experiment Manager 
panel and drag and drop it into the heat map to add Count statistics of the 
gate.  

Edit Heat Map Statistics Window 

You can add, edit, and remove statistics in Edit Heat Map Statistics window. To do 
so, click the Edit Statistics… button in the heat map. The Edit Heat Map Statistics 
window will appear.  
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• Add: Click to add a new statistic to the list. Up to 4 statistics parameters can 
be added into the list. 

• Remove: Click to delete the selected statistics parameter. 
• Type: Select Basic, Cell Cycle, or Cell Proliferation to be displayed in the heat 

map from the drop down list. 
 

NOTE User can select Cell Cycle or Cell Proliferation only when associated analysis 
results are included for selected sample. 

• Statistics: Select the statistics type to be displayed in the heat map from the 
drop down list. 

• Gate: Select the gate whose associated statistics is displayed in the heat map 
from the drop down list. 

• Parameter: Select the parameter to be displayed in the heat map from the 
drop down list. 

• Plot: Select the plot to be displayed in the heat map from the drop down list. 
This option is available only when Cell Cycle or Cell Proliferation is selected in 
the drop down list of Type. 

• Select color scale and range: There are two color scale displaying patterns you 
can choose for each statistic in the heat map, Threshold mode and Gradient 
mode.  
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Threshold pattern defines the statistics parameter with two colors, depending 
on if the result is larger or smaller than the defined threshold. Select different 
color scheme from the drop-down list in the Threshold option and enter the 
Threshold into the text box below.  

Gradient pattern shows the statistics parameter in a color gradient. Select 
different color scheme from the drop-down list in the Gradient option. The 
scale of the statistics parameter can be defined as Auto Range (software 
identifies the minimum and maximum value and calculate the range 
automatically) or you can manually define the range by entering the minimum 
value in the Min. text box and the maximum value in the Max. text box.  

Update Heat Map 

When the statistics of a sample are changed in value or in scale, the heat map will 
be automatically updated in real time. 

Save Heat Map 

The heat map and legend can be saved as image or a CSV file. 
• Select Image or CSV File from the drop down menu of Save As.  
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• Select the target folder, and enter the file name, click Save. The currently 
displayed heat map will be saved in designated folder as an image file (i.e. 
PNG, JPEG, BMP, GIF, TIFF, or EMF) or a CSV file. The default prefix of the 
saved file is in the format of Experiment File Name_Heat Map Name. For 
example, if the experiment file name is 190417_1507.ncf,  and name of the 
current heat map is HM20201012, the prefix of the saved file will be 
190417_1507_ HM20201012.  
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Copy Heat Map 

The heat map and statistics result can be copied to clipboard. To do this,  select 
Image or Statistics from the drop down menu of Copy. The currently displayed 
heat map or statistics will be copied to clipboard. User can paste it to a third party 
editing software (e.g. Microsoft Excel) for further analysis. 

 

Heat Maps Management 

Heat maps can be managed in the Experiment Manager panel under the Heat 
Maps node. 
• Copy and Paste Heat Map 

In the Experiment Manager panel, drag a heat map and drop it into the Heat 
Maps node will create a new heat map identical to the original one. 
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Alternatively, a heat map can be copied and then pasted into the Heat Maps 
node to create a new heat map identical to the original one.  

• Duplicate Heat Map 

In the Experiment Manager panel, select a heat map. Right-click and select 
Duplicate to create a new heat map identical to the original one.  

• Delete Heat Map 

In the Experiment Manager panel, select a heat map. Right-click and select 
Delete to delete the selected heat map. Alternatively, select the heat map and 
press the Delete key on the keyboard. 

• Rename Heat Map 

In the Experiment Manager panel, select a heat map. Right-click and select 
Rename. Enter the new name to rename the heat map. 

Post Gain 

In certain situations, user may want to align a particular peak on different samples 
on the same plot. Post Gain function in NovoExpress software allows such 
adjustment to be done after data acquisition.  

 
 

NOTE Post Gain does not affect data acquisition. The threshold value entered in the 
Cytometer Setting panel is based on event data value before Post Gain. 

 
 
 

NOTE Only accounts with the Post Gain Adjustment privilege can adjust Post Gain. 
 

Adjust Post Gain 

You can adjust the post gain value for each parameter of a sample. 

First create a histogram of the desired parameter and click Adjust Post Gain 
button  , on the workspace toolbar. Move mouse to the histogram plot area, hold 
down the left button of the mouse and drag the histogram curve, then drag and 
drop the peak of interest to the target location. In the example below the left plot is 
prior to the post gain adjustment and the right plot is after the post gain 
adjustment. 
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If you want to align peaks of different samples, first create a histogram plot of the 
parameter with multiple overlays of these samples. Set the style of the histogram 
plot as offset, and then use the mouse to drag each histogram curve to align them. 
In the examples below the left plot is prior to alignment and the right plot after 
alignment using the post gain function. 
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After a parameter is set using post gain, a * mark will be shown with parameter 
name in the statistics information of a plot or in the analysis table, and the value of 
any statistics with post gain will be shown with a * mark. 

 
 

NOTE Post gain will have no effect on the calculation of compensation, such that, 
compensated data will be calculated from the original data first, and the post gain 
will then be applied to the data. Control samples in an auto compensation 
specimen cannot be set using post gain. 

 

Clear Post Gain 

If you want to clear the post gain of a parameter, on area of axis parameter of any 
plot which contains the parameter, click the Clear Post Gain in the shortcut menu. 
If the menu item is not in the menu, it means that no post gain is set to the 
parameter. 

 

If you want to clear post gain of all parameters of a sample, click Clear Post Gain 
menu under the main menu Sample, the post gain of active sample will be clear. If 
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the menu item is gray, it means that no post gain is set to the parameters of the 
active sample. 

Apply Post Gain 

When pasting an Analysis node of a sample to other sample on the experiment 
management tree, post gain will be pasted to the target sample too. 

When exporting a sample to a .nct template file in the experiment management 
tree, post gain is contained in that template file too. When importing a template file 
to an Analysis node of a sample, post gain will also be imported and applied to the 
target sample. 

Export Post Gained Data 

In Export Events dialog, check the Post Gain option to enable exporting post 
gained data to FCS or CSV file. If the Post Gain option is unchecked, data without 
post gain will be exported. 

 

If Post Gain option is checked, the sample data exported to FCS file are post 
gained data, and if there is compensation matrix in the sample, the data are first 
compensated and then post gained. If the FCS file is again imported in 
NovoExpress, post gain can be readjusted or cleared, as well as the compensation 
matrix. If the FCS file is imported into a third party software, the third party 
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software will treat the data like an original data, and does not know about the 
original compensation matrix and Post Gain information. 

 
 

NOTE When export post gained data to CSV file, the name of parameters with post gain 
will be followed with a * mark. 
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6 Plate Manager 

This chapter provides the information for the Plate Manager panel, including 
overview of Plate Manager panel and context menu. 

Overview of Plate Manager Panel 

The Plate Manager panel will only be available when the NovoSampler (or 
NovoSampler Pro or NovoSampler Q) is installed or the NovoSampler (or 
NovoSampler Pro or NovoSampler Q) installed checkbox is checked in the 
Instrument Configuration window in the NovoExpress software offline mode. This 
management tool provides users with an intuitive and convenient way to manage 
samples on a multi-well plate or tube rack. The Plate Manager also allows user to 
set up the working mode, plate type, mixing and rinsing conditions.  

 

When NovoSampler is connected 



Plate Manager 
 
 

216   Software Guide 

 

When NovoSampler Pro is connected 

 

When NovoSampler Q is connected 
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Icon  Description  

 

The Plate Manager panel displays a 16 x 24 grid indicating a 384-
well plate map (for NovoSampler Q only) and an 8 x 12 grid 
indicating a 96-well plate map. In settings for a 24 or 40 tube-rack 
or a plate type other than 384-well and 96-well plate, an 8 x12 grid 
will be displayed while invalid wells will be grayed out. 
In one plate, multiple samples can be set with the same Well ID. In 
the grid, one well will show one sample at one time. The currently 
visible sample in a well is defined as selected sample of a well. 
The state of each well can be: 
•   This icon indicates that this well is selected. Multiple wells 

can be selected at the same time. 
•   The number is the Specimen ID and indicates to which 

specimen the selected sample belongs to. 

•    An underlined number indicates that the selected sample 
has acquired data. 

•   The arrow in the upper right corner indicates that the well 
has multiple samples. Context menu of the well will list all 
samples.  

•   The italicized number indicates the acquisition sequence of 
the selected sample. 

•   A red background indicates the well contains the Active 
Sample.  

•   A green background indicates that the well contains 
sample in queue to be collected. 

•  /   An alternating green and dark green background 
indicate that the well contains sample currently in acquisition. 

•  /   An alternating green and red background indicate that 
the well contains sample currently in acquisition and also is the 
Active Sample. 

The following operations can be operated on the plate grid: 
• Click: Click the header of a row or a column to select the entire 

row or column. Click the top left corner cell selects all wells in 
the plate. 

• Right-click: Displays context menu. 
• Double-click: Set selected sample to be the Active Sample. 
• Drag: Drag to select multiple wells in a rectangular range. 
• Ctrl + Click: Hold Ctrl to select multiple individual wells. 
• Shift + Click: Hold Shift to select consecutive wells between two 

wells. 

 Work List: View and edit Work List. 

 Samples Created Order: Selects whether to automatically proceed 
horizontally across the plate or vertically across the plate when 
creating new samples. 



Plate Manager 
 
 

218   Software Guide 

 

New Sample(s) on Selected Well(s): Creates new samples on the 
selected wells. The created samples will have the same template 
as the Active Sample with the same compensation matrix, report, 
data analysis, and Cytometer Setting. The samples will be created 
in the specimen with name specified in Specimen Name box. If 
specified specimen name is empty or does not exist, a new 
specimen will be created. The created sample name will use the 
name specified in the Sample Name box as a prefix. If the sample 
name box is empty, the default sample name prefix (sample 1, 
sample 2 …) will be used.  
Without Template: Creates new samples on the selected wells 
without template applied. The compensation matrix, report, and 
data analysis template will be empty. But the cytometer setting will 
be the same as the current cytometer setting in the Cytometer 
Setting panel. 

 Delete Sample(s) on Selected Well(s): Deletes the selected 
samples from the selected wells. If one well has multiple samples 
defined, only the selected sample will be deleted. 

 Copy Sample(s) on Selected Well(s): Copies templates of selected 
samples from the selected wells. If no sample has defined in the 
selected wells, this function is disabled. If part of selected wells has 
samples defined, only the wells which have sample defined will be 
copied. 

 Paste Sample(s) on Selected Well(s): Pastes sample template or 
sample events to the selected wells according to copied content. 
• If all the selected wells have samples defined, then it applies 

templates of the copied samples to the selected samples of 
selected wells one by one repeatedly. 

• If all the selected wells have no samples defined, then it creates 
samples with the same templates as copied samples on the 
selected wells. The samples will be created in the specimen 
with the name specified in Specimen Name box.  

• If part of the selected wells has samples defined and the rest 
part have no samples defined, or the selected samples of the 
selected wells are in different specimen, this tool will be 
disabled. 

• If Copy Events is selected from context menu of a well, this tool 
will be available when only one well is selected and the selected 
sample of the selected well contains no events. 

 

Duplicate Sample(s) on Selected Well(s): Creates new samples on 
empty wells, duplicating the template of the selected samples of 
the selected wells. 
• If part of the selected wells has samples defined and the rest 

part have no samples defined, or the selected samples of the 
selected wells are in different specimen, this tool will be 
disabled. 

• If the specimen contains more than one sample, and all the 
samples are selected, clicking this icon will create duplicated 
samples under a newly created specimen. 
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New Plate: Creates new plate and specimen, and creates new 
samples in the new specimen, duplicating the template of the 
selected samples of the selected wells. The new samples have the 
same well ID with the selected wells. 

 Show Run Order: When selected, a blue outline shows on the icon 
. The sample acquisition sequence will be shown in the plate 

view. 

 Mode: Allows user to select the working mode (Standard, High- 
Throughput and Custom) of the NovoSampler (or NovoSampler Pro 
or NovoSampler Q) in this area. Default mixing condition, rinse 
condition, stop condition and flow rate will be automatically applied 
when Standard or HT mode is selected. Please refer to associated 
operator's guide for more details. User can only customize these 
settings when Custom mode is selected.  

NOTE  Selecting the working mode is only available before the 
sample is created. 

 

 
This area is designed to input plate information. The left drop-down 
box is the Plate ID. The Plate ID is a positive integer and can be 
modified by highlighting the area and entering a new number.  
The middle drop-down box is the Plate Type. The drop-down box 
lists all the available plate type defined in the Manage Plate Types 
window. Pull down the list and select the corresponding plate type 
for the experiment. The right box is the Plate Name. Input plate 
name in this box to help identify the plate.  

NOTE  The plate type cannot be modified once the sample 
acquisition has begun. 

 

NOTE  When NovoSampler Q is connected and the barcode 
reading function is enabled, user can view the scanned 
barcode information from the row below this area (see 
example below). Please refer to NovoSampler Q 
Operator's Guide for more details. 
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This area is designed to input the specimen and sample 
information. The left drop-down box is the Specimen ID and 
Specimen Name, separated by a colon. The right box is the Sample 
Name.  
When creating new samples, the samples will be created in a 
specimen with specimen name specified in the Specimen Name 
box. If the Specimen Name box is empty or does not exist, a new 
specimen will be created. The default new specimen name is 
Specimen1, Specimen2…. The default sample name is Sample1, 
Sample2 …. 

 This function is available only when NovoSampler Q is connected. 
With Absolute Count is selected, user can analyze the exact 
number of cells or particles per unit volume. This function is 
disabled by default when NovoSampler Q works in Standard or 
High-Throughput (HT) mode. When Custom mode is selected, user 
can select to disable or enable this function.   

 This function is available only when NovoSampler Q is connected. 
With Recover Remaining Samples selected, user can recover the 
remaining sample aspirated into the sampling tube back to the 
sample tube or plate well after sample acquisition. This function is 
disabled by default when Standard or High-Throughput (HT) are 
selected. When Custom mode is selected, user can select to 
disable or enable this function. 

NOTE  The Recover Remaining Samples function is disabled 
by default. To enable this function, user need to check 
the check box in the front. 

 

NOTE  Any changes to this setting (i.e. disable or enable) 
during the sample collection will only be effective from 
the next well forward.   

 

Barcode 
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Mix: Sets the mixing conditions. Mix can be set for None (no 
mixing), 1 Cycle, 2 Cycles, 3 Cycles for every defined number of 
wells or every defined number of minutes.  

NOTE  Default mixing conditions (i.e. Mix 1 Cycle Every 1 Well) 
will be automatically applied and cannot be modified 
by user when Standard or HT mode is selected. 

 

 
Rinse: Sets the rinse cycle to clean the sample injection probe. 
Rinse can be set for None (no rinse), 1 Cycle, 2 Cycles, 3 Cycles for 
every defined number of wells. 

NOTE  There is always one rinse cycle at the end of each plate 
run even the Rinse setting is set to None. 

 

NOTE  Default rinse conditions (i.e. Rinse 1 Cycle Every 1 Well 
when Standard mode is selected, or None when HT 
mode is selected) will be automatically applied and 
cannot be modified by user when Standard or HT 
mode is selected. 

 

 

Mixing Parameters: This panel is available only when NovoSampler 
Pro or NovoSampler Q is connected. User can view or set the 
mixing parameters for the orbital shaker in this panel. When 
NovoSampler Pro or Q works in Custom mode, these mixing 
parameters for each plate type are defined in the Manage Plate 
Type window and can be modified in this area for the current 
experiment. When NovoSampler Pro or NovoSampler Q works in 
Standard or HT mode, default mixing parameters will be 
automatically applied and cannot be modified by user.  
 
Speed: The mix speed of the orbital shaker. Please refer to table 
below for the default mix speed when NovoSampler Pro or 
NovoSampler Q works in different mode. 
 
 Plate Type Default Mix Speed (rpm)             
  Standard 

 Mode 
HT  
Mode 

Custom  
Mode 

NovoSampler 
Pro 

96 well plate (U, V and 
Flat bottom) 

1500 1500 1500 

24 well plate 2500 2500 2500 
24 tube rack 1500 1500 1500 
48 well plate 1500 1500 1500 

NovoSampler 
Q 

96 well plate (U, V and 
Flat bottom) 

1500 1500 1500 

24 well plate 2500 2500 2500 
48 well plate 1500 1500 1500 
40 tube rack 1000 1000 1000 
384 well plate 2500 2500 2500 
24 tube cooling rack 1000 1000 1000 
96 well plate (U, V and 
Flat bottom) with 
cooling box 

1500 1500 1500 
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Acceleration: The acceleration time for the orbital shaker to reach 
the specified Mix Speed. By default, the mix acceleration is set  to 0  
second for NovoSampler Pro, and  1 second for NovoSampler Q. 
Duration: The mixing time for the orbital shaker to mix the sample 
in one cycle. Please refer to table below for the default mix duration 
when NovoSampler Pro and NovoSampler Q works in different 
mode. 
 
 Plate Type Default Mix Duration (s) 

Standard 
Mode 

HT 
Mode 

Custom 
Mode 

NovoSampler 
Pro 
 

96 well plate (U, V and 
Flat bottom) 

10 10 10 

24 well plate 10 10 10 
24 tube rack 10 10 10 
48 well plate 10 10 10 

NovoSampler Q 96 well plate (U, V and 
Flat bottom) 

8 3 10 

24 well plate 10 4 10 
48 well plate 10 5 10 
40 tube rack 10 5 10 
384 well plate 8 2 10 
24 tube cooling rack 10 5 10 
96 well plate (U, V and 
Flat bottom) with cooling 
box 

8 3 10 

 

Context Menu 

In addition to the Tools menu, the Plate Management panel also provides a rich 
set of context menu actions. 

Context menu when a single well is selected 

If the selected well has sample already defined, the right-click menu displays a list 
of the samples defined in the selected well and the software functions available to 
be used. This context menu is the same as the context menu by right-clicking a 
sample node in the Experiment Manager panel. From this context menu, you can 
quickly select the defined sample, open, close, delete, and create plots, copy and 
paste templates, copy and delete events, delete, rename and duplicate the sample, 
edit sample notes, import template or the data from a FCS file, or export as a 
template or the data in FCS and CSV formats, move the sample to the selected 
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specimen. For additional information regarding these functions, refer to Right-Click 
Menu in this guide. 

 

If the selected well has no sample defined, the right-click menu generally has two 
items available, New and Batch Creation of New Specimens. New will create new 
sample without a template. Batch Creation of New Specimens allows user to 
create new specimen(s) with customized specimen and sample organization. 
Refer to Context menu when multiple wells are selected for more details on this 
function. 

 

NOTE If Paste Sample Names will be available if user copied the sample name in 
previous operation. 
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Context menu when multiple wells are selected 

 

• New: Same as the New Sample(s) on Selected Well(s) tool in the toolbar. 
• Delete: Same as the Delete Sample(s) on Selected Well(s) tool in the toolbar. 
• Batch Creation of New Specimens: Create new specimen(s) with customized 

specimen and sample organization. When clicked, software will prompt 
following window. User need to define item(s) in this window, click OK to 
complete or cancel to go back to the previous window. 
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• Do not import template: Select this option if no templates need to be 
imported 

• Import sample template: Select this option if sample template needs to be 
imported for newly created samples. Click  to load the template file 
(.nct file). 

• Import specimen template: Select this option if specimen template needs 
to be imported for newly created specimens. Click  to load the 
template file (.nct file). 

• Specimen order: direction of creating the specimens for selected wells. 
For example, when A1, A2, B1, B2 are selected, and Horizontal is selected 
as the specimen order, and 2 samples per specimen is selected, software 
will automatically create two new specimens and new samples in these 
four wells. Sample A1 and A2 will be placed under the first newly created 
specimen. Sample B1 and B2 will be placed under the second newly 
created specimen. 

• Prefix of specimen name: Set the prefix for the name of the newly created 
specimen(s).  

• Prefix of sample name: Set the prefix for the name of the newly created 
sample(s). 
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• Number of samples per specimen: Set the number of newly created 
samples per each newly created specimen. 

• Delete Specimen: Delete the selected specimen and associated samples on 
selected wells. 

• Copy Template: Same as the Copy Sample(s) on Selected Well(s) tool in the 
toolbar. 

• Paste: Same as the Paste Sample(s) on Selected Well(s) tool in the toolbar. 
• Paste Sample Names: Rename samples of the selected wells with the names 

copied from a spreadsheet program like Microsoft Excel or create new 
samples with copied name on selected wells if there is no sample defined. If 
part of selected wells has samples defined and the rest part have no samples 
defined, this menu will be disabled. 

 

NOTE If you have an Excel spreadsheet defining the sample names in a plate format, use 
Paste Sample Names function from the right-click context menu to copy the 
sample name from the spreadsheet and quickly create new samples for a plate in 
NovoExpress Software. 

 
 

• Duplicate: Same as the Duplicate Sample(s) on Selected Well(s) tool in the 
toolbar. 

• Move to Specimen: Move the selected sample(s) to the selected specimen or 
new specimen. 
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7 Experiment Manager 

This chapter provides the information for the Experiment Manager function, 
including Experiment Manager Toolbar, Hierarchy, Templates, Import and Export 
Data. 

Experiment Manager Toolbar 

 
 

Icon Description 

 
Work List: View and edit the work list. Contains information on the sample names and 
collection parameters. Refer to Work List for more information.  

 
Copy the selected node.  

 
Paste the copied content.  

 
Create a copy of the currently selected sample or specimen.  

 
Expand all child nodes of the current node.  

 
Collapse all child nodes of the current node. 

Hierarchy 

Description 

In the NovoExpress Software, the hierarchy structure from high to low is groups, 
specimen, and samples. 
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In the figure above, the red arrow indicates the active sample. In the NovoExpress 
Software, the active sample collection parameters are displayed in the Cytometer 
Setting and Cytometer Control panels. In the Experiment Manager panel, double-
clicking on a sample node will make it the active sample. When switching to a new 
active sample, the Cytometer Setting and Cytometer Control panels will update 
with the new active samples’ information, and the plots in the Workspace will be 
replaced with the new active sample’s plots. 

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is connected, The 
samples listed in the Experiment Manager panel include the Well ID and the 
sample name, separated by a colon (see figure below). Click the sample node to 
select the sample, right-click and select Rename to rename the sample. When 
renaming the sample, both the Well ID and the sample name can be modified. 
Specimen is also associated with a Specimen ID. The Specimen ID is the number 
before the specimen name, separated by a colon. The Specimen ID is used to 
identify specimen and can be modified. For additional information regarding the 
Specimen ID, see Plate Manager Panel in this guide. 
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Icon Description 

 
File 

The experiment file (*.ncf file format) 

 
Heat Maps 

This node contains Heat Maps for the experiment file. Right-clicking this node 
allows for creating new heat map. 

 
Statistical tables 

This node contains statistical tables for the experiment file. Right-clicking this 
node allows for the creation of new statistical tables. 

  
Statistical table 

Statistical analysis table 

  
Group 

This node represents a Group in the organizational hierarchy. A group can 
contain multiple specimens and subgroups, and specimens will always be 
placed in front of subgroups.  

  
Specimen 

This node represents a Specimen in the organizational hierarchy. A specimen 
can contain multiple samples. Each specimen contains a specimen report. In 
the node text “1:Specimen 1”, the former number is Specimen ID, the latter text 
is Specimen Name. 
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Sample 

This node represents a Sample in the organizational hierarchy. The sample is 
the most basic organizational unit and contains sample data collection 
parameters, instrument settings, fluorescence compensation settings, reports, 
analysis, and data. The sample icon will display differently depending on the 
status of the sample. 
A blank sample without any data collected will appear as   
A sample listed for sample acquisition and during acquisition will appear as   
A sample with data collected will appear as   

  
Cytometer settings 

Cytometer settings contain the sample parameters, the acquisition stop 
conditions, and the sample flow rate and threshold settings. See Cytometer 
Setting for additional information. 

  
Fluorescence 
compensation 

Fluorescence compensation matrix for the sample. If the matrix is empty, the 
node is displayed in black. If the matrix is filled, the matrix is displayed in blue. 
See Fluorescence Compensation for additional information. 

  
Report 

Contains a report of the data analysis and is found under both specimen and 
sample nodes. 
Reports under specimen nodes can include plots and statistical analysis for all 
samples under the specimen. 
Reports under the sample nodes can include plots and statistical analysis only 
for the sample. 
See Reports for additional information. 

  
Analysis 

Analysis contains the plots and gates for a sample. Under the Analysis node, 
there are plot nodes and a logic gate node. Plot nodes are listed for individual 
plots of the sample, and each plot node contains the gates created for the plot. 
A separate logic gate node contains all of the logic gates created for the 
sample.  

Plot A plot created for the analysis of a sample  

Gate A gate created within a plot 

  
Logic gate group 

Contains all logic gates for a sample  

 
 Logic gate 

Logic gates 

  
Red arrow 

The red arrow indicates the sample is the active sample.  

 /   
Flashing green and 
dark green arrows 

Flashing green and dark green arrows indicate the sample is being collected. 
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 /   
Alternatively 
flashing red and 
green arrows 

Flashing red and green arrows indicate the active sample is being collected. 

Right-Click Menu 

From the Experiment Manager panel, right-clicking each node will bring up a menu 
of functions. The table below lists the specific functions available by right-clicking 
each node type. 

 

Icon Description 

  
File 

 

 

New Experiment: 
• New Blank Experiment: Create a blank 

experiment file. 
• New from Template: Create an experiment file 

from a template. 
• New from Experiment File: Create an 

experiment file from an existing experiment file. 
• New from JSON File: Create an experiment file 

from an existing JSON file. This option is  
available when NovoCyte Quanteon, NovoCyte 
Advanteon or NovoCyte Penteon is connected. 

New Sample: Creates a new specimen with a new 
sample included. 
New Specimen: Creates a new specimen.  
New Group: Creates a new group.  
New from Template: Imports selected group, 
specimen, and samples from a template.  
New Auto Compensation: Creates a compensation 
specimen containing samples to compute a 
compensation matrix.  
Open Plots: Opens all plots from all of the samples.  
Close Plots: Closes all plots from all of the samples. 
Paste: Creates a new specimen with the copied 
specimen template. 
Paste to All Specimens: Pastes the copied 
specimen template to all specimens. 
Paste to All Samples: Pastes the copied sample 
template to all samples. 
Import FCS Files: Selects a folder to import all FCS 
files within the folder or subfolders as samples. 
Files up to 10 subfolders deep from the selected 
folder will be added and organized according to the 
folder structure. 
Export: 
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• Export as Template: Exports the file as a 
template file. 

• Export to FCS Files: Exports all samples as FCS 
files. 

• Export to CSV Files: Exports all samples as CSV 
files.  

• Export Plots: Exports all plots from all samples 
as image files. 

Open Folder: Opens the folder containing the 
experiment file. 

 
Heat Map 

 

Create: Creates a new heat map.  
Paste: Pastes a copied heat map. 

 
Heat Map 

 

Open: Opens the selected heat map.  
Copy: Copies the selected heat map. 
Duplicate: Duplicates the selected heat map. 
Delete: Deletes the selected heat map. 
Rename: Renames the selected heat map. 

 
Statistical Tables 

 

Create: Creates a new statistical table.  
Paste: Pastes a copied statistical table. 
New from Template: Creates a new statistical table 
from an exist template. 

 
Statistical Table 

Open: Opens the selected statistical table.  
Copy: Copies the selected statistical table. 
Duplicate: Duplicates the selected statistical table. 
Delete: Deletes the selected statistical table. 
Rename: Renames the selected statistical table. 
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Group 

 

New Sample: Creates a new specimen with a new 
sample included. 
New Specimen: Creates a new specimen.  
New Group: Creates a new group.  
New from Template: Imports selected group, 
specimen, and samples from a template.  
New Auto Compensation: Creates a compensation 
specimen containing samples to compute a 
compensation matrix.  
Open Plots: Opens all plots from all of the samples 
within the group.  
Close Plots: Closes all plots from all of the samples 
within the group. 
Paste: Creates a new specimen with the copied 
specimen template. 
Paste to All Specimens: Pastes the copied 
specimen template to all specimens in the group. 
Paste to All Samples: Pastes the copied sample 
template to all samples in the group.  
Delete: Deletes the group.  
Rename: Renames the group.  
Import FCS Files: Selects a folder to import all FCS 
files within the folder or subfolders as samples. 
Files up to 10 subfolders deep from the selected 
folder will be added and organized according to the 
folder structure. 
Export: 
• Export as Template: Exports the group as a 

template file. 
• Export to FCS Files: Exports all samples as FCS 

files. 
• Export to CSV Files: Exports all samples as CSV 

files. 
• Export Plots: Exports all plots in current group 

as image files. 

 
Specimen 

New Sample: Creates a new sample in the 
specimen.  
New Sample from Template: Imports the samples 
of the first specimen from a selected template.  
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Open Plots: Opens all plots from all of the samples 
within the specimen.  
Close Plots: Closes all plots from all of the samples 
within the specimen. 
Copy: Copies the template of the specimen. 
Paste: Pastes the template of a copied specimen, or 
creates a new sample with the copied sample 
template.  
Paste to All Samples: Pastes the copied sample 
template to all samples in the specimen. 
Duplicate: Creates a duplicate of the specimen. 
Delete: Deletes the specimen.  
Rename: Renames the specimen.  
Import: 
• Import Template: Imports template and apply to 

the selected specimen. 
• Import FCS Files: Selects one or more FCS files 

imported as samples. 
Export: 
• Export as Template: Exports the specimen as a 

template file. 
• Export to FCS Files: Exports all samples as FCS 

files. 
• Export to CSV Files: Exports all samples as CSV 

files. 
• Export Plots: Exports all plots in current 

specimen as image files. 
Move to Group: Move the specimen to the existing 
group or new group. 

   
Sample 

Open Plots: Opens all plots from the sample.  
Close Plots: Closes all plots from the sample. 
Delete Plots: Deletes all plots from the sample.  
Create Plot: Creates a new plot for the sample. 
Copy Template: Copies the template of the sample.  
Copy Events: Copies the events of the sample.  
Paste: Pastes the copied template or events of a 
sample. 
Duplicate: Creates a duplicate of the sample. 
Delete: Deletes the sample.  
Delete Events: Deletes all or part of the sample’s 
events. Only accounts with the Delete Sample 
Events privilege can perform this operation (Refer to 
Sample). 
Rename: Renames the sample.  
Edit Sample Notes: Edits the sample notes. 
Import: Imports a sample template or FCS file, as 
shown below: 
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Export: Exports the sample as a template, FCS file, 
CSV file, or exports all plots of the sample as image 
files. 

 
Move to Specimen: Move the sample to the 
selected specimen or new specimen. 

 
View Cytometer Status: Displays the cytometer 
status when the sample is collected. 
View Instrument Information: Displays the 
instrument information when the file is created or 
the first sample is collected. 
View Merge Information: This option is only 
available when selected sample is merged from 
other samples. User can view the merge 
information (e.g. samples which current sample 
was merge from). Please refer to Merge Samples in 
this guide for more details. 

 
Cytometer settings 

 

Copy: Copies the sample’s instrument settings.  
Paste: Pastes the copied instrument settings to the 
sample.  
Import: Imports the instrument settings from a 
selected template. 

 
Fluorescence compensation 

 

Compensation Matrix: Opens the sample’s 
compensation matrix.  
Spillover Matrix: Opens the sample’s spillover 
matrix. 
Clear Compensation: Clears fluorescence 
compensation information of the sample.  
Copy: Copies the sample’s fluorescence 
compensation.  
Paste: Pastes the copied fluorescence 
compensation to the sample.  
Import: Imports fluorescence compensation from a 
selected sample template. 

 
Open: Opens the report.  
Print: Prints the report.  
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Report 
Specimen Report: 

 
Sample Report: 

 

Copy: Copies the report template.  
Paste: Pastes the copied report template to the 
sample. Specimen reports and sample reports are 
not able to copy and paste each other. 
Import: Imports a report template to the sample 
from a selected template file. 

 
Analysis 

 

Open Plots: Opens all plots from the sample.  
Close Plots: Closes all plots from the sample. 
Delete Plots: Deletes all plots from the sample.  
Create Plot: Creates a new plot for the sample. 
Copy: Copies the sample analysis template.  
Paste: Pastes the copied analysis template to the 
sample. 
Import: Imports an analysis template to the sample 
from a selected template file. 

Plot 

 

Open: Opens the plot.  
Close: Closes the plot.  
Copy: Copies the plot.  
Paste: Pastes a copied gate to the plot.  
Delete: Deletes the plot.  
Rename: Renames the plot. 
Save as image…: Save plot as an image file. 

Gate Create Plot: Creates a new plot including the events 
from the selected gate. 
Gating: Selects plots to apply the gate. 
Open: Opens the plot containing the gate. 
Copy: Copies the gate. 
Delete: Deletes the gate.  
Rename: Renames the gate.  
Name with CD Marker: If a fluorescence parameter 
is labeled as a CD (Cluster of Differentiation) marker 
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in the Parameter panel by setting the Alias as CD 
and a number, this labels the gate using the CD 
markers.  
Change Color: Modifies the color of the gate.  
Show Color: Sets whether to display the gates in 
color.  
Color Precedence: Modifies color precedence of the 
gate. 
Show Name: Shows the gate name in gate label on 
plot. If the Show gate name in gate label option in 
Setting > Analysis is not checked, the Show Name 
menu item here will be disabled. 
Show Percentile: Shows the percentage of the 
gated events relative to the total number of events 
on the plot. If the Show population percentile in 
gate label option in Setting > Analysis is not 
checked, the Show Percentile menu item here will 
be disabled. 
Format: Opens Plot Format dialog to define gate 
format. 
Export Events: Exports data for the events inside 
the current gate in either FCS or CVS format. 

 
Logic gate group 

 

Create: Creates a logic gate.  
Delete: Deletes all logic gates. 

 
Logic gate 

 

Create Plot: Creates a new plot including the events 
from the selected gate. 
Gating: Selects plots to apply the gate. 
Edit: Opens the logic gate editing window.  
Delete: Deletes the logic gate. 
Rename: Renames the logic gate. 
Change Color: Modifies the color of the logic gate.  
Show Color: Sets to display the logic gates in color. 
Gating: Selects plots to apply the gate.  
Create Plot: Creates a new plot with the gate 
applied to the plot. 

Move Items 

Items in the Experiment Manager can be easily re-organized by drag and drop 
action. Select the item using the left key of the mouse. Move the mouse while 
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holding the left key to drag the item. When the mouse cursor turns like  , one may 
move the item to the position indicated by the blue line. When the mouse cursor 
turns like  , one may apply the analysis as the template to another item. For more 
information, see Drag and Drop the Templates. 

 
 
 

NOTE During the drag, press the ESC key to cancel the drag operation. 
 
 
 

NOTE Experiment Manager supports making multiple selections within tree node to allow 
batch operation of multiple objects. Use Shift key to select continuous nodes on the 
tree and use Ctrl key to select discontinuous nodes on the tree, just like selecting 
multiple files on Windows Explorer. Only nodes of same type can be selected 
simultaneously. The selection menu may have less items available when in multiple 
selection mode. 

 

Merge Samples 

When two or more samples were collected from the same instrument (i.e. same 
instrument serial number, and same optical configuration), with same data 
acquisition parameters selected in the Cytometer Setting panel, with same data 
acquisition mode (i.e. Absolute Count mode applied or not), and the total events 
from merged samples are less than 10 million, these samples can be merged into 
one sample.  

To merge multiple samples,  
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1 Ensure the Merge Samples privilege is enabled in the Access Privilege 
window.  

 
 

NOTE When user logs into the software with Administrator account, the Merge Samples 
privilege is automatically enabled by default. 

2 Select the samples from the Experiment Manager panel or Plate Manager 
panel (if NovoSampler, NovoSampler Pro or NovoSampler Q is connected) 
while holding the Ctrl or Shift key on the keyboard  

3 Right click any sample, click Merge as New Sample to Specimen. User can 
select either New Specimen to have the merged samples placed under a 
newly created specimen, or select Specimen X to have the merged sample 
placed under the selected existing specimen.  
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4 The original samples will be merged in the order of acquisition time with a 
fixed time interval of 30 seconds added between each original sample to 
account for the time needed for fluidic rinsing and sample preparation. The 
icon of the merged sample is displayed as .  

5 User can right click the merged sample, and select View Merge Information to 
view the information of merged sample (e.g. Name of original specimen and 
sample).  
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Templates 

The NovoExpress Software allows for the use of templates to quickly set up 
experiment settings. These files can contain the settings for groups, specimens, or 
samples. There are multiple methods for a template to be applied including: 
copying and pasting, dragging and dropping, adding through the toolbar, and 
importing and exporting templates. 

Copy and Paste the Template 

In the Experiment Manager panel, select a specimen, right-click, and select Copy 
to copy the template of the specimen. To copy the template of a sample, select 
the sample, right-click, and select Copy Template to copy the template of the 
sample. 

   

To paste, right-click on the target node and select Paste or Paste to All Samples 
or Paste to All Specimens to apply the template, as shown below: 
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The following table lists template information transferred when copying from a 
source node type and pasting to a target node type. In addition to copying and 
pasting, the table below also applies to dragging and dropping (Drag and Drop the 
Templates) and using the toolbar (Use the Toolbar) except for one exception 
described in Drag and Drop the Templates. 

 

The source 
node  

Target node 

Specimen  Specimen: The target specimen report is replaced by the template of source 
specimen report and samples in the target specimen are replaced by copying 
samples in the source specimen and pasting to them. 
Group, Experiment File: Creates the same specimen as the source specimen in the 
target group of experiment file. 

Specimen 
Report  

Specimen Report, Specimen: The target specimen report or specimen report of 
target specimen is replaced by template of source specimen report. 
Group, Experiment File: The specimen reports of all specimens within the target node 
are replaced by the template of source specimen report. 

Sample  Sample: The cytometer settings, compensation, sample report and analysis 
templates are replaced. If the target sample contains events, cytometer settings are 
not replaced. 
Specimen: Create the same sample in the target specimen  
Groups, Experiment File: All samples in the target node are replaced by copying the 
source sample and pasting them to the target node. 
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Cytometer 
Setting 

Cytometer Setting, Sample: The cytometer settings template is replaced. If the 
target sample node contains previously collected events, only the parameter aliases 
are replaced. 
Specimen, Groups, Experiment File: The cytometer settings templates for all 
samples within the target node are replaced. 

Compensation  Compensation, Sample: The compensation of target sample is replaced. 
Specimen, Group, Experiment File: The compensations of all samples within the 
target node are replaced. 

Sample 
Report  

Sample Report, Sample: The report template is replaced by the report template of 
source sample. 
Specimen, Group, Experiment File: The sample report templates of all samples 
within the target node are replaced. 

Analysis  Analysis, Sample: The analysis template of target sample including plots and gates 
is replaced by the analysis template of source sample. 
Specimen, Group, Experiment File: The analysis templates of all samples within the 
target node are replaced. 

Plot Analysis, Plot: If the target node contains a plot with the same name as the source 
node, the plot will be replaced. Otherwise, the plot will be created. 
Specimen, Group, Experiment File: Either replace or create the plot in all of the 
samples of the target node. 

Gate (does 
not include 
logic gates) 

Plot (does not include cell cycle plots): If the target node contains a gate with the 
same name as the source node, the gate will be replaced. Otherwise, the gate is 
created. Only range and bi-range gates can be drawn into a one-dimensional 
histogram. i.e., a rectangular gate cannot be applied to a histogram. Also, changing a 
two-dimensional gate (such as FITC vs. PE, that has a rectangular gate drawn in it) to 
a histogram will delete rectangular gates. 
Analysis, Sample: Source gate will be pasted to the plot with the same plot name as 
source gate’s plot in the target sample if it exists.  
Specimen, Group, Experiment File: Source gate will be pasted to all samples in the 
target node. 

 
 

NOTE Specimen reports and sample reports cannot copy and paste each other. 
 

Drag and Drop the Templates 

The template from source nodes can also be applied to target nodes by dragging 
and dropping, as shown below: 
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When dragging a node over another, if the mouse turns to  , dropping will apply 
template. If the mouse turns to  , dropping will move and reposition the selected 
item. For more details for moving objects, see Move Items.  

 
 

NOTE Drag a sample node to a specimen node, a pop-up dialog box will ask you to create 
new sample or paste a template to all samples of that specimen; drag a specimen 
node to a group node, a pop-up dialog box will ask you whether create new 
specimen or paste a template to all specimen of that group. 

 
 
 
 

NOTE During the drag, press the ESC key to cancel the drag operation. 
 
 
 

NOTE Drag a sample node to the workspace (empty area or inside plot window) will apply 
the data analysis template of the current Active Sample to the dragged sample and 
display the data from the dragged sample. In another word, it will keep current 
analysis template and switch the Active Sample to the dragged sample. 
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Use the Toolbar 

In the Experiment Manager panel, select the source node to be copied. The node 
will be highlighted in yellow (e.g.  ). To copy the selected node, click the 
Copy button  , from the Experiment Manager panel toolbar. To paste the copied 
node, select the target node in the Experiment Manager panel, and click the Paste 
button  , from the toolbar.  

Import and Export Templates 

Export Template 

In the Experiment Manager panel, select the sample, specimen, group, or 
experiment file to export. Right-click the selected node and select Export > Export 
as Template…. The template will be exported as a *.nct template file. 

 

Import Template 
• Import to Experiment File 

If importing to an experiment file, right-click the experiment file node and 
select New from Template…. 
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• Import to Specimen 

If importing to a specimen, right-click the specimen node and select New 
Sample from Template…. 

 

• Import to Sample 

If importing to a sample, right-click the sample node and select Import, then 
Import Template…. 
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• Import to Cytometer Setting, Compensation, Report, or Analysis 

If importing to Cytometer Setting, Compensation, Report, or Analysis, right-
click the target node and select Import… 
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 Import and Export Data 

The NovoExpress Software is capable of importing FCS 2.0, 3.0 and 3.1 formatted 
files for data analysis, and it is able to export FCS 3.0, FCS 3.1, and CSV formatted 
files. 

Import Data 

There are multiple methods for importing FCS files through the Experiment 
Manager panel: 
• Select the experiment file node or a group node. Right-click and select Import 

FCS Files…. Select a folder containing the FCS files to import. All FCS files 
within the folder will be imported. Files up to 10 subfolders deep will be 
imported and organized according to the folder structure. 

• Select a specimen node. Right-click and select Import FCS Files…. Select FCS 
files to import as samples under the specimen node. 

 
 

NOTE To import multiple samples, hold down the Ctrl key while selecting samples to 
select more than one sample. 

 

• Select a blank sample node. Right-click and select Import, then Import FCS 
File… . 

Select the FCS file, and data from the file will be imported to the blank sample. 
It is not possible to import data to a sample already containing collected data. 
To import data to a sample already containing data, first clear the sample of 
any events by right-clicking the sample and selecting Delete Events. 

Export Data 

Select the sample, specimen, group, or experiment file node with data to be 
exported. Right-click the node and select Export > Export to FCS Files… or Export 
to CSV Files…. The Export Events window will open. 
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When NovoSampler (or NovoSampler Pro or NovoSampler Q) is not connected 

 

 

When NovoSampler (or NovoSampler Pro or NovoSampler Q) is connected 

The Export Events window has the following settings: 
• Object: This is the node to be exported. If the object is a sample, only the 

sample will be exported. If the object is a specimen, group, or experiment file, 
all samples within the object will be exported. 
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• Gate: The default gate setting is All. In this setting, all events are exported for 
each of the exported samples. A specific gate can be selected using the drop-
down menu. When a gate is selected, only events within the gate are exported. 
If an exported sample does not contain the selected gate, all events within the 
sample are exported. Also, if an exported sample contains the gate but the 
gate does not include any events, all of the sample’s events are exported. 

• Path: The path specifies the location to save the exported files. The user can 
type in the textbox or use the button  , to change the path. When the object 
is a single sample, the exported data file is saved directly at the path. When the 
object is a specimen, group, or experiment file, the exported data files is saved 
in subfolders representative of the sample hierarchy organization in the 
Experiment Manager. 

• Specimen Name: Check this box to include specimen name in the name of the 
exported file. 

• Well ID: Check this box to include Well ID in the name of the exported file. This 
option is available only when NovoSampler, NovoSampler Pro or NovoSampler 
Q is connected. 

• Format: This specifies the exported data file format. The default setting 
depends on whether the window was opened using Export > Export to FCS 
Files… or Export > Export to CSV Files…. However, the format can be changed 
post selection using this setting. If you want to import the FCS files to FlowJo 
with version below v10, please select FCS 3.0.  

• Parameter Range: When exporting as a FCS formatted files, there is the option 
to set the recommends visualization parameter range. The three options are 
Default, Auto, and Plots. When Default is selected, the parameter range is the 
full range of the instrument (10 to 224). When Auto is selected, the software 
automatically calculates the best range based on the distribution of the 
sample data. When Plots is selected, the parameter range is determined from 
parameter ranges used in plots. 

• Post Gain: This option is enabled only when the samples specified to export 
have Post Gain defined. When checked, exported event value is the value after 
Post Gain adjusted. 

• Use Alias as Parameter Name: Check this option to use the parameter alias 
as keyword when exporting FCS file. 

After setting the above options, click OK to begin exporting the data. 
 
 



Experiment Manager 

 Software Guide 253 

NOTE Parameter range of options does not affect the number of events exported. No 
matter what choice was made it will export all the events within specified gate. 
Export FCS file with Auto or Plots parameter range could help third-party software 
to select the appropriate range when showing plots. 

 

Copy and Paste Events 

In the Experiment Manager panel, data of collected events can be copied and 
pasted to blank samples. 
• Select the sample containing the events to be copied. Right-click and select 

Copy Events. 
• Select the empty sample. Right-click and select Paste, or select the Paste 

button, from the toolbar. Data from all of the collected events in the original 
sample is pasted into the blank sample. Note that only events and cytometer 
settings are pasted. To copy and paste Analysis, select the sample containing 
the Analysis to be copied. Right click and select Copy Template. Select the 
sample to paste the Analysis into. Right click and select Paste. Alternatively, 
dragging and dropping Analysis from one sample to another will also copy and 
paste the Analysis. Similarly, this can be performed with Compensation and 
Report. 

 
 
 

NOTE This is useful when using the Auto Compensation feature during analysis to apply 
single stained compensation controls to the generated Auto Compensation 
samples. 
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8 Reports 

This chapter provides information for the Report function, including Report 
Interface, Automatically Generate Reports, Report Options, Report Editor, Report 
Output and Batch Print Reports.  

Reports can be created using an Auto mode and a manual mode. In the Auto 
mode, the software generates the report using a fixed format to include user 
created plots, statistics (Gate, Count, % of Parent, Mean X and Mean Y), and basic 
information (Sample Name, Run Time, Cytometer, and Software). In the manual 
mode, the user is able to add or remove elements and adjust formatting. 

 
 

NOTE Real-time changes made to a plot within the Report are also applied to sample’s 
Analysis back in the main interface. Statistics are automatically adjusted. 

 

From the Experiment Manager panel, the report can either be a sample report or a 
specimen report. A sample report can contain plots, statistical information, 
compensation matrices, and collection information for the sample. A specimen 
report contains such information for all of its samples and basic information of its 
own. Double clicking on Report in the Experiment Manager allows the user to view 
the report interface window. 

After the reports are created, a batch print function (Batch Print Reports) can be 
used to generate PDF files.  
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Report Interface 

The report interface window is shown below. It can be opened by double-clicking 
on the report node in the Experiment Manager panel. 

 

The interface window is divided into three main sections: Title Block, Toolbar, and 
Display Area. 

The title bar contains the name of the current report in the window. 

The toolbar contains the functions available to generate and edit the report. 

The display area is the main area of the window. Using this area, the user is able to 
edit the objects displayed and add and delete pages. The objects here forth are 
referred to as report items and include text, graphics, statistical information, 
fluorescence compensation, and plots. 

The toolbar functions are described below: 
 

Icon Description 

 
Auto Report Mode: Clicking on this button switches between the automatic 
report generation mode and the manual mode. When selected and in automatic 
mode, the icon appears with a blue border . When unselected and in manual 
mode, the icon appears without the blue border .  
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NOTE  The original automatic report can be restored after making manually 
changes in manual mode by re-selecting auto report mode. 

  

 
Report Options: Click to open Report Options dialog. Refer to Report Options 
for detail information. 

 
Insert Page: This function inserts a page into the report. By default, clicking the 
button inserts a blank page after the current page being viewed. In the display 
window, the current page being viewed has a red border. From the arrow to the 
right of the button, a drop-down menu allows the user to specify Insert Before 
Current Page or Insert After Current Page.  

 
Delete Page: Deletes the current page. If the report is a single page, the page 
cannot be deleted. 

 
Print: Prints the report.  

 
Batch Print Reports: Open the Batch Print Reports dialog. Refer to Batch Print 
Reports. 

 
Print Preview: Displays a print preview of the report.  

 
PDF: Generates a PDF file of the report. 

 
Insert Text: Inserts a textbox. The user can edit and format the text. Text types 
include text, sample name, sample notes, specimen ID, specimen name, 
operator, run time, cytometer, and software. In addition, specimen reports 
contain specimen information text type. 

  

 
Insert Plot: Click the icon to list the plots for the sample, including dot plots, 
density plots, histogram plots, contour plots, and cell cycle plots. Select the plot 
to insert. The plot is inserted with the statistics as shown below.  
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Insert Sample Statistics: Inserts a table of gate statistics for a sample. In a 
sample report, click the button to insert a gate statistics table for the sample. In 
a specimen report, click the button and select a sample from the dropdown 
menu to insert a gate statistics table for the selected sample. 

 
Insert Compensation: Inserts a spillover matrix. In a sample report, click the 
button to insert the spillover matrix for the sample. In a specimen report, click 
the button and select a sample from the dropdown menu to insert the spillover 
matrix for the selected sample. The spillover matrix cannot be edited from 
within the report. If the spillover matrix is modified in the main interface, the 
matrix in the report window will update. 

 
Insert Photodetector Gain: Inserts a table of photodetector gain setting for a 
sample. In a sample report, click the button to insert a table of photodetector 
gain setting for the sample. In a specimen report, click the button and select a 
sample from the dropdown menu to insert a table of photodetector gain setting 
for the selected sample. 

  
Plate Information: Inserts plate information for selected sample, including 
plate ID, barcode of the plate (if scanned), and description. It is available only 
when NovoSampler, NovoSampler Pro or NovoSampler Q is connected. 

 

 
Insert Shape: Click to insert a horizontal line, vertical line, or rectangle. 

 
Insert Picture: Click open the Open window, select a picture to insert. The 
picture will be resized to an appropriate size with the original aspect ratio and 
inserted in the report.  
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Select: The default is Select All. From the arrow on the right of the button, 
Select Similar Objects is also available. 

 
Page Rotation: Switches the page layout orientation between portrait and 
landscape. 

 
Zoom: Sets the zoom percentage of the displayed page. When report displays 
is zoomed in or zoomed out (zoom percentage is not 100%), user cannot 
double-click report item to enter into edit mode. 

 
Align: Select two or more objects in a page to activate these features. When 
selecting multiple objects, the first object has white squares on the border, 
while additional objects have black squares. From the four alignment options 
(align top, left, bottom, or right), select the edge to be aligned. The objects will 
be moved so that the selected edge of all selected objects aligns with the 
object first selected.  

 
Lock Position: Check this item to forbid moving any object of the report. Align 
Top, Align Left, Align Bottom, Align Right buttons will be disabled when Lock 
Position is checked.  

 
Make Same Size / Width / Height: Select two or more objects in a page to 
activate these features. When selecting multiple objects, the first object has 
white squares on the border, while additional objects will have black squares. 
From the three resize options (make same size, width, or height), select the 
desired resize dimension. The selected objects will be resized to match the 
selected dimension of the object first selected.  

 
Previous: In a sample report, click to switch to the previous sample’s report. In 
a specimen report, click to switch to the previous specimen’s report. 

 
Next: In a sample report, click to switch to the next sample’s report. In a 
specimen report, click to switch to the next specimen’s report. 

 
Select: Select to view or edit another report. 

 
Set Page Header and Footer: Click to show header and footer editing interface. 

Page: 1/3 Page: Displays the current page and the total number of pages. 

Automatically Generate Reports 

The report can be generated through an automated or a manual mode. In the 
automated mode, the user performs the analysis and creates the plots in the main 
software interface. The report will be automatically created with the plots and 
statistical information added without the need for additional input from the user. 
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The user is not able to add, delete, or modify the contents of the report in this 
mode. 

To switch the mode from manual to automated, click on the Auto Report Mode 
button in the toolbar  . The prompt below will appear to confirm the switch to 
the automated mode. Click OK, to automatically generate the report. 

 

To switch the mode from automated to manual, click on Auto Report Mode button 
in the toolbar  . The user can now make modifications to the report. 

 
 

NOTE When creating a report, it may be best to use the automated mode to generate an 
initial report and then switch to manual mode to modify the report. 

 

Report Options 

Report Options dialog provides user interface for user to customize report of auto 
and manual mode. To open Report Options dialog, click the Report Options button 

 in the report window toolbar. The Report Options dialog is shown below: 
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The settings in Plot Options panel are used for customizing plots inside report. 
They are effective for both auto and manual report mode. 
• Show Gate Name in Gate Label:  

If selected, gate name is displayed in gate label on the plot. 
• Show Population Percentile in Gate Label:  

If selected, gate label is displayed with the percentage of the population within 
the gate. 

• Plot Title Options:  

If clicked, a drop down menu will show as below. 
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 Show Plot Title:  

If selected, plot title is displayed on the report plot. 
 Sample Name: 

If selected, the sample name is displayed in the report plot title. 
 Specimen Name: 

If selected, the specimen name is displayed in the report plot title. 
 Gating Name: 

If selected, the gating name is displayed in the report plot title. 
 Gating Hierarchy: 

If selected, the gating hierarchy is displayed in the report plot title. 
 
 

The settings in Auto Report Mode Options panel are used for customizing auto 
report. They are only effective for auto report mode. 
•  Number of Plots per Row:  

Sets how many plots are shown in one row. 
• Plot Statistics:  

If selected, shows gate statistics of plot. 
• Sample Statistics: 

If selected, shows gate statistics of sample. 
• Compensation:  

If selected, shows compensation matrix. 
• Photodetector Gain:  

If selected, shows the photodetector gain setting. 
• Plate Information: 
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If selected, shows the plate information. This option is available only when 
NovoSampler, NovoSampler Pro or NovoSampler Q is connected. 

• Insert Page Break Before Each Sample: 

Only available for specimen report. If selected, a page break will be inserted 
before each sample. 

• Show Statistics Columns:  

Selects statistical items to display. 
• Show Sample Statistics Rows:  

Selects sample statistical items to display. 
• Select Plots:  

Selects plots to display on report. 
• Select All:  

Selects all associated items to display on report. 
• Set as Default:  

Sets above settings as default setting for new reports. 
• Apply to All:  

Applies above settings to all report in the experiment. 

Report Editor 

In the manual mode, the user is able to freely edit the report. Options include 
adding, removing, and editing objects in the report 

Add Report Objects 

Objects can be added to the report through the toolbar, Workspace, and 
Experiment Manager panel. To add objects using the toolbar, use the insert 
functions described in Report Interface. From both the Workspace and Experiment 
Manager panel, objects corresponding to the sample can be dragged and dropped 
into the report. 
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Select Report Objects 

Click on an object to select it in the report. An object can have one of two selected 
states. After clicking on an object, the object will be highlighted. In this state, the 
object is bordered by a black dashed line with white control points. If the object is 
then double-clicked, it is in the edit state, and the object is bordered by a red 
dashed line with black control points. Different operations can be performed on 
the object depending on the selected state. The two states are shown below. 

This is the object after being selected: 

 

This is the object selecting and in the editing state: 

 



Reports 

 Software Guide 265 

To have multiple objects selected simultaneously: 
• In the toolbar, click the Select All button  , to select all of the objects in the 

report. 
• Left-click and drag in the report to enclose objects inside of the dashed 

rectangle. Objects within the dashed rectangle will be selected when the 
mouse button is released. 

• Select an initial object. In the toolbar, click Select All, then Select Similar 
Objects. All objects in the report of the same type as the initial object will be 
selected. 

• Select an object. Press and hold the Ctrl key to select additional items. 

When multiple items are selected, the first item is bordered by a black dashed line 
with white control points and additional items are bordered by black dashed lines 
with black control points. 

Edit Report Objects 

Double-click on a selected object or right-click on the object and select Edit to 
enter the editing mode for that object. This section will describe the editing options 
available for the objects. 

Edit Text 

Double-click on the textbox or right-click on the textbox and select Edit to enter 
editing mode. In this mode, text formatting tools will appear. Right-click on the 
textbox and select Insert to insert sample information including sample name, 
sample notes, specimen ID, specimen name, operator, run time, cytometer and 
software information, as shown below. This can also be accessed by clicking the 
Insert Text  icon’s drop-down menu in the tool bar. 
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Edit Plots and Statistics 

Double-click on the plot or right-click on the plot and select Edit to enter editing 
mode. Plots can be edited in the report by right-clicking in the plot to access the 
plot tools. Modifications made to the plot will also be updated to the plot in the 
main interface. In addition, if the plots are modified in the main interface, the plots 
in the report will also update automatically.  

Double-click on the statistics box or right-click on the statistics box and select Edit 
to enter editing mode. Right-click in the selected statistics box to choose the 
columns to display, as shown below. 

 

Filter Statistics 

User can right click the statistics box of the report, click Filter Rows to open the 
Filter Rows window. Check to select the gate(s) to display associated sample 
statistical information in the report, and click OK to confirm. 
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When the statistics box shows the gate hierarchy, the Filter Rows window displays 
the gate hierarchy too. When the child gate is checked, the parent gate will be 
automatically checked. 

 

When the statistics box does not show the gate hierarchy, the Filter Rows window 
does not display the gate hierarchy either. 
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Edit Shapes 

Double-click on an inserted shape (horizontal lines, vertical lines, or rectangles) or 
right-click on the shape object and select Edit to ender editing mode. A Shape 
Properties window will appear. In the window, line width, style, and color can be 
set. 

 

Edit Pictures 

Double-click on the picture or right-click on the picture and select Edit to enter 
editing mode. The Open window will appear, and users can select an image to 
replace the current picture. 
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Align Report Project Items 

There are multiple methods to align objects in a report. 
• Use the mouse to drag an object within the report. As the object is dragged, 

smart guides appear when the object is aligned with other objects in the 
report. Drag the object until it is aligned with the appropriate other objects and 
release the mouse button to set the object at the new location. 

• Select the object and use the ￪, ￬, ￩, ￫ keys on the keyboard to move the 
object. Move the object until the object appears to be aligned with the 
appropriate other objects. 

• Select multiple objects. Select the appropriate align tool from the toolbar 
depending on the edge of the object to be aligned (Align Top  ; Align Left 

 ; Align Bottom  ; Align Right  ). The objects will be aligned along the 
selected edge relative to the position of the first selected object. (The first 
selected object will be displayed with white control points, while other selected 
objects will be displayed with black control points.) 

Resize Objects 

There are two methods to resize objects in a report: 
• Select an object. Click and drag on the control points of the object to resize the 

object . 
• Select multiple objects. Select the tool to Make Same Size, Make Same Width, 

or Make Same Height. The objects will be resized to match the appropriate 
dimensions of the first selected object. (The first selected object is displayed 
with white control points, while other selected objects are displayed with black 
control points.) 

Order Object Levels 

When objects are overlapped in the report, the object that is displayed is 
determined by the ordering of the object. To change the ordering of an object, 
select the object. Right-click on the object and select Ordering. Options then 
include Bring to Front, Bring Forward, Send Backward, and Send to Back. Select 
the appropriate operation for the object. Objects toward the front are displayed 
over objects further back. 

Cut, Copy, Paste, and Delete 

• Cut: Select an object. Use the keyboard shortcut Ctrl X or right-click and select 
Cut to cut an object. 
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• Copy: Select an object. Use the keyboard shortcut Ctrl C or right-click and 
select Copy to copy an object. The copied object can be pasted to the office 
software such as Word, PowerPoint, and Excel. 

• Paste: After cutting or copying an object, the object can be paste from the 
clipboard using the keyboard shortcut Ctrl V or right-click and select Paste. 
The object will be pasted at the specified location. 

• Delete: Select an object. Use the keyboard Delete key or right-click and select 
Delete to delete an object. 

Insert or Delete Pages 

To insert or delete pages, use the Insert Page and Delete Page button from the 
toolbar. For more information, see Report Interface. 

Header and Footers 

Headers and Footers Working Interface 

The header and footer display information at the top and bottom of the pages, 
respectively, in the report. To edit the header and footer, click the Set Page Header 
and Footer button  , from the toolbar. As shown below, the rectangular region at 
the top and bottom of the page for the header and footer is outlined. A toolbar 
containing functions to edit the header and footer is also available. At this time, the 
header and footer can be edited. 
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Toolbar for Header and Footer Functions: 
 

Icon Description 

 
Insert Text: Inserts a textbox.  

 
Insert Page Number: Inserts page numbers. Select between two styles: 1,2,3 ... or 1/3, 
2/3 .... 

 
Insert Shape: Inserts a horizontal line, vertical line, or rectangle.  

 
Insert Picture: Inserts a picture.  

 
Set Page Header and Footer: Click to exit header and footer editing mode. 

Edit Headers and Footers 

To edit the header, click in the header region at the top of the page. Once selected, 
the region is bordered by a red rectangle. The toolbar can now be used to add 
objects to the header. 

To edit the footer, click in the footer region at the bottom of the page. After 
selected, the region is bordered by a red rectangle. The toolbar can now be used to 
add objects to the footer. The default footer includes an object for page number. 

The methods for editing the header and footer are consistent with the rest of the 
report interface with the following exceptions. 
• The level of the objects in the header and footer cannot be ordered. Newer 

created objects are automatically created more towards the top. Objects in the 
header and footer are behind objects created in the main report interface. 
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• Smart guides are not available to help align objects in the header and footer. 
• Copying and pasting objects is unavailable in the header and footer. 
• Variables such as sample name, specimen ID. Specimen name, operator, run 

time, and cytometer and software information cannot be inserted into 
textboxes in the header or footer. 

After editing the header and footer is complete, click the Set Page Header and 
Footer button  , to return to the main report interface. The header and footer will 
display on all pages of the report. 

Copy the Header and Footer Settings to Other Reports 

To transfer the header and footer from one report to another, copy and paste the 
report as a template as described in Templates. 

Report Output 

The reports can be printed or converted to a PDF file. 
• To Print: 

Click the toolbar Print button  . Alternatively, right-click the report node in 
the Experiment Manager panel and select Print. The print window will appear. 
Select the correct printer and print the report. 

• To Convert to PDF: 

Click the toolbar PDF button  . The Save As window will appear to save the 
report as a PDF file. 

Batch Print Reports 

To batch print reports: 

In the main interface window, click the Batch Print Reports button in the Home tab 
of the Menu Bar. Alternatively, select File > Print > Batch Print Reports. The Batch 
Print Reports window will appear. 
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The reports are listed on the left side of the Batch Print Reports window. Use the 
checkboxes to select the reports to be printed. On the right side of the window, 
select either to print the report or generate PDF files for the report.  

If printing, select a printer and click Print.  

If generating a PDF, select a file path to save the PDF files. If the Specimen name 
box is checked, the PDF files will be saved in the format specimen name_sample 
name_YYYYMMDD_hhmmss. If the box is unchecked, the PDF files will be saved 
in the format sample name_YYYYMMDD_hhmmss. Click Print to begin generating 
the PDF files. 

 
 

NOTE One PDF file will be created for each report selected by default. If Merge reports in 
the same specimen/group/experiment is checked, all reports of one 
specimen/group/experiment will be printed into one PDF file. 

 

After clicking Print a progress bar will appear as shown below. 
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During the printing process, click Cancel to stop the printing. 
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9 QC Test 

This chapter describes the procedures to run QC test and view the report for 
Agilent flow cytometers. 

 

The NovoExpress software QC Test function automatically conducts the QC 
procedure using Agilent flow cytometer QC particles. Click Instrument > QC Test 
from the NovoExpress software to initialize the QC test. The QC Test Report 
tracks the QC test results over time and can be reviewed through Instrument > QC 
Test Report from the NovoExpress software. 

 

Agilent Flow Cytometer QC particles are polystyrene microspheres with uniform 
size (average diameter of 3 μm). The QC particles contain 5 kinds of microspheres 
with differing fluorescence intensities and one blank microsphere. These 
fluorescent microspheres are internally stained with fluorescent dye, which can be 
excited by all the lasers with known MESF (Molecules of Equivalent Soluble 
Fluorochrome) values for each fluorescent peak, from which the linearity can be 
calculated.  

There are three test results: 
• Pass 

Indicating that all the performance parameters meet the requirements. 
• Acceptable 

Indicating that the performance parameters are not optimal compared to the 
manufacturing QC criteria. However, continued use of the instrument is still 
allowed and the experiment results should be not be impacted.  

• Fail 

Indicating that the performance parameters do not meet the requirements. A 
label in red will show on report to indicate the reason of failure. Please contact 
your local Agilent Technologies representative when the QC test fails. 

The QC Test procedure generally includes three steps:  
• Prepare QC particles sample 
• Run QC test 
• View QC reports and Levey-Jennings plot 
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NOTE The software prompted windows displayed in this chapter is for illustration purpose 
only. User may observe different windows depending on the Agilent flow cytometer 
models. 

Prepare QC Particle Sample 

 

1 Label a 12 × 75 mm tube for the QC test. Add 1 mL dilution buffer (0.8 mL PBS 
and 0.2 mL NovoRinse solution) into the tube. 

2 Take one bottle of QC particles from storage. Invert the bottle to mix the 
particles thoroughly. 

3 Add two drops of QC Particles into the test tube. 
4 Vortex the test tube to mix the QC particles thoroughly.  
5 Place the tube onto the instrument and start the QC test. If NovoSampler or 

NovoSampler Pro or NovoSampler Q is used, transfer 150 µL of the QC 
particles sample from the test tube to the A1 well of a 96-well plate and run 
the QC Test immediately. If the prepared QC particle sample is not intended to 
be run immediately, store the sample in a 2-6 ℃ refrigerator away from light. 
The prepared QC particle sample should be used within four hours after 
preparation. 

 

NOTE Make sure the QC particle sample is prepared properly following the above 
procedure. Properly prepared QC particle sample would give enough QC particle 
counts (~10,000 QC particles) during the QC Test. 

Run QC Test  

1 Save the Agilent Flow Cytometer QC Particles Lot file. 

Download the Lot File for the specific batch of QC Particles from 
https://www.agilent.com/chem/novocyte-qc-lot-files. Save the Lot File in a 
specific directory in the NovoExpress Software’s installation directory. (Save 
the file in C:\Program Files (x86)\NovoExpress\QC \QC Beads, if the 
installation directory is C:\Program Files (x86)\NovoExpress). Saving the Lot 
file is only done once for each new batch of QC Particles. After saving the Lot 

https://www.agilent.com/chem/novocyte-qc-lot-files
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File to the directory, the lot ID for the specific batch will be listed when running 
the QC test. 

2 Ensure the instrument is in Ready status. If NovoSampler (or NovoSampler 
Pro or NovoSampler Q) is used, open the cover of NovoSampler (or 
NovoSampler Pro or NovoSampler Q) and place the sample plate on the tray. 
Ensure the plate is fully seated with the correct orientation onto the shaker.  

3 In the NovoExpress Software, click the QC Test button in the Instrument tab of 
the Menu Bar to open the QC Test window. The window is shown below. 

 

NovoExpress QC Test Window when NovoSampler (or NovoSampler Pro or NovoSampler Q) is not 
connected 
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NovoExpress QC Test Window when NovoSampler (or NovoSampler Pro or NovoSampler Q) is  
connected 

 

In the window, enter the name of the operator, select the QC particles lot ID, 
select the Well ID (if NovoSampler or NovoSampler Pro or NovoSampler Q is 
used) and click Next. If the correct QC particles lot ID is not listed, please refer 
to the first step to download and save the QC particles Lot File. Check Export 
Report to CSV File to export report as a csv file after QC test is completed. 
The exported CSV file (in the format of YYMMDD_hhmmss.csv) is 
automatically saved in C:\Program Files (x86)\NovoExpress\QC \QC Report 
Files by default. 

 

NOTE The default name of the exported CSV file is in the format of QC test date and time. 
For example, if the QC test is performed at 10:30:40 am on January 18, 2019, the 
default name of the exported CSV file will be 190118_103040.csv. 

 

4 Click Run to begin the test. The instrument will begin collecting events and the 
results will be displayed in real-time on the QC Test window. 
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NOTE When NovoCyte Quanteon, Advanteon or Penteon is used, the software will collect 
electronic and optical noise (see figure below) before collecting the events. 
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5 After data collection is complete, click the Report button to view the test 
results. 

 

From the figure, the QC test will provide results for various parameters. Click 
Print to print the test report.  
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NOTE To view the history of the resulting QC data, click QC Test Report from the 
Instrument tab of the Menu Bar (described in View QC Test Report ). Highlight the 
date to be viewed and select the QC Test Report tab. 

 

View QC Test Report 

The QC test report function stores previous QC test results and provides a data 
analysis feature to track instrument performance changes over a period time. To 
open the QC Test Report window, click QC Test Report from the Instrument tab of 
the Menu Bar. The window is shown below. 

 

The QC Test Report window contains the following sections. 
 

Interface Description 

Title Area  Displays the report name and the Export CSV File, Open Data File and Print button.  

Query Area  Query a time interval for QC test reports. As shown: 
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QC Test 
Report 

Displays the QC test report for a selected report from the query results. As shown: 

 

Levey-
Jennings 
Report  

Displays the QC test data over time to observe trends in instrument performance. As 
shown: 
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Export CSV 
File 

Export the QC result as a csv file. 

Open Data 
File 

Open the QC data file of the selected report. 

Print Click the Print button in the top right corner of the window to print QC test reports or 
Levey-Jennings reports. 
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10 Troubleshoot 

This chapter provides the information for troubleshooting Agilent flow cytometer 
instrument and associated accessories, including prompted message ID, software 
messages, possible causes, recommended solutions, and procedures to create 
technical support files.  

Troubleshoot Instrument 

The following table lists possible causes for warning and error prompts from the 
status bar when connecting with Agilent flow cytometer instrument. 

 
 

Message 
IDs 

Software 
Messages 

Possible Causes  Recommended Solutions  

0x0001 Collision of SIP  The movement of the SIP is 
blocked by some obstacles. 

Locate and clear the obstacles. The 
instrument will automatically start 
error handling and move the SIP to 
the home position.  

Incorrect plate selected in plate 
manager. 

Select the correct plate in the plate 
manager window. 

Incorrect positioning of plate in 
NovoSampler, NovoSampler Pro 
or NovoSampler Q. 

Position the plate on the shaker 
correctly. Ensure the plate is seated 
flat on the stage inside the clamps. 
 

NovoSampler (or NovoSampler 
Pro or NovoSampler Q) is not 
calibrated. 

Re-calibrate NovoSampler (or 
NovoSampler Pro or NovoSampler 
Q). 

Dirty SIP or SIP Cleaning 
apparatus. 

Clean the SIP or SIP cleaning 
apparatus following the procedures 
described in Preventative 
Maintenance in associated 
instrument operator's guide. 

0x0002 Running out of 
NovoFlow  

NovoFlow solution is not 
sufficient to continue to run any 
samples. 

Refill the NovoFlow container 
following the procedures described 
in Add Instrument Reagents in 
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associated instrument operator's 
guide. 

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0003 Running out of 
NovoRinse  

NovoRinse solution is not 
sufficient to continue to run any 
samples. 

Refill the NovoRinse container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide.  

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0004 Running out of 
NovoClean 

NovoClean solution is not 
sufficient to continue to run any 
samples. 

Refill the NovoClean container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide.  

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0005 Waste container 
is full  

Waste container is too full to 
continue to run any samples. 

Empty the waste container 
following the procedures described 
in Empty Waste in associated 
instrument operator's guide.  

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0006 System voltage 
is out of range 

System Error. • Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0007 System electric 
current is out of 
range 

System Error. • Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 
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0x0008 Firmware 
configuration 
error 

System Error. • Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0009 
0x000A 
0x000B 
0x4009 
0x400D 

…… laser self-
test error 

Specified laser is not functioning 
properly. 

The instrument will automatically 
reset the laser and run a laser self-
test. It takes approximately 5 to 10 
minutes.  

0x000C 
0x000D 
0x000E 
0x400A 
0x400E 

…… laser is not 
connected 

Specified laser is not detected. • Restart the instrument 
• Contact Agilent technical 

support if the error persists. 

0x000F NovoSampler 
communication 
lost 

The cable between the 
NovoSampler(or NovoSampler 
Pro or NovoSampler Q) and 
instrument is not securely 
connected. 

Reconnect the cable between the 
NovoSampler (or NovoSampler Pro 
or NovoSampler Q) and instrument.  

NovoSampler (or NovoSampler 
Pro or NovoSampler Q) is not 
communicating with instrument. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0010 NovoSampler 
has not been 
calibrated 

NovoSampler (or NovoSampler 
Pro or NovoSampler Q) is newly 
installed or re-connected. 

Follow the prompted instructions to 
calibrate the NovoSampler (or 
NovoSampler Pro or NovoSampler 
Q). 

0x0011 NovoSampler 
calibration 
failed…… 

NovoSampler (or NovoSampler 
Pro or NovoSampler Q) is not 
installed properly. 

Re-install and calibrate the 
NovoSampler (or NovoSampler Pro 
or NovoSampler Q) following the 
procedures described in Installation 
in associated operator's guide. 
Ensure the NovoSampler is seated 
flat on the stage and tightly close to 
the instrument. 

The NovoSampler (or 
NovoSampler Pro or 
NovoSampler Q) cover is opened 
during calibration. 

Close the NovoSampler (or 
NovoSampler Pro or NovoSampler 
Q) cover and redo the calibration. 

The optocoupler or motor of 
NovoSampler Q is not working 
properly. 

• Restart the instrument and redo 
the calibration. 

• Contact Agilent technical 
support if the error persists. 

0x0012 The movement of the orbital 
shaker is blocked. 

• Check the path of the orbital 
shaker to make sure there are 
no objects blocking the 
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The movement 
of plate is out of 
range 

movement. Clear the block if 
there is anything.  

• Re-calibrate the NovoSampler 
(or NovoSampler Pro or 
NovoSampler Q). 

NovoSampler (or NovoSampler 
Pro or NovoSampler Q) is not 
installed properly. 

Re-install and calibrate the 
NovoSampler (or NovoSampler Pro 
or NovoSampler Q) following the 
procedures described in Installation 
in associated operator's guide.  

0x0013 Cover of 
NovoSampler is 
opened during 
moving plate 

The cover of NovoSampler (or 
NovoSampler Pro or 
NovoSampler Q) is open during 
moving plate. Or the cover is not 
closed well. 

Close the cover. NovoSampler (or 
NovoSampler Pro or NovoSampler 
Q) will automatically reset and be 
ready for operation. 

0x0014 Pressure is out 
of limit 

Waste container is not correctly 
connected to the instrument. Or 
waste tubings are bending and 
clogged. 

Follow the prompted instructions 
from NovoExpress to clear the 
error. If NovoCyte Flow Cytometer 
is connected, check the quick 
coupling connectors to ensure the 
waste container is correctly 
connected to the instrument. 
Ensure the waste tubings are not 
bending and clogged.  

Sheath in-line filter is clogged. Follow the prompted instructions 
from NovoExpress to clear the 
error. If NovoCyte Flow Cytometer 
is connected, replace the sheath in-
line filter following the procedures 
described in Replacing Fluidic 
System Consumables in associated 
instrument operator's guide. 

Sample injection probe or flow cell 
is clogged. 

Follow the prompted instructions 
from NovoExpress to clear the 
error.  

0x0015 NovoSampler 
firmware error 

NovoSampler (or NovoSampler 
Pro or NovoSampler Q) firmware 
is not working properly. 

Re-install or upgrade the 
NovoSampler (or NovoSampler Pro 
or NovoSampler Q) firmware. 

0x0016 
0x0017 
0x0018 
0x400B 
0X400F 

…… laser does 
not emit 

Specified laser is not connected 
properly or laser is not working 
properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0019 
0x001A 
0x001B 

…… laser 
communication 
error 

Specified laser is not 
communicating with the 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 
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0x400C 
0x4010 

instrument properly or the laser is 
not working properly. 

0x001C Sample injection 
probe reset 
failed 

Bad connection or optocoupler is 
not working properly. 

• Click the OK button in the 
prompted dialog box or wait 10 
seconds for automatically error 
handling.  

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x001D Sampling Pump 
reset failed 

Bad connection or optocoupler is 
not working properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x001E The SIP module 
needs to be 
upgraded to 
support 
NovoSampler 
Pro 

SIP module is not compatible with 
connected NovoSampler Pro. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0020 System 
initialization is 
paused 

Liquid level in the reagent 
containers is not within normal 
range when instrument is 
powered up. 

• Make sure that the instrument 
reagent containers are placed 
correctly and the liquid level in 
the containers is within the 
normal range. 

• Click OK on the prompted 
dialog to continue system 
initialization. 

0x0021 Sheath fluid 
pump reset 
failed 

Bad connection or optocoupler is 
not working properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x0022 Resetting 
NovoSampler 
Pro to zero 
position failed 

NovoSampler Pro is not working 
properly. 

• Click Instrument → 
NovoSampler Pro→ Reset in 
NovoExpress software to reset 
NovoSampler Pro.  

• Restart the NovoSampler Pro. 

0x0023 Resetting 
NovoSampler to 
home position 
failed 

NovoSampler (or NovoSampler 
Pro or NovoSampler Q) is not 
working properly. 

• Click Instrument → 
NovoSampler (or NovoSampler 
Pro or NovoSampler Q) → 
Reset in NovoExpress software 
to reset NovoSampler (or 
NovoSampler Pro or 
NovoSampler Q).  

•  Restart the NovoSampler (or 
NovoSampler Pro or 
NovoSampler Q). 

0x0100 Instrument cover 
opened 

Instrument cover is opened or not 
tightly closed. 

Close the instrument cover. 
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0x0101 NovoFlow 
running low 

NovoFlow solution is below the 
pre-set volume limit. 

Refill the NovoFlow container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide. 

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0102 NovoRinse 
running low  

NovoRinse solution is below the 
pre-set volume limit. 

Refill the NovoRinse container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide. 

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0103 NovoClean 
running low 

NovoClean solution is below the 
pre-set volume limit. 

Refill the NovoClean container 
following the procedures described 
in Add Instrument Reagents in 
associated instrument operator's 
guide. 

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0104 Waste container 
is close to full 

Waste is above the pre-set volume 
limit. 

Empty the waste container 
following the procedures described 
in Empty Waste in associated 
instrument operator's guide. 

If the liquid level is within the 
normal range, maybe the sensor 
is not working properly. Or the 
sensor needs to recalibrate. 

• Calibrate Fluidics Station (or 
Cart) following the procedures 
described in associated 
instrument operator's guide. 

• Contact Agilent technical 
support if the error persists. 

0x0105 Cover of 
NovoSampler is 
opened  

Cover of NovoSampler (or 
NovoSampler Pro or 

Close the cover. 
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NovoSampler Q) is opened. Or the 
cover is not closed well. 

0x0106 NovoSampler is 
disconnected 
when powered 
up 

The NovoSampler (or 
NovoSampler Pro or 
NovoSampler Q) is disconnected 
when powered up 

• Shut down instrument.  
• Reconnect the cable of the 

NovoSampler (or NovoSampler 
Pro or NovoSampler Q) to 
instrument.  

• Turn on instrument and follow 
the prompts to calibrate the 
NovoSampler (or NovoSampler 
Pro or NovoSampler Q). 

• Contact Agilent technical 
support if the error persists. 

0x0109 Fluidics Station 
is not connected 

Cable between the fluidics station 
and the instrument is not properly 
connected. 

• Power down the instrument.  
• Reconnect the cable between 

the fluidics station and the 
instrument.  

• Power up the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x010A 
0x010B 
0x010C 
0x010D 

… liquid level 
sensor failure 

Specified liquid level sensor in the 
fluidics station (or Cart) is not 
working properly. 

• Reconnect the fluidics station 
(or Cart) cable.  

• Restart the instrument.  
• Contact Agilent technical 

support if the error persists. 

0x010F Sheath filter is 
clogged. Please 
replace the 
sheath filter and 
run the Priming 
procedure 

Sheath in-line filter is clogged. Replace the sheath in-line filter 
following the procedures described 
in Replacing Fluidics System 
Consumables in associated 
instrument operator's guide. 

0x0110 Recovering 
collision error 

Plate stops at an incorrect 
position. 

No action is needed. Instrument will 
automatically recover the error. 

0x0111 Orbital shaker 
homing position 
reset failure 

Orbital shaker of NovoSampler (or 
NovoSampler Pro or 
NovoSampler Q) is not working 
properly. 

No action is needed. The 
NovoSampler (or NovoSampler Pro 
or NovoSampler Q) can be used 
normally. 

0x0112 0.05 µm sheath 
fluid 
ultrafiltration 
(UF) filter is 
clogged 

0.05 µm sheath fluid ultrafiltration 
(UF) filter is clogged. 

Replace the 0.05 µm sheath fluid 
ultrafiltration (UF) filter following 
the procedures described in 
Replacing Fluidics System 
Consumables in associated 
instrument operator's guide. 

0x1001 Fluidics 
procedure run 
error 

Fluidics procedure file is 
damaged. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 
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0x300A Calibrating DA 
coefficient failed 

AD board is not working properly. • Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x3100 Failed to read 
optical filter 
information 

Optical filter sensor is not working 
properly. 

• Restart NovoExpress software. 
• Reinstall the optical filter. 
• Replace an optical filter. 
• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x3101 Failed to read 
dichroic mirror 
information 

Dichroic mirror sensor is not 
working properly. 

• Restart NovoExpress software. 
• Reinstall the dichroic mirror. 
• Replace a dichroic mirror. 
• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x3102 Failed to read 
photodetector 
information 

Photodetector sensor is not 
working properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x3103 The optical filter 
information has 
been changed 

The optical filter has been 
replaced. 

Follow the software prompted 
instructions to perform the 
appropriate operation. 

0x3104 The dichroic 
mirror 
information has 
been changed 

The dichroic mirror has been 
replaced. 

Follow the software prompted 
instructions to perform the 
appropriate operation.  

0x3105 The 
photodetector 
information has 
been changed 

The photodetector has been 
replaced. 

Follow the software prompted 
instructions to perform the 
appropriate operation. 

0x6100 Communication 
error between 
NovoSampler 
and the orbital 
shaker 

The orbital shaker is not 
communicating to NovoSampler 
Pro (or NovoSampler Q) is not 
working properly. 

• Restart NovoSampler Pro (or 
NovoSampler Q) through 
NovoExpress.  

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0x7000 Fluidics cart 
firmware error 

NovoCyte Fluidics Cart firmware 
is not working properly. 

• Restart the instrument. 
• Replace the NovoCyte Fluidics 

Cart. 
• Contact Agilent technical 

support if the error persists. 

0x7001 NovoFlow liquid 
level sensor is 
not connected 

NovoFlow liquid level sensor is 
not connected or does not work 
properly. 

• Reconnect the NovoFlow liquid 
level sensor. 

• Contact Agilent technical 
support if the error remains 
after reconnection. The sensor 
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may be damaged and need to 
be replaced. 

0x7002 Waste liquid 
level sensor is 
not connected 

Waste liquid level sensor is not 
connected or does not work 
properly. 

• Reconnect the waste liquid level 
sensor. 

• Contact Agilent technical 
support if the error remains 
after reconnection. The sensor 
may be damaged and need to 
be replaced. 

0x7100 NovoCyte 
Fluidics Cart 
communication 
lost 

NovoCyte Fluidics Cart is not 
properly connected to the 
instrument. 

• Ensure the DVI cable between 
the fluidics cart and the 
instrument is properly 
connected. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0xA003 The temperature 
of the 
photodetectors 
is abnormal 

Ambient temperature outside the 
operating range. 

• Ensure to have the instrument 
working at normal ambient 
temperatures. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

More than four temperature 
sensors of the photodetector 
module are not working properly. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0xA020 Laser board 
firmware error 

Laser board firmware is not 
working properly. 

• Re-install or upgrade the laser 
board firmware. 

0xA021 Laser board 
communication 
lost 

Laser board is not properly 
connected to the instrument. 

• Restart the instrument. 
• Contact Agilent technical 

support if the error persists. 

0xA100 The temperature 
of the 
photodetectors 
is abnormal 

One to three temperature sensors 
of the photodetector module may 
not work properly. 

No action is needed. The 
instrument can use the 
temperature from other sensors 
and ensure the data is processed 
normally. 

 Communication 
error (code: xx, 
xx). Please 
restart 
Instrument and 
NovoExpress. 

USB cable between the 
instrument and workstation is not 
connected properly. 

• Reconnect the USB cable 
between the instrument and the 
workstation.  

• Restart the instrument, 
workstation and NovoExpress 
software. 

• Contact Agilent technical 
support if the error persists. 
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Technical Support Request 

In case you need to contact Agilent technical supports, use the Technical Support 
Request from Home menu to create a request. Technical Support Request 
Creation Wizard automatically collects instrument configurations, NovoExpress 
system logs, current screenshot, current experiment file and other information that 
helps diagnosis and troubleshooting of Agilent flow cytometer. You can also 
attach any other files using this function.  
1 Click Home > Technical Support Request to open the Technical Support 

Request Creation Wizard. 

  

2 Click Next button and input request description. 
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3 Click Next button and select the files to be attached. Any related files including 
experiment files (*. ncf) can be attached. 

 

4 Click Create button to start creating technical support request. 
5 Click Finish. 
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After the request creating process is completed, send the created request files 
to Agilent technical support.  
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11 Version History 
 

Date/Version Changed by Description 

10/30/2020  Initial release. 

 



Version History 
 
 

298   Software Guide 

 

This page is intentionally left blank. 

 

 

 
 

 
 
 
 
 
  



 

  

  



 

 

In This Guide 
 
The manual describes the following: 
 

• Prologue 

• Installation 

• Use NovoExpress Software 

• Sample Acquisition 

• Data Analysis 

• Plate Manager 

• Experiment Manager 

• Reports 

• QC Test 

• Troubleshoot 

• Version History 
 
 
 
 

 

www.agilent.com 
© Agilent Technologies, Inc. 2020 
 
Edition 1.0 October 2020 
 

*150013* 
150013 
 

http://www.agilent.com/

	In This Guide
	Contents
	1 Prologue
	About NovoExpress
	Using this Guide
	Keyboard Shortcuts
	Glossary

	2 Installation
	Installation Requirements
	Hardware:
	Software:

	Install NovoExpress Software
	Start NovoExpress Software
	Uninstall NovoExpress Software
	NovoExpress License
	Free Trial
	NovoExpress Registration
	NovoExpress Dissociation

	User Management
	User Groups
	Add a User Group
	Modify a User Group
	Delete a User Group
	Display the Users in a User Group

	Users
	Add a New User
	Modify User Information
	Access Privilege
	Delete a User



	3 Use NovoExpress Software
	NovoExpress Software Interface
	Title Block
	Menu
	File
	Home
	Instrument
	Sample
	Plot
	Gate
	View
	Setting

	Workspace Toolbar
	Cytometer Setting Panel
	Cytometer Control Panel
	Plate Manager
	Experiment Manager
	Cytometer Status Panel
	Gate Manager Panel
	Status Bar
	Green Indicator
	Flashing Red Indicator
	Flashing Yellow Indicator
	Black Indicator

	Instrument Configuration
	Instrument Configuration with Instrument Connected
	Instrument Configuration with Instrument Disconnected

	Manage Plate Types

	4  Sample Acquisition
	Cytometer Setting
	Parameters Settings
	Stop Condition Settings
	Flow Rate Settings
	Threshold Settings

	Work List
	Open the Work List
	Work List Management
	Insert a New Specimen or Sample
	Copy and Insert the Copied Specimen or Sample
	Delete Specimen or Sample
	Import a Specimen or Sample from a Template
	Create a Duplicate Specimen or Sample

	Edit a Work List Cell
	Edit Specimen, Specimen ID and Sample Names
	Edit Template
	Edit Acquisition Parameters
	Edit Stop Conditions, Sample Flow Rates, and Threshold Settings
	Copy and Paste Cells


	Cytometer Control
	Active Sample Information
	Experiment Control


	5 Data Analysis
	Plots
	Create a Plot
	Create a Plot with the Toolbar
	Create a Plot with the Experiment Manager
	Create a Plot from a Gate
	Create a Duplicate Plot
	Copy and Past a Plot with the Experiment Manager
	Import from a Template

	Open and Close a Plot Window
	Edit Plots
	Plot Gating
	Parameter Plot Settings
	Set Plot Types
	Rename Plots
	Delete Plots

	Set the Coordinates of the Axis
	Set the Coordinate Range
	Set the Coordinate Scale
	Display a Biexponential Plot

	Adjust the Size of Plots
	Copy or Save Plots
	Overlays
	Plot Formatting
	Dot Plot Formatting
	Density Plot Formatting
	Histogram Plot Formatting
	Contour Plot Formatting
	Plot Format
	Default Plot Settings

	Bi-Variate Plots

	Gates
	Create Gates
	Edit Gates
	Gate Display Format
	Set the Color of the Gate
	Gate Labels

	Apply a Gate to a Plot
	Copy and Paste Gates
	Export Gate Events
	Gate Manager
	Toolbar of Gate Manager
	Modify Gate Color and Color Precedence
	Context menu


	Statistics
	Display Statistical Information
	Open the Statistics Chart
	Statistics Layout
	Copy Statistical Information to Clipboard
	Statistics Layers

	Calculation of Statistics

	Fluorescence Compensation
	Automatic Compensation
	Set Automatic Compensation
	Prepare Samples for Automatic Compensation
	Automatic Calculation of the Compensation Matrix
	Application of Automatic Compensation Results
	Conduct Automatic Compensation from Imported FCS Files

	Active Compensation
	Relationship between the Spillover and Compensation Matrix
	Edit the Spillover Matrix

	Quick Compensation Adjustment
	Open the Quick Compensation Adjustment
	Use the Quick Compensation Adjustment


	Cell Cycle Analysis
	Automated Cell Cycle Analysis
	Manual Cell Cycle Analysis

	Cell Proliferation Analysis
	Automated Cell Proliferation Analysis
	Cell Proliferation Setting

	Statistical Tables
	Create Different Types of Statistical Tables
	Statistical Table Columns
	Add and Edit Columns
	Formula Columns
	Select Multiple Columns
	Duplicate Columns
	Delete Columns
	Show and hide Columns
	Move Columns
	Sort by Columns

	Statistical Table Rows
	Add Rows
	Select Multiple Rows
	Delete Row

	Statistical Tables Export or Copy Text
	Export Statistical Tables as CSV File
	Copy Statistical Table as Text to the Clipboard

	Statistical Table Options
	Statistical Table Management

	Heat Maps
	Create a New Heat Map
	Heat Map Window
	Heat Map Grid
	Heat Map for Multiple Statistics
	Add Statistics

	Edit Heat Map Statistics Window
	Update Heat Map
	Save Heat Map
	Copy Heat Map
	Heat Maps Management

	Post Gain
	Adjust Post Gain
	Clear Post Gain
	Apply Post Gain
	Export Post Gained Data


	6 Plate Manager
	Overview of Plate Manager Panel
	Context Menu
	Context menu when a single well is selected
	Context menu when multiple wells are selected


	7 Experiment Manager
	Experiment Manager Toolbar
	Hierarchy
	Description
	Right-Click Menu
	Move Items
	Merge Samples

	Templates
	Copy and Paste the Template
	Drag and Drop the Templates
	Use the Toolbar
	Import and Export Templates
	Export Template
	Import Template


	Import and Export Data
	Import Data
	Export Data
	Copy and Paste Events


	8 Reports
	Report Interface
	Automatically Generate Reports
	Report Options
	Report Editor
	Add Report Objects
	Select Report Objects
	Edit Report Objects
	Edit Text
	Edit Plots and Statistics
	Filter Statistics
	Edit Shapes
	Edit Pictures

	Align Report Project Items
	Resize Objects
	Order Object Levels
	Cut, Copy, Paste, and Delete
	Insert or Delete Pages
	Header and Footers
	Headers and Footers Working Interface
	Edit Headers and Footers
	Copy the Header and Footer Settings to Other Reports


	Report Output
	Batch Print Reports

	9 QC Test
	Prepare QC Particle Sample
	Run QC Test
	View QC Test Report

	10 Troubleshoot
	Troubleshoot Instrument
	Technical Support Request

	11 Version History

